Install and License your Genero Products
## Contents

<table>
<thead>
<tr>
<th>Install and License your Genero Products</th>
<th>.................................</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>The what, where, and when of installation</td>
<td>........................................</td>
<td>8</td>
</tr>
<tr>
<td>Software package names</td>
<td>..........................................................</td>
<td>8</td>
</tr>
<tr>
<td>Installation conventions</td>
<td>........................................................................</td>
<td>9</td>
</tr>
<tr>
<td>Install multiple Genero versions</td>
<td>.......................................................................</td>
<td>10</td>
</tr>
<tr>
<td>Installation troubleshooting tips</td>
<td>........................................................................</td>
<td>11</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Install Genero Business Development Language</th>
<th>........................................</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero Business Development Language packages</td>
<td>........................................</td>
<td>12</td>
</tr>
<tr>
<td>Pre-install tasks</td>
<td>........................................................................</td>
<td>12</td>
</tr>
<tr>
<td>Install Genero BDL on UNIX™ platforms</td>
<td>..................................................</td>
<td>13</td>
</tr>
<tr>
<td>Install BDL on UNIX™ platforms in silent mode</td>
<td>........................................................................</td>
<td>14</td>
</tr>
<tr>
<td>Install Genero BDL on Windows®</td>
<td>..................................................</td>
<td>14</td>
</tr>
<tr>
<td>Install BDL on Windows® in silent mode</td>
<td>........................................................................</td>
<td>15</td>
</tr>
<tr>
<td>Install Genero BDL on macOS™</td>
<td>..................................................</td>
<td>16</td>
</tr>
<tr>
<td>Post-install tasks</td>
<td>........................................................................</td>
<td>17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Install Genero Desktop Client</th>
<th>........................................</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero compatibility for the GDC</td>
<td>..................................................</td>
<td>17</td>
</tr>
<tr>
<td>GDC 3.20 and Genero compatibility</td>
<td>..................................................</td>
<td>17</td>
</tr>
<tr>
<td>GDC 3.10 and Genero compatibility</td>
<td>..................................................</td>
<td>18</td>
</tr>
<tr>
<td>GDC 3.00 and Genero compatibility</td>
<td>..................................................</td>
<td>18</td>
</tr>
<tr>
<td>GDC 2.50 and Genero compatibility</td>
<td>..................................................</td>
<td>18</td>
</tr>
<tr>
<td>Install GDC on UNIX™ platforms</td>
<td>..................................................</td>
<td>18</td>
</tr>
<tr>
<td>Install GDC on UNIX™ platforms in silent mode</td>
<td>..................................................</td>
<td>19</td>
</tr>
<tr>
<td>Install GDC on Windows®</td>
<td>..................................................</td>
<td>19</td>
</tr>
<tr>
<td>Install GDC on Windows® in silent mode</td>
<td>..................................................</td>
<td>20</td>
</tr>
<tr>
<td>Install GDC on macOS™</td>
<td>..................................................</td>
<td>21</td>
</tr>
<tr>
<td>Install GDC on X11 systems</td>
<td>..................................................</td>
<td>22</td>
</tr>
<tr>
<td>Microsoft® Windows® Security Blocking</td>
<td>..................................................</td>
<td>22</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Install Genero Application Server</th>
<th>........................................</th>
<th>22</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero compatibility for the GAS</td>
<td>..................................................</td>
<td>23</td>
</tr>
<tr>
<td>GAS 3.20 and Genero compatibility</td>
<td>..................................................</td>
<td>23</td>
</tr>
<tr>
<td>GAS 3.10 and Genero compatibility</td>
<td>..................................................</td>
<td>23</td>
</tr>
<tr>
<td>Install GAS on UNIX™ platforms</td>
<td>..................................................</td>
<td>23</td>
</tr>
<tr>
<td>Install the GAS on UNIX™ platforms in silent mode</td>
<td>..................................................</td>
<td>24</td>
</tr>
<tr>
<td>Install GAS on Windows®</td>
<td>..................................................</td>
<td>25</td>
</tr>
<tr>
<td>Install GAS on Windows® in silent mode</td>
<td>..................................................</td>
<td>25</td>
</tr>
<tr>
<td>Install GAS on macOS™</td>
<td>..................................................</td>
<td>27</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Install Genero Studio</th>
<th>........................................</th>
<th>28</th>
</tr>
</thead>
<tbody>
<tr>
<td>GST 3.20 and Genero compatibility</td>
<td>..................................................</td>
<td>28</td>
</tr>
<tr>
<td>Install Genero Studio on UNIX™ platforms</td>
<td>..................................................</td>
<td>29</td>
</tr>
<tr>
<td>Install Genero Studio on UNIX™ platforms in silent mode</td>
<td>..................................................</td>
<td>29</td>
</tr>
</tbody>
</table>
### License Genero Business Development Language

- Steps to BDL license installation.................................................. 58
  - Install BDL license with user interface (internet).......................... 58
  - Install BDL license with user interface (no internet)....................... 60
  - Install BDL license from the command line (via internet)............... 62
  - Install BDL license from the command line (no internet)............... 63
- Manage Genero BDL local license.................................................. 64
  - License Controller (fglWrt).......................................................... 65
  - Displaying environment and statistics.......................................... 67
  - GDC/GDCAx/GJC.......................................................................... 69
  - Genero Browser Client (GBC).......................................................... 70
  - Get license information.............................................................. 70
  - Uninstall license........................................................................... 73
  - The FGLDIR/lock directory............................................................ 75
  - License an upgraded installation.................................................. 75
  - Managing the active users............................................................ 75
- Register license on Four Js website................................................ 78
- Troubleshooting license registration ................................................. 80
- Get maintenance key from Four Js website........................................ 80
- Steps to finalize temporary BDL license........................................... 81
  - Finalize BDL license with user interface (via internet).................... 82
  - Finalize BDL license with user interface (no internet)..................... 83
  - Finalize BDL license from the command line (via internet).......... 85
  - Finalize BDL license from the command line (no internet)........... 85
- Steps to apply maintenance or subscription key (BDL)......................... 86
  - Install or update the maintenance key (BDL) with UI (via internet).... 86
  - Install or update the maintenance key (BDL) with UI (no internet)... 88
  - Install or update the maintenance key (BDL) with fglwrt (via internet)... 89
  - Install or update the maintenance key (BDL) with fglwrt (no internet)... 89
- License using Four Js License Manager............................................. 89

### License Genero Report Engine (GRE)

- Steps to GRE license installation.................................................... 90
  - Install Genero Report Engine license with GUI (internet)............. 90
  - Install GRE license with GUI (no internet)................................... 91
  - Install GRE license from the command line.................................. 92
  - Install GRE license from the command line.................................. 93
- Manage Genero Report Engine local license...................................... 94
  - License Controller (greWrt) options.............................................. 94
  - Get license information.............................................................. 97
  - Uninstall license........................................................................... 99
  - License an upgraded installation.................................................. 100
- Register license on Four Js website................................................ 100
- Get maintenance key from Four Js website........................................ 102
- Steps to finalize temporary GRE license........................................... 103
  - Finalize Genero Report Engine license with GUI (via internet)....... 104
  - Finalize Genero Report Engine license with GUI (no internet)....... 105
Copyrights and Trademarks................................................................. 139
Index............................................................................................................ 141
Install and License your Genero Products

The installation instructions for all of the packages provided by the Genero Enterprise suite.

This manual provides installation instructions for the products that comprise the Genero Enterprise suite:

- Genero BDL with Web Services (BDL)
- Genero Application Server (GAS)
- Genero Studio (GST)
- Genero Suite Server (Genero Studio Server plus all components)
- Genero Desktop Client (GDC)
- Genero Mobile for Android™ (GMA)
- Genero Mobile for iOS (GMI)
- Genero Ghost Client (GGC)
- Genero Report Engine (GRE)

This manual covers the installation and licensing of the product. Configuration of a product is covered in product-specific administrator and user manuals.

Genero Installation Basics

Regardless of the product, there are basics that are true across the Genero packages:

- The what, where, and when of installation on page 8
- Software package names on page 8
- Installation conventions on page 9
- Install multiple Genero versions on page 10
- Installation troubleshooting tips on page 11

Product-specific Installation Guides

Click on a link to access a product-specific installation guide:

- Install Genero Business Development Language on page 12
- Install Genero Desktop Client on page 17
- Install Genero Application Server on page 22
- Install Genero Studio on page 28
- Install Genero Report Engine on page 43
- Install Genero Report Designer on page 47
- Install Four Js License Manager on page 51

Licensing your products

Click on a link to learn more about licensing your Genero installation:

- License Genero Business Development Language on page 58
- License Genero Report Engine (GRE) on page 90
- License using Four Js License Manager on page 114

Note: For a general overview and introduction to licensing Genero products, see Genero Licensing manual.
The what, where, and when of installation

This topic covers what you should install (bundled software or individual packages) and where you should install it (server or workstation) based on what you want to do (development or production).

Software Bundle versus Individual Package

Genero software is provided as both software bundles and, for some products, as individual packages.

Individual packages include:

• Genero BDL with Web Services (BDL)
• Genero Desktop Client (GDC)
• Genero Application Server (GAS)
• Genero Report Engine (GRE)
• Genero Report Designer (GRD)

When you install individual packages, each package creates its own installation directory.

Software bundles include:

• Genero Studio (Studio + GRE + BDL + GAS + GDC)
• Genero Suite Server (Studio Server + GRE + BDL + GAS)

When you install a bundle, the installation puts all of the Genero products in a single install directory, with child directories for each product included in the package (fgl, gas, gdc, gre and gst). You can opt during the installation to include or exclude any of the individual components when installing a bundle.

Installation for Development

For development, you can install the Genero Suite Client/Server software bundle on your local machine. This provides all the software you need, pre-configured to work together. You do not need a Web server for your development environment; you can use the standalone Genero Application Server to test your Web applications and Web services.

Installation for Production

For a production environment, you must use a Web server with the Genero Application Server. It is recommended that the Genero Business Development Language, Genero Application Server and your Web server sit on the same server host. The database can be on a separate machine, and the end-user client software will sit on the client machine (or be delivered to a browser that sits on the client machine). For more information, refer to the various User Guides to see different architecture scenarios.

Related concepts

Install multiple Genero versions on page 10
A strategy for installing and using different versions of Genero software is described.

Software package names

Genero software packages use a standard nomenclature.

All Four Js software packages follow a specific naming convention:

\texttt{fjs-product-version-build-osident.extension}

where:

• \textit{product} is the product identifier.
• \textit{version} is the software release number.
• *build* is the build number.
• *osident* is the operating system identifier.
• *extension* is the file extension:
  • *run* on UNIX™ platforms
  • *exe* on Windows® platforms
  • *dmg* or *run* on macOS® platforms.

**Examples**

```
fjs-fglgws-3.10.00-build2239_gws126106-a640610.run
fjs-fglgws-3.10.00-build2239_gws126106-w64v100.exe
fjs-gdc-3.10.03-build4949-164lx25.run
```

**Installation conventions**

Genero software installations use standard conventions, for example, for environment and directory structure.

All Four Js software installations follow conventions which are common between products.

**Installation environment**

Typically environment variables, which define the installation directory of Genero products, follow this recognizable format:

```
product identifying code DIR
```

Where, for example:

• FGLDIR is the variable that sets the Genero Business Development Language (BDL) installation directory.
• GDCDIR sets the Genero Desktop Client (GDC) installation directory.
• FGLASDIR sets the Genero Application Server (GAS) installation directory.
• GSTDIR sets the Genero Studio (GST) product installation directory.
• GREDIR sets the Genero Report Engine (GRE) installation directory.
• GRDDIR sets the Genero Report Designer (GRD) installation directory.
• FLMDIR sets the Four Js License Manager (FLM) installation directory.

**Scripts to set environment**

Scripts that ensure that PATH, installation directory and other dependent environment variables are set correctly, are run in the installation directory at installation time. The name of the associated script files (*sh* for Linux® or *bat* for Windows®) follow this recognizable format:

```
env product identifying code
```

Where, for example:

• *envcomp* is the script that sets the Genero Business Development Language installation environment.
• *envas* sets the Genero Application Server installation environment.
• *envgst* sets the Genero Studio product installation environment.
• *envgre* sets the Genero Report Engine installation environment.
• *envflm* sets the Four Js License Manager installation environment.

**Note:** As the Genero Studio installation also installs the Genero Business Development Language, the Genero Application Server, the Genero Report Engine, and the Genero Desktop Client, the environment is set for all at installation time by the wrapper script *envgenero.*
Installation directory structure

There is a standard directory structure used across the Four Js product installation. Where, for example, some directories are product specific, these are standard directories:

- **bin** contains the product executables.
- **lib** contains library extension files.
- **release** contains the copyright details.
- **license** contains end user and third-party license information.

Version and help

Command line program tools, such as compilation `fglcomp`, runtime system tool (`fglrun`), and other tools, for example, `fglgar`, `gasadmin`, etc., follow a standard use of options to provide version information and help with the tool. See Table 1: Version and help options on page 10.

Table 1: Version and help options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-V</code> or <code>--version</code></td>
<td>Display version information for the tool.</td>
</tr>
<tr>
<td><code>-h</code> or <code>--help</code></td>
<td>Display options for the tool. Short help.</td>
</tr>
</tbody>
</table>

Install multiple Genero versions

A strategy for installing and using different versions of Genero software is described.

To maintain more than one Genero product version, you install the version as described in the installation section, with the following additional considerations:

- When prompted for the destination directory during installation, ensure that a distinct directory is used for each installed Genero version. Give the directory a name including exact product version (for example, `fglgws-3.10.00`) to ensure the directory specified is not the same as that used for any other installed version.

  **Tip:** It is recommended to store all versions beneath an application root directory (for example, `/opt/fourjs/fgl`).

- Ensure that your application has been compiled for the version your environment is currently pointing to. If the new version is a major upgrade (for example, from 3.10 to 3.20), you must recompile the sources and form files before switching between versions; this is true whether you are switching from old to new version or revert back to the old version.

  **Note:** It is recommended that you compile each version in its own output directory, so that you do not overwrite the prior compiled versions.

  **Note:** If the new version is a minor upgrade (for example, from 3.20.06 to 3.20.07), recompilation is not mandatory but may have some optimization benefits.

To switch between versions, use either generic symbolic links or set environment variables.

Example 1: generic symbolic links

You have two symbolic links, one for the product version installation directory, and one perhaps for your application directory where your application files (.42r, .42m, .4st, etc.) are stored. These symbolic links remain the same regardless of the version in use. For example:

- You create a symbolic link at `/opt/fourjs/fgl` pointing to the current installed version at `/opt/fourjs/fgl.3.10.08`
- You create a symbolic link at `/opt/myapp` pointing to your current application directory at `/opt/myapp.1.23.4`, where 1.23.4 is the application version number.
At upgrade time, you change the symbolic links, to point to the latest installed version and your latest application version directory.

- `/opt/fourjs/fgl` now points to `/opt/fourjs/fgl.3.10.09`
- `/opt/myapp` now points to `/opt/myapp.1.24.1`

**Example 2: environment variables**

This method uses the same principle as the symbolic link example. You have two environment variables, one for the product installation directory, and one for your current application directory. These remain the same regardless of the version in use. For example:

- You set the environment variable FGLDIR to `/opt/fourjs/fgl.3.10.08`
- You set MYAPP to `/opt/myapp.1.23.4`

At upgrade time, you change the values of the environment variables, to point to the latest installed version and your latest application version directory.

- FGLDIR now has the value `/opt/fourjs/fgl.3.10.09`
- MYAPP now has the value `/opt/myapp.1.24.1`

**Switching between product versions**

To switch between versions, change the symbolic links or environment variables. The advantage is that you can run two versions in parallel beforehand to test, or you can run a previous version after an upgrade to compare changes. This allows you to revert back quickly if something goes wrong.

**Installation troubleshooting tips**

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

How you log an installation of a Genero package depends on your operating system.

**Table 2: Logging your installation**

<table>
<thead>
<tr>
<th>Operating System</th>
<th>How to log the installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows®</td>
<td>1. Extract the <code>.msi</code> file from the software package executable (<code>exe</code>): <code>fjs-package-name.exe /x</code></td>
</tr>
<tr>
<td></td>
<td>2. From the command line execute: <code>msiexec /i fjs-package-name.msi /log mylogfile.log</code></td>
</tr>
<tr>
<td></td>
<td>Important: On Windows®, you must run the command as administrator. It is not enough to simply have administrator permissions.</td>
</tr>
<tr>
<td>UNIX™</td>
<td>From the command line:</td>
</tr>
<tr>
<td></td>
<td>1. <code>export FGLINSTALLDEBUG=1</code></td>
</tr>
<tr>
<td></td>
<td>2. `./fjs-package-name 2&gt;&amp;1</td>
</tr>
<tr>
<td>Mac®</td>
<td>See Debug the Genero Studio Install on macOS (GUI installer) on page 34.</td>
</tr>
</tbody>
</table>
Install Genero Business Development Language

These topics relate to the installation of Genero Business Development Language.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

**Note:** See the *Genero Business Development Language User Guide* for additional installation and configuration information.

**System requirements**

For details about system requirements, refer to the *Supported platforms and databases* document (available on the Download page of the Four Js Web site) or contact your support center.

**Related concepts**

*Install multiple Genero versions* on page 10
A strategy for installing and using different versions of Genero software is described.

*Installation troubleshooting tips* on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Genero Business Development Language packages**

The Genero Business Development Language software is a self-extractable installation program.

Genero BDL package files follow a specific naming convention:

\[ fjs\text{-}product\text{-}version\text{-}build\text{-}osident\text{-}extension \]

where:

- *product* is the product identifier
- *version* is the release number of the software
- *build* is the build information
- *osident* is the operating system identifier
- *extension* is `run` on UNIX™ platforms, `exe` on Windows® platforms, and `dmg` or `run` on macOS™ platforms.

**Examples**

- `fjs-fglgws-3.10.00-build2239_gws126106-a640610.run`
- `fjs-fglgws-3.10.00-build2239_gws126106-w64v100.exe`

**Pre-install tasks**

Before launching the installation program, make sure:

1. You have a license number and a license key for Genero BDL development or runtime. See *License Genero Business Development Language* on page 58 for more details.
2. You have a valid maintenance contract (for BDL versions 2.20 or higher) and maintenance key. See *License Genero Business Development Language* on page 58 for more details.
3. You are using a supported operating system. See the *Supported platforms and databases* document (available on the Download page of the Four Js Web site).
4. You are connected to the system as a user with sufficient privileges to install the software in the target directory.
5. Your configuration matches all hardware requirements and software requirements.

In addition there are some environment and database considerations that you may need to take care of before installation. Make sure:

**Important:** Before starting the installation program, make sure that the database client environment variables are set.

1. You have set the environment variables for the database client software (for example, `INFORMIXDIR`).
2. You have access to all needed DLLs (PATH) or shared libraries (LD_LIBRARY_PATH, LD_LIBRARY_PATH_64, SHLIB_PATH, LIBPATH or DYLD_LIBRARY_PATH).
3. You can use the C compiler, if you need to create C Extensions.
4. You can use the JDK, if you need to use the Java Interface.

### C compiler for C Extensions

Applications using C extensions need a C compiler and linker to build the C extension library that will be loaded by the runtime system.

On UNIX® platforms, you need a `cc` compiler on the system where you create the C extension libraries. Note that some UNIX® systems do not have a C compiler installed by default.

On Windows® platforms, it is mandatory to install Microsoft® Visual C++ version corresponding to the installed Genero BDL package. The OS identifier of the Genero BDL package file name identifies the Visual C++ version to be used.

### Java

In order to use the Java Interface in your application programs, you need the Java software installed and properly configured.

- Install a Java Development Kit on development sites (if you need to compile your own Java classes)
- Install a Java Runtime Environment on production sites (on the server where your programs are running)

The version of the installed Java software can be shown with the command:

```
java --version
```

In order to execute Java byte code, the Genero runtime system uses the JNI interface. The JVM is loaded as a shared library and its binary format must match the binary format of the Genero runtime system. For example, a 64-bit Genero package requires a 64-bit JVM.

For a detailed list of supported JVMs, refer to the *Supported platforms and databases* document (available on the Download page of the Four Js Web site).

---

### Install Genero BDL on UNIX™ platforms

Follow these steps to install Genero Business Development Language (BDL) on UNIX™ platforms.

On UNIX™ platforms, Genero BDL is provided as an auto-extractable shell script. Distribution files and installation program are provided in the same file.

The installation program has options. Display the installation program options using the help (-h) option, for example:

```
./fjs-fglgws-3.20.02-build2281_gws128706-164pl25.run -h
```

**Note:** Ensure that the daemon is run as a non-privileged user (not root) on Linux®/UNIX™ systems. It is recommended that the non-privileged user should also add the licenses.

1. To perform the installation, run the auto-extractable shell script without any option.

   For example: `./fjs-fglgws-3.20.02-build2281_gws128706-164pl25.run`
The installation program determines the operating system and checks that all the system requirements are met before starting to copy the product files to your disk.

2. Follow the instructions of the installation program.
   Answer the questions, including the request for license key and number (See License Genero Business Development Language on page 58).

**Install BDL on UNIX™ platforms in silent mode**

Install BDL silently on Gnu/Linux® and UNIX™ platforms.

To start the installation, type the following:

```
./fjs-fglgws-version-buildYYYYMMDDhhmm-osident.run -a -q -t install_dir
```

For example:

```
./fjs-fglgws-3.20.08-build202005131737-h64il12.run -a -q -t $PWD/fglgws-3.20
```

**Options**

Table 3: UNIX install options on page 14 shows the most common options relating to installation.

### Table 3: UNIX™ install options

<table>
<thead>
<tr>
<th>Install option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a or --accept</td>
<td>Bypass the display and the prompt for acceptance of the license agreement. Using the -a option indicates that you have read and accepted the End User License Agreement contained in the .txt files (in the license directory of the install directory).</td>
</tr>
<tr>
<td>-h or --help</td>
<td>Display help about all possible options.</td>
</tr>
<tr>
<td>-q or --quiet</td>
<td>Silent mode with no UI. If -q is not specified, the interactive installer is used.</td>
</tr>
<tr>
<td>-f backup</td>
<td>overwrite</td>
</tr>
<tr>
<td>-t install_dir or --target install_dir</td>
<td>Install the product in the specified target directory. If -t is not specified, the default installation is used.</td>
</tr>
<tr>
<td>--dblist</td>
<td>List database drivers available for this package.</td>
</tr>
</tbody>
</table>

---

**Install Genero BDL on Windows®**

Install Genero BDL on Windows® platforms.

**Important:** If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.
1. Execute the installation package to start the Setup Wizard.

   `fjs-product-version-build-osident.exe`

   Example:

   `fjs-fglgws-3.20.00-build2239_gws126106-w64v100.exe`

2. Follow the instructions of the installation program.

   Answer the questions, including the request for license key and number (See License Genero Business Development Language on page 58).

**Install BDL on Windows® in silent mode**

Install Genero BDL on Windows® platforms using the MSI installer.

On Microsoft® Windows®, the Genero BDL package is provided with a standard MSI Windows® setup program. Distribution files and installation program are provided in the same file.

The `msiexec` utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The `/qn` option allows you to install in silent mode. The `msiexec` utility expects an `.msi` file. To be compliant with Microsoft® User Access Control (UAC) requirements, the `.msi` file is embedded inside an `.exe` file.

To extract the `.msi` file from the `.exe` file, use the `/x` option:

   `fjs-fglgws-version-build-osident.exe /x`

For example:

   `fjs-fglgws-3.20.02-build2281_gws128706-w32v100.exe /x`

A `.msi` file is created in the same directory and with the same name as the `.exe` file.

**Options**

Table 4: `msiexec` install and uninstall options on page 15 shows the most common options for `msiexec` relating to installation and un-installation.

**Table 4: msiexec install and uninstall options**

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/qn</code></td>
<td>Silent mode with no UI. If /qn is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td><code>/i package-name.msi</code></td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td><code>/x package-name.msi</code></td>
<td>Uninstall the specified msi package.</td>
</tr>
<tr>
<td><code>/log logfile</code></td>
<td>Write processing info to the specified log file.</td>
</tr>
<tr>
<td><code>/l*vx logfile</code></td>
<td>Provide verbose (detailed) logs in the specified log file</td>
</tr>
</tbody>
</table>

Enter `msiexec` from the command prompt to view the complete list of available options.

**Arguments**

You can pass arguments to the `msiexec` installer on the command line.
Table 5: Arguments for the msiexec installer

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=fgldir-path</td>
<td>The path where BDL is installed. It is an alias of FGLDIR variable.</td>
</tr>
<tr>
<td>FGLDIR=fgldir_path</td>
<td>The path where BDL is installed. It is an alias of the PRODUCTDIR variable.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=startmenu-folder</td>
<td>Customize the location for the shortcuts in the startmenu. For example, &quot;fjs\fgl&quot;.</td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, remove the PRODUCTDIR location, even if it is not empty. YES = Force removal of PRODUCTDIR. Other = Keep files in PRODUCTDIR. Default value: &quot;&quot; (empty string)</td>
</tr>
</tbody>
</table>

Note: Quotes are only required around the argument value when a space character is in the value string.

Call your support center for more details if this silent installation is required.

Install Genero BDL on macOS™

Before you begin

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

About this task

Follow these instructions to install the Genero BDL on macOS.

1. Determine the directory where you will install the product.
   The wizard will eventually suggest /opt/fourjs/fgl. If you plan to use this default, ensure you have write permission to this directory.

2. Log in as a user with permission to write to the directory in which you plan to install this product.

3. Copy the self-extractable file into a temporary directory.

4. From a command prompt, run the self-extractable shell script with the -i option:

   ```bash
   sh fjs-fgl-3.xx.xx-buildxxxxxxxx-m64x1011.run -i
   ```

   Note: The "x" entries in the file name example above must use the actual numbers of the downloaded file!

5. Follow the instructions displayed.

   Tip: After you have read the licensing agreement, press "q" to return to the instructions and prompts.

   At some point in the instructions, you will be asked whether you wish to provide the licensing details for the Genero Business Development Language. If you skip this step during the installation, you can always go back later to provide the licensing details.

   When asked about providing the licensing details for the Genero Report Engine, you can choose to not license the GRE. A GRE license is not necessary if you have a Genero BDL license with maintenance support.

What to do next

When installation is complete, see the Genero Business Development Language User Guide for configuration information and instructions.
Post-install tasks

Tasks to complete after the installation of Genero BDL.

After installing the product, it is recommended that you first read the license terms provided in the `FGLDIR/license` directory.

Release information files are provided in `FGLDIR/release` directory. The `readme.txt` file may contain important last-minute information that may not be found in the documentation.

A list of corrected defects can be accessed at the issue tracker page of the Four Js website at the following URL:

http://www.4js.com/support/issue/FGL

It is recommended that you read the details of the new features as well as upgrade notes provided in the Upgrading section of Genero Business Development Language User Guide.

Depending on the database server you want to connect to, you will need to set up the correct database driver in `FGLPROFILE`. The default database driver is selected at installation time. For more details about database driver configuration, see Connections in the Genero Business Development Language User Guide.

Tip: If you have configurations from a previous installation version, for example in your `fglprofile`, avoid copying these files in to your new installation. The preferred practice is to use the default from the new install package so that you benefit from any new or changed syntax it may contain and then reapply your custom changes.

For additional post installation and configuration information see the Installation topics in the Genero Business Development Language User Guide.

Install Genero Desktop Client

These topics relate to the installation of the Genero Desktop Client.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

Note: See the Genero Desktop Client User Guide for additional installation and configuration information.

System requirements

For details about system requirements, refer to the Supported platforms and databases document (available on the Download page of the Four Js Web site) or contact your support center.

Related concepts

Install multiple Genero versions on page 10
A strategy for installing and using different versions of Genero software is described.

Installation troubleshooting tips on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Genero compatibility for the GDC

Determine the compatibility of different versions of the Genero product family and the Genero Desktop Client.

GDC 3.20 and Genero compatibility

GDC 3.20 can run in direct mode (SSH) with FGL 3.20, FGL 3.10, or FGL 3.00.

GDC 3.20 can run on the UA protocol using FGL+GAS 3.20, FGL+GAS 3.10, or FGL+GAS 3.00.
The Genero Report Viewer (GRV) 3.20, which is included in GDC, is compatible with FGL 3.20, FGL 3.10, and FGL 3.00.

**GDC 3.10 and Genero compatibility**

GDC 3.10 is compatible with FGL 3.00 or FGL 3.10 in direct mode.

GDC 3.10 is compatible with:

- a 3.10 server-side configuration (FGL 3.10 + GAS 3.10) in UA mode.
- a 3.00 server-side configuration (FGL 3.00 + GAS 3.00) in UA mode.

GDC 3.10 is not compatible with FGL 2.5x or earlier.

**GDC 3.00 and Genero compatibility**

GDC 3.00 is compatible with FGL 3.00.

When using an HTTP connection through the GAS:

- GDC 3.00 should use uaproxy (ua) and requires FGL 3.00.
- GDC 3.00 is not compatible with FGL 2.5x or earlier.

**GDC 2.50 and Genero compatibility**

Genero Desktop Client 2.5x will work only with FGL 2.5x, as well as FGL 2.4x, FGL 2.3x, FGL 2.2x and FGL 2.1x for backward compatibility. It is not supported with FGL 2.0x and FGL 1.3x.

When using an HTTP connection through the GAS:

- GDC 2.50 should use gdcproxy (wa) and requires FGL 2.50.

For those who connect through HTTP, Genero Desktop Client and Genero Application Server need to be on the same level; for instance, both would need to be 2.5x. Genero Desktop Client 2.5x is **NOT** backward compatible with versions 1.3x, 2.0x, 2.1x, 2.2x, 2.3x and 2.4x of the Genero Application Server, mainly for stability reasons due to the HTTP stack review.

If you have any doubts regarding compatibility between versions, contact your support center.

**Install GDC on UNIX™ platforms**

Follow these steps to install GDC on UNIX™ platforms.

On UNIX™ platforms, GDC is provided as an auto-extractable shell script. Distribution files and installation program are provided in the same file.

The installation program has options. Display the installation program options using the help (-h) option, for example:

```
./fjs-gdc-3.20.11-build158046-164x1212.run -h
```

1. To perform the installation, run the auto-extractable shell script without any option.
   - For example: ./fjs-gdc-3.20.11-build158046-164x1212.run

   The installation program determines the operating system and checks that all the system requirements are met before starting to copy the product files to your disk.

2. Follow the instructions of the installation program.

**What to do next**

When installation is complete, see the *Genero Desktop Client User Guide* for configuration information and instructions.
Install GDC on UNIX™ platforms in silent mode

Install the Genero Desktop Client (GDC) silently on Gnu/Linux® and UNIX™ platforms.

To start the installation, type the following:

```
./fjs-gdc-version-buildYYYYYMMDDhhmm-osident.run -a -q --no-desktop -t install_dir
```

For example:

```
./fjs-gdc-3.20.13-build202005251839-164x1217.run -a -q --no-desktop -t $PWD/fjs-gdc-3.20.13
```

Options

Table 6: UNIX install options on page 19 shows the most common options relating to installation.

**Table 6: UNIX™ install options**

<table>
<thead>
<tr>
<th>Install option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a or --accept</td>
<td>Bypass the display and the prompt for acceptance of the license agreement. Using the -a option indicates that you have read and accepted the End User License Agreement contained in the .txt files (in the license directory of the install directory).</td>
</tr>
<tr>
<td>-h or --help</td>
<td>Display help about all possible options.</td>
</tr>
<tr>
<td>-q or --quiet</td>
<td>Silent mode with no UI. If -q is not specified, the interactive installer is used.</td>
</tr>
<tr>
<td>-f backup</td>
<td>overwrite</td>
</tr>
<tr>
<td></td>
<td>backup: Back up the installation directory.</td>
</tr>
<tr>
<td></td>
<td>overwrite: Overwrite installation file.</td>
</tr>
<tr>
<td></td>
<td>remove: Delete installation directory before installing.</td>
</tr>
<tr>
<td>-t install_dir or --target install_dir</td>
<td>Install the product in the specified target directory. If -t is not specified, the default installation is used.</td>
</tr>
<tr>
<td>--no-desktop</td>
<td>Desktop bindings are not installed, which means:</td>
</tr>
<tr>
<td></td>
<td>• Desktop and system menu icons are not created.</td>
</tr>
<tr>
<td></td>
<td>• File types are not automatically associated with the product.</td>
</tr>
</tbody>
</table>

Install GDC on Windows®

Procedure to install GDC on Windows® using the exe file.

1. Close all running applications.
2. Execute the installation program.

On Windows® Vista, Windows® 7, Windows® 8, and Windows® 10, administrator privileges are needed to perform the installation. UAC will pop up, you will need to validate it to install GDC.
3. Press 'Next' to start the installation.
4. If you accept the agreement, check 'I accept the terms in the License Agreement' and click 'Next' to continue.
5. Select the folder in which you want to install GDC.
6. Determine whether to grant read/write/modify permissions on the installation directory to the Users group.
   The option must be selected to allow the GDC auto-updater to work silently. However, granting these permissions may be considered as unsecure. Consult with your Genero application administrator.
7. Select the StartMenu folder in which GDC shortcuts will be set.
8. Determine whether to associate .gdc files with the GDC.
   GDC shortcuts can be stored as a .gdc file. By associating this extension with this GDC, you can start GDC by double-clicking a .gdc file in Explorer. You can enable or disable the file associations.
   GDC is now ready to be installed.
9. Click Install to begin the installation.
   All files are copied.
10. Click Finish to close the installation wizard.

What to do next
When installation is complete, see the Genero Desktop Client User Guide for configuration information and instructions.

Install GDC on Windows® in silent mode
Install Genero Desktop Client on Windows® platforms using the MSI installer.

The msiexec utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The /qn option allows you to install in silent mode. The msiexec utility expects an msi file. To be compliant with Microsoft® User Access Control (UAC) requirements, the msi file is embedded inside an exe file. To extract the msi file from the exe file, use the /x option:

```
c:\fjs-gdc-version-build-osident.exe /x
```

For example:

```
c:\fjs-gdc-3.10.03-build4949-w32v100.exe /x
```

A msi file is created in the same directory and with the same name as the exe file.

Options
Table 7: msiexec install and uninstall options on page 20 shows the most common options for msiexec relating to installation and un-installation.

Table 7: msiexec install and uninstall options

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/qn</td>
<td>Silent mode with no UI. If /qn is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td>/i package-name.msi</td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td>/x package-name.msi</td>
<td>Uninstall the specified msi package.</td>
</tr>
<tr>
<td>/log logfile</td>
<td>Write processing info to the specified log file.</td>
</tr>
<tr>
<td>/l*vx logfile</td>
<td>Provide verbose (detailed) logs in the specified log file</td>
</tr>
</tbody>
</table>

Enter msiexec from the command prompt to view the complete list of available options.
Arguments
You can pass arguments to the msiexec installer on the command line.

Table 8: Arguments for the msiexec installer

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_gdcdir_path</td>
<td>The path where GDC will be installed. It is an alias of GDCDIR variable.</td>
</tr>
<tr>
<td>GDCDIR=your_gdcdir_path</td>
<td>The path where GDC will be installed. It is an alias of the PRODUCTDIR variable.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example, &quot;fjs\gdc&quot;.</td>
</tr>
<tr>
<td>ADDLOCAL=[ALL</td>
<td>GDC</td>
</tr>
<tr>
<td></td>
<td>• ALL (default): Install GDC (mandatory) and .gdc file association</td>
</tr>
<tr>
<td></td>
<td>• GDC: Install GDC only</td>
</tr>
<tr>
<td></td>
<td>• GDC, GDCFILEASSOCGDC: Same as ALL</td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, force the removal of the PRODUCTDIR directory, even if it is not empty. For any value other than YES, keep the files in the PRODUCTDIR location. Default value: &quot;&quot;.</td>
</tr>
<tr>
<td>FORCEWRITEPERM=YES</td>
<td>Specify whether to grant read, write, and modify permissions on the installation directory to the Users group. These permissions are needed to allow the GDC auto-updater to work silently. However, granting these permissions may be considered as unsecure. Consult with your Genero application administrator.</td>
</tr>
<tr>
<td></td>
<td>• YES sets the permissions.</td>
</tr>
<tr>
<td></td>
<td>• Any other value but YES will be understood as NO, and the permissions will not be set.</td>
</tr>
</tbody>
</table>

Note: Quotes are only required around the argument value when a space character is in the value string.

Install GDC on macOS™
Procedure for installing GDC on macOS™.

Before you begin
You need a macOS™ and an user account which has administrator access level.

You need the GDC .dmg package. For example: fjs-gdc-3.xx.xx-buildxxxxxx-m64xxxx.dmg, where the "x" are placeholders for version and build numbers.

About this task
Follow these instructions to install the Genero Desktop Client.

1. Close all applications.
2. Double-click on the drive image file (dmg).
   The image file is mounted by macOS™.
3. Double-click on the package file (mpkg).
The installation wizard displays.

4. Follow the installation instructions presented by the wizard.

What to do next

When installation is complete, see the *Genero Desktop Client User Guide* for configuration information and instructions.

### Install GDC on X11 systems

Procedure to install GDC on X11 systems

By default, the script un-compresses data into `DBTEMP`. Please make sure you have the correct permissions for this directory. If you do not have the necessary permissions, either unset `DBTEMP` (`/tmp` will be used), or use the `-w <tempdir>` option to specify an alternate temporary directory.

1. Close all applications.
2. Execute the installation shell. At the command line, enter the name of the package to install.
   
   ```shell
   ./fjs-gdc-version-build-osident.run
   ```
   
   Example:
   
   ```shell
   ./fjs-gdc-3.20.03-build4949-164lx25.run
   ```
   
3. Follow the directions that appear.

What to do next

When installation is complete, see the *Genero Desktop Client User Guide* for configuration information and instructions.

### Microsoft® Windows® Security Blocking

The Windows® firewall, enabled by default, detects and blocks the Genero Studio Server and the Genero Desktop Client.

From the network point of view, Genero Studio Server and the Genero Desktop Client (used by Genero Studio to display forms) are both considered servers. When you start Genero Desktop Client, or attempt to connect to Genero Studio Server, the firewall detects this and blocks the programs.

A dialog allows you to unblock the program. Follow the instructions provided by the dialog.

If you select **Keep Blocking** or **Ask Me Later**, the firewall continues to block the program(s).

If **Keep Blocking** has been pressed by mistake, you can change this parameter in the Windows® Firewall settings. Ensure you add Genero Studio, Genero Studio Server and Genero Desktop Client to the list of exceptions or allowed apps, and make sure that their listings have a check mark.

### Install Genero Application Server

These topics relate to the installation of the Genero Application Server.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

The software is provided as an auto-extractible installation program (i.e. product files and installation program are provided in the same file). The name of the package includes the operating system type and version. You must install the Genero Application Server software package corresponding to the operating system that you use.
The Genero Application Server and the Genero BDL runtime should be installed on the same machine.

**Note:** See the *Genero Application Server User Guide* for additional installation and configuration information.

**System requirements**

For details about system requirements, refer to the *Supported platforms and databases* document (available on the Download page of the Four Js Web site) or contact your support center.

**Related concepts**

- [Installation troubleshooting tips](#) on page 11
  - If you have an issue during installation, generating a log of the installation can provide valuable information for support.

---

**Genero compatibility for the GAS**

Determine the compatibility of different versions of the Genero product family and the Genero Application Server.

**GAS 3.20 and Genero compatibility**

When using Genero Application Server (GAS) 3.20, ensure the other Genero components are based on compatible versions.

The GAS and DVM should be in sync; GAS 3.20 should use FGL 3.20.

The following Genero clients are compatible:

- GDC HTTP 3.20
- GBC 1.00
- GMA 1.40 (where the mobile client is using `runOnServer` to connect to a server-side application.)
- GMI 1.40 (where the mobile client is using `runOnServer` to connect to a server-side application.)

**GAS 3.10 and Genero compatibility**

When using Genero Application Server (GAS) 3.10, ensure the other Genero components are based on compatible versions.

The GAS and DVM should be in sync; GAS 3.10 should use FGL 3.10.

The following Genero clients are compatible:

- GDC HTTP 3.10 and GDC HTTP 3.20
- GBC 1.00
- GMA 1.30 and 1.40 (where the mobile client is using `runOnServer` to connect to a server-side application.)
- GMI 1.30 and 1.40 (where the mobile client is using `runOnServer` to connect to a server-side application.)

**Important:** Genero Web Client for JavaScript (GWC-JS) applies to the Web client 3.xx and lower. Starting with 3.10, GWC-JS was renamed as the Genero Browser Client (GBC).

---

**Install GAS on UNIX™ platforms**

Follow these steps to install the Genero Application Server on UNIX™ platforms.

The installation program provides options that allow you to specify configuration options from the command line. You can display the installation program options using the `-h` option:

```
./fjs-gas-version-build-osident.run -h
```

Example:

```
$ ./fjs-gas-3.20.04-build129065-164x125.run -h
```
The installation program identifies the operating system and checks that all the system requirements are met before starting to copy the product files to disk.

1. To perform the installation, run the auto-extractable shell script:

   ./fjs-gas-version-build-osident.run

   Example:

   $ ./fjs-gas-3.20.04-build129065-164x125.run

2. Once the files are copied to disk, follow the instructions displayed.

What to do next:

When you have completed the installation of the GAS, see FastCGI installation in the Genero Application Server User Guide for details on the Web Server configuration. Afterwards, validate your installation as described in Validating the installation with the GBC or Validating the installation with the GDC in the Genero Application Server User Guide.

Tip: If you have configurations from a previous installation version, for example in your as.xcf, avoid copying these files in to your new installation. The preferred practice is to use the default from the new install package so that you benefit from any new or changed syntax it may contain and then reapply your custom changes.

Install the GAS on UNIX™ platforms in silent mode

Install the Genero Application Server (GAS) silently on Gnu/Linux® and UNIX™ platforms.

To start the installation, type the following:

```
./fjs-gas-version-buildYYYYMMDDhhmm-osident.run -a -q --no-desktop -t install_dir
```

For example:

```
./fjs-gas-3.20.11-build202006111557-132a1228.run -a -q --no-desktop -t $PWD/gas-3.20.11
```

Options

Table 9: UNIX install options on page 24 shows the most common options relating to installation.

**Table 9: UNIX™ install options**

<table>
<thead>
<tr>
<th>Install option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a or --accept</td>
<td>Bypass the display and the prompt for acceptance of the license agreement. Using the -a option indicates that you have read and accepted the End User License Agreement contained in the .txt files in the license directory of the install directory.</td>
</tr>
<tr>
<td>-h or --help</td>
<td>Display help about all possible options.</td>
</tr>
<tr>
<td>-q or --quiet</td>
<td>Silent mode with no UI. If -q is not specified, the interactive installer is used.</td>
</tr>
</tbody>
</table>
Install option | Description
---|---
-f backup|overwrite|remove or --force backup|overwrite|remove | Specify what happens if the installation directory already exists:
- backup: Back up the installation directory.
- overwrite: Overwrite installation file.
- remove: Delete installation directory before installing.
-t install_dir or --target install_dir | Install the product in the specified target directory. If -t is not specified, the default installation is used.
-d or --dvm | Specify the FGL directory to configure .xcf files.
--gredir | Specify the GRE directory to configure .xcf files.
--no-desktop | Desktop bindings are not installed, which means:
- Desktop and system menu icons are not created.
- File types are not automatically associated with the product.

Install GAS on Windows®

Install the Genero Application Server on Microsoft® Windows® platforms.

On Microsoft® Windows®, the GAS is provided as a standard Windows® setup program.

If you plan on installing the ISAPI connector for the integration of the GAS within IIS, you must install IIS first, prior to running the setup program. On IIS 7.x, ensure also that the IIS Management Scripts and Tools component under Management Tools (or Web Management Tools) is installed.

The installation program and the distribution files are provided in the same file:

fjs-gas-version-build-osident.exe

To install execute the setup program:

Example:

fjs-gas-3.20.04-build129065-w32v100.exe

A wizard guides you through the installation process.

What to do next:

Tip: If you have configurations from a previous installation version, for example in your as.xcf file, avoid copying this in to your new installation. The preferred practice is to use the default configuration file from the new install package so that you benefit from any new or changed syntax it may contain and then reapply your custom changes.

When the installation completes, follow the instructions to install and configure the ISAPI dispatcher in the Genero Application Server User Guide.

Install GAS on Windows® in silent mode

Install the Genero Application Server on Windows® platforms using the MSI installer.

The msiexec utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The /qn option allows you to install in silent mode. The msiexec utility expects an msi file. To be
compliant with Microsoft® User Access Control (UAC) requirements, the msi file is embedded inside an exe file. To extract the msi file from the exe file, use the /x option:

```
msiexec /x
```

For example:

```
fjs-gas-3.20.05-build129065-v32v100.exe /x
```

A msi file is created in the same directory and with the same name as the exe file.

**Options**

Table 10: msiexec install and uninstall options on page 26 shows the most common options for msiexec relating to installation and un-installation.

**Table 10: msiexec install and uninstall options**

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/qn</td>
<td>Silent mode with no UI. If /qn is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td>/i package-name.msi</td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td>/x package-name.msi</td>
<td>Uninstall the specified msi package.</td>
</tr>
<tr>
<td>/log logfile</td>
<td>Write processing info to the specified log file.</td>
</tr>
<tr>
<td>/l*vx logfile</td>
<td>Provide verbose (detailed) logs in the specified log file</td>
</tr>
</tbody>
</table>

Enter msiexec from the command prompt to view the complete list of available options.

**Arguments**

You can pass arguments to the msiexec installer on the command line.

**Table 11: Arguments for the misexec installer**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_gasdir_path</td>
<td>Path where GAS will be installed. It is an alias of GASDIR.</td>
</tr>
<tr>
<td>GASDIR=your_gasdir_path</td>
<td>Path where GAS will be installed. It is an alias of PRODUCTDIR.</td>
</tr>
<tr>
<td>FGLDIR=your_fgldir_path</td>
<td>Path where Genero BDL is installed. Used only when SETFGLDIR=1.</td>
</tr>
<tr>
<td>SETFGLDIR=1</td>
<td>Enable the FGLDIR variable. Default value is 0 (zero).</td>
</tr>
<tr>
<td>GREDIR=your_gredir_path</td>
<td>Path where GRE is installed. Used only when SETGREDIR=1.</td>
</tr>
<tr>
<td>SETGREDIR=1</td>
<td>Enable the GREDIR variable. Default value is 0 (zero).</td>
</tr>
<tr>
<td>ADDLOCAL=GAS</td>
<td>Install the GAS without ISAPI. Set the parameter to ALL to install the GAS with the ISAPI extension.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example: &quot;fjs\gas&quot;</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FORCEREMOVPRODUCTDIR=YES</td>
<td>On uninstall, remove the PRODUCTDIR location even if it is not empty. Default value: &quot; &quot;</td>
</tr>
<tr>
<td>ALLUSERS=1</td>
<td>Install system-wide, for all users. Always set to 1.</td>
</tr>
</tbody>
</table>

**Note:** Quotes are only required around the argument value when a space character is in the value string.

**Silent install example**

```plaintext
msiexec /qn /i fjs-gas-3.20.08-build129065-v32v100.msi /log gas3_20_08.log
PRODUCTDIR=c:\tmp\gas2 ADDLOCAL=ALL ALLUSERS=1
```

**Silent uninstall example**

```plaintext
msiexec /qn /x fjs-gas-2.50.04-build129065-v32v100.msi /log as2_50_04.log
```

**Install GAS on macOS™**

**Before you begin**

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.

You should have completed the installations for Genero BDL (mandatory) and Genero Report Engine (if necessary) before you start this task.

- The installation of Genero BDL is mandatory.
- The installation of Genero Report Engine is only necessary if you plan to use the Genero Report Writer through applications running on the GAS.

You will be asked to provide the directory paths for both BDL and GRE.

**About this task**

Follow these instructions to install the Genero Application Server on macOS.

1. Determine the directory where you will install the product.
   The wizard will eventually suggest `/opt/fourjs/gas`. If you plan to use this default, ensure you have write permission to this directory.
2. Log in as a user with permission to write to the directory in which you plan to install this product.
3. Copy the self-extractable file into a temporary directory.
4. From a command prompt, run the self-extractable shell script with the `-i` option:

   ```plaintext
   sh fjs-gas-3.xx.xx-buildxxxxxxxx-m64x1011.run -i
   ```

   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!
5. Follow the instructions displayed.
   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.

**What to do next**

When installation is complete, see the *Genero Application Server User Guide* for configuration information and instructions.
Install Genero Studio

These topics relate to the installation of the Genero Studio.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

The Genero Studio software package includes Genero Studio, Genero Business Development Language, Genero Application Server, Genero Desktop Client, Genero Web Client, Genero Web Services, Genero Mobile and Genero Report Writer. During the installation process, you can select which components to include or exclude. By default, the wizard installs all components.

Genero Studio can be used as a standalone application, or in a client/server mode. The packages for Windows® and GNU/Linux® install client and server programs.

Use a standalone scheme when you want to use local Genero and Genero Desktop Client installations and compile files locally.

If the Genero installation and your project files are on another machine, install Genero Studio on this machine and run the server program only. You will have to declare the Genero Studio Server in your local Genero Studio (client) configuration in order to use it.

Note: See the Genero Studio User Guide for additional installation and configuration information.

Note: See the Genero Business Development Language User Guide for details on configuring Genero Mobile for Android™ and iOS. Those configuration topics contain additional system requirements for each mobile platform.

If you do not have a valid maintenance key for Genero, you must License Genero Report Engine (GRE) on page 90.

System requirements

For details about system requirements, refer to the Supported platforms and databases document (available on the Download page of the Four Js Web site) or contact your support center.

Related concepts

Installation troubleshooting tips on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

GST 3.20 and Genero compatibility

When using Genero Studio (GST) 3.20, ensure the other Genero components are based on compatible versions.

Genero Studio 3.20 is compatible with:

• FGL 3.00 and above
• GDC 3.00 and above
  
  Note: GST may work with older versions of FGL and GDC.
• GAS 3.00 and above
• GRE 3.20
• GGC 2.00
• GMI and GMA 1.4
Install Genero Studio on UNIX™ platforms

Follow these steps to install Genero Studio on Gnu/Linux® and UNIX™.

1. Type the following command to start the installation:

   ```
   $ sh fjs-gst-version-build-osident.run
   ```

   Example:

   ```
   $ sh fjs-gst-3.20.05-build156401-164x124.run
   ```

2. Follow the instructions provided on the screen.

What to do next

When installation is complete, see the Configuring Genero Studio page in the Genero Studio User Guide.

Install Genero Studio on UNIX™ platforms in silent mode

Install Genero Studio silently on Gnu/Linux® and UNIX™ platforms.

Before you begin: Ensure that your PATH environment variable contains the full path to the java binary that you want to use with Genero Studio tools.

To start the installation, type the following:

```bash
./fjs-gst-version-buildYYYYMMDDhhmm-osident.run -a -q --no-desktop -t install_dir
```

For example:

```bash
./fjs-gst-3.20.10-build202006051012-164x1217.run -a -q --no-desktop -t $PWD/fjs-gst-3.20.10
```

Options

Table 12: UNIX install options on page 29 shows the most common options relating to installation.

Table 12: UNIX™ install options

<table>
<thead>
<tr>
<th>Install option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a or --accept</td>
<td>Bypass the display and the prompt for acceptance of the license agreement.</td>
</tr>
<tr>
<td></td>
<td>Using the –a option indicates that you have read and accepted the End User</td>
</tr>
<tr>
<td></td>
<td>License Agreement contained in the .txt files (in the license directory of</td>
</tr>
<tr>
<td></td>
<td>the install directory).</td>
</tr>
<tr>
<td>–h or --help</td>
<td>Display help about all possible options.</td>
</tr>
<tr>
<td>–q or --quiet</td>
<td>Silent mode with no UI. If –q is not specified, the interactive installer</td>
</tr>
<tr>
<td></td>
<td>is used.</td>
</tr>
<tr>
<td>-f backup</td>
<td>overwrite</td>
</tr>
<tr>
<td></td>
<td>• backup: Back up the installation directory.</td>
</tr>
<tr>
<td></td>
<td>• overwrite: Overwrite installation file.</td>
</tr>
<tr>
<td></td>
<td>• remove: Delete installation directory before installing.</td>
</tr>
</tbody>
</table>
Install option | Description
---|---
--t install_dir or --target install_dir | Install the product in the specified target directory. If --t is not specified, the default installation is used.
--no-desktop | Desktop bindings are not installed, which means:
  • Desktop and system menu icons are not created.
  • File types are not automatically associated with the product.

Install Genero Studio on Windows®

Procedure to install Genero Studio on Windows®.

1. Execute the package name to start the Setup Wizard.
   
   \textit{fjs-gst-version-build-osident.exe}
   
   Example:
   
   \textit{fjs-gst-3.20.03-build127192-w32v100.exe}

2. When the Welcome page displays, click Next.

3. End-User License Agreement - Read and accept the license agreement and click Next.

4. Third-Party License Agreement - Read and accept the terms of the license agreement and click Next.

5. Setup Type - Select your machine type and components:
   
   • Workstation or Server - Full installs the entire product suite.
   • Workstation - Minimal installs the workstation for development using a Studio Server only.
   • Server - Minimal installs the server tools only.
   
   Click Next.

6. Destination Folder - Specify the destination folder for your Genero installation (or use the default) and click Next.

7. Start Menu Folder - Select the folder and click Next.

8. Licensing - If you want to license the product directly after it is installed, select the appropriate check boxes:
   
   • License Genero Business Language - Select if you want to install the BDL. This is the default.
   • License Genero Report Engine - Select only if you have a specific GRE license.
   
   For further information about licensing types, see \textit{Genero Licensing} manual.

   If you deselect all check boxes, you need to license the product at a later time. See License Genero Business Development Language on page 58 and License Genero Report Engine (GRE) on page 90.

   Click Next to continue.


10. Ready to install - Click Install to begin the installation.

11. If you chose to license Studio during the installation, the License Information appears as well as the maintenance key (if available). Click Install. Alternatively, select the check box to use the Four Js Activation Server.
   
   a) Enter the license number and the license key, and click Install.
   b) Enter the maintenance key and click Update Key.
   c) Click Quit to leave the License Information dialog.

12. Click Finish.

   The installation completes and the install wizard closes.
What to do next

When installation is complete, see the Configuring Genero Studio page in the Genero Studio User Guide.

Install Genero Studio on Windows® in silent mode

Install Genero Studio on Windows® platforms using the MSI installer.

The msiexec utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The /qn option allows you to install in silent mode. The msiexec utility expects an msi file. To be compliant with Microsoft® User Access Control (UAC) requirements, the msi file is embedded inside an exe file. To extract the msi file from the exe file, use the /x option:

```shell
fjs-gst-version-build-osident.exe /x
```

For example:

```shell
fjs-gst-3.20.04-build123456-w64v120.exe /x
```

A msi file is created in the same directory and with the same name as the exe file.

Options

Table 13: msiexec install and uninstall options on page 31 shows the most common options for msiexec relating to installation and un-installation.

Table 13: msiexec install and uninstall options

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/qn</td>
<td>Silent mode with no UI. If /qn is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td>/i package-name.msi</td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td>/x package-name.msi</td>
<td>Uninstall the specified msi package.</td>
</tr>
<tr>
<td>/log logfile</td>
<td>Write processing info to the specified log file.</td>
</tr>
<tr>
<td>/l*vx logfile</td>
<td>Provide verbose (detailed) logs in the specified log file</td>
</tr>
</tbody>
</table>

Enter msiexec from the command prompt to view the complete list of available options.

Arguments

You can pass arguments to the msiexec installer on the command line.

Table 14: Arguments for the msiexec installer

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_gstdir_path</td>
<td>Path where GST will be installed. It is an alias of GSTDIR.</td>
</tr>
<tr>
<td>GENEROSTUDIODIR=your_gstdir_path</td>
<td>Path where GST will be installed. It is an alias of GSTDIR.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example: &quot;fjs\gst&quot;</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ADDLOCAL=option</td>
<td>Use <em>option</em> to set the features to install.</td>
</tr>
</tbody>
</table>

**Table 15: Option values for ADDLOCAL**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Install Genero Studio (GSTIDE), all Genero Studio file associations (GSTFILEASSOC), Genero Studio to the context menu (GSTIDECONTEXTMENU), Genero Desktop Client and its file associations (GDC + GDCFILEASSOCGDC), Genero Business Development Language (FGL), Genero Report Engine (GRE), and the Genero Application Server (GAS).</td>
</tr>
<tr>
<td>GSTIDE</td>
<td>Install Genero Studio (mandatory).</td>
</tr>
<tr>
<td>GSTFILEASSOC</td>
<td>Install all Genero Studio file associations.</td>
</tr>
<tr>
<td>GSTFILEASSOCSOURCEFILES</td>
<td>Install all Genero Studio source file associations.</td>
</tr>
<tr>
<td>GSTFILEASSOCBINARYFILES</td>
<td>Install all Genero Studio binary file associations.</td>
</tr>
<tr>
<td>GSTFILEASSOCWEBXMLFILES</td>
<td>Install all Genero Studio WebXML file associations.</td>
</tr>
<tr>
<td>GSTIDECONTEXTMENU</td>
<td>Install Genero Studio to the context menu.</td>
</tr>
<tr>
<td>GDC</td>
<td>Install the Genero Desktop Client (GDC).</td>
</tr>
<tr>
<td>GDCFILEASSOCGDC</td>
<td>Install the GDC file associations.</td>
</tr>
<tr>
<td>FGL</td>
<td>Install the Genero Business Development Language (BDL).</td>
</tr>
<tr>
<td>GRE</td>
<td>Install the Genero Report Engine (GRE).</td>
</tr>
<tr>
<td>GAS</td>
<td>Install the Genero Application Server (GAS).</td>
</tr>
</tbody>
</table>

Default value: GSTIDE, GSTFILEASSOCSOURCEFILES, GSTFILEASSOCBINARYFILES, GSTIDECONTEXTMENU, GDC, GDCFILEASSOCGDC, FGL, GRE, GAS.
### Argument Description

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAVADIR=your_jvm_path</td>
<td>Location of the Java Virtual Machine (JVM). This option is required for the Genero Report Engine (GRE).</td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, force the removal of the PRODUCTDIR directory, even if it is not empty. For any value other than YES, keep the files in the PRODUCTDIR location. Default value: &quot;&quot;.</td>
</tr>
</tbody>
</table>

**Note:** Quotes are only required around the argument value when a space character is in the value string.

**Tip:** To determine the required arguments for the silent installation, run the installer graphically and generate a log file that records your choices. The log file will contain the argument values for your command line script. This is particularly useful for the ADDLOCAL argument, which can be complex.

1. Install the product using the graphical installer (without /qn) and specify a log file, for example:

   ```
   msiexec /i fjs-gst-3.20.08-build167272-w64v141.msi /l gst_install.log
   ```

2. Open the log file.

3. Search the log file for the arguments you need, for example ADDLOCAL and PRODUCTDIR. Copy the values.

4. Install the product again (you may need to uninstall first), this time using silent mode (with /qn) and specifying the copied arguments. For example:

   ```
   msiexec /qn /i fjs-gst-3.20.08-build167272-w64v141.msi
   PRODUCTDIR="C:\Program Files\FourJs\Genero Studio\3.20.08"
   ADDLOCAL="GENEROSTUDIO,GSTIDE,GDC,FGL,GRE,
   GAS,VC100_CRT_x86_x64,VC120_CRT_x86_x64,VC141_CRT_x86_x64,GSTFILEASSOC4AD,GSTFILEASSOC4ASSOC4DS,GSTFILEASSOC4DBX,GSTFILEASSOC4DM,GSTFILEASSOC4FD,GSTFIL"
   ```

5. Save the installation instructions to a script, so it can be reused and distributed.

### Silent install example

This command installs GST 3.20.03 with all products, and sets the location of the Java Virtual Machine (JRE):

```
msiexec /qn /i fjs-gst-3.20.03-build155239-alpha-w64v120.msi /log gst.log
PRODUCTDIR="C:\fjs\gst32003" ADDLOCAL=ALL JAVADIR="C:\Program Files\Java\jdk1.7.0_80\bin"
```

### Silent uninstall example

This command removes GST 3.10.05 and removes the product directory:

```
msiexec /qn /x fjs-gst-3.10.05-build155239-alpha-w64v120.msi /log
gst_remove.log FORCEREMOVEPRODUCTDIR=YES
```
If **Keep Blocking** has been pressed by mistake, you can change this parameter in the Windows® Firewall settings. Ensure you add Genero Studio, Genero Studio Server and Genero Desktop Client to the list of exceptions or allowed apps, and make sure that their listings have a check mark.

### Install Genero Studio on macOS™ (GUI installer)

**Procedure to install Genero Studio on macOS™.**

**Before you begin**

You need a macOS™ and an user account which has administrator access level.

You need the GST .dmg package. For example: `fjs-gst-3.xx.xx-buildxxxxxxx-m64xxxxx.dmg`, where the "x" are placeholders for version and build numbers.

**About this task**

Follow these instructions to install Genero Studio.

1. Double-click on the `.dmg` package in the finder. The `.dmg` mounts. You have a new icon on your desktop with the same name as the package (`fjs-gst-3.20.00-buildxxxxxxx-m64x106`, for example).

2. Double click on the new icon.
   
   It will display a new window containing `fjs-gst-3.20.00-buildxxxxxxx-m64x106.pkg`.

3. Double click on the `fjs-gst-3.20.00-buildxxxxxxx-m64x106.pkg` to launch the installation process.

   The GUI installer can be installed GST in /Applications or $HOME/Applications. You can have several GST installed in the same time.

4. Follow the installation instructions presented by the wizard.

**What to do next**

When installation is complete, see the *Configuring Genero Studio* page in the *Genero Studio User Guide*.

### Debug the Genero Studio Install on macOS™ (GUI installer)

**Procedure to debug the install Genero Studio on macOS™.**

Follow these steps to debug a failed installation in GUI mode:

1. When the installation process begins, you will have a "Window" menu. Go to the **Window** menu and choose the **Installer Log** item.

   It launches a window where the installation logs are displayed.

2. To the left of the new window, you can choose **Show all logs** from a combobox.

3. When the installation process ends (with or without error), you can use the save button to create a file containing all log messages.

### Install Genero Studio on macOS™ (command line)

**Procedure to install Genero Studio on macOS™.**

**Before you begin**

You need a macOS™ and an user account which has administrator access level.

You need the GST .dmg package. For example: `fjs-gst-3.xx.xx-buildxxxxxxx-m64xxxxx.dmg`, where the "x" are placeholders for version and build numbers.

1. Open a terminal.
2. Mount the `.dmg` file using the `hdiutil` tool:

   ```bash
   hdiutil mount fjs-gst-2.50.00-buildxxxxxxx-m64x105.dmg
   ```
3. Launch the install process:
   ```
   sudo installer -pkg /Volumes/fjs-gst-2.50.00-buildxxxxxx-m64x106/fjs-gst-2.50.00-buildxxxxxx-m64x106.pkg/ -target "/Volumes/Macintosh HD"
   ```

4. Change the owner of $HOME/.Fourjs:
   ```
   sudo chown -R [My Account]:staff $HOME/.Fourjs
   ```

5. Unmount the dmg:
   ```
   hdiutil unmount /Volumes/fjs-gst-2.50.00-buildxxxxxx-m64x106
   ```

What to do next

When installation is complete, see the Configuring Genero Studio page in the Genero Studio User Guide.

Debug the Genero Studio Install on macOS™ (command line)

Procedure to debug the install Genero Studio on macOS™.

To debug a failed installation, use the following command line:

```
sudo installer -pkg /Volumes/fjs-gst-2.50.00-buildxxxxxx-m64x106/fjs-gst-2.50.00-buildxxxxxx-m64x106.pkg/ -target "/Volumes/Macintosh HD" -dumplog -verbose 2>&1  | tee fjs-gst-2.50.00-buildxxxxxx-m64x106.log
```

Install Genero Studio Server Suite

These topics relate to the installation of the Genero Studio Server Suite

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

The Genero Suite Server package is intended for production or for remote development (where you are developing on a server machine and the IDE is not available for the platform).

It only includes the server components.

The Genero Studio Server Suite software package includes Genero Studio Server, Genero Business Development Language, Genero Application Server, and Genero Report Engine. During the installation process, you can select which components to include or exclude. By default, the wizard installs all components.

It does not include the Genero Desktop Client (GDC). If you download this package, you must also download the GDC separately to handle any client needs.

**Note:** See the Genero Studio User Guide for additional installation and configuration information.

If you do not have a valid maintenance key for Genero, you must License Genero Report Engine (GRE) on page 90.

**System requirements**

For details about system requirements, refer to the Supported platforms and databases document (available on the Download page of the Four Js Web site) or contact your support center.

**Related concepts**

Installation troubleshooting tips on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Install Genero Studio Server Suite on UNIX™ platforms**

Follow these steps to install Genero Studio Server Suite on Gnu/Linux® and UNIX™.

**Before you begin**

You must have Java installed. You will be asked to provide the Java directory as part of the installation.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

You will also be asked to identify a default database driver. Be prepared to provide an answer to that question.

1. Type the following command to start the installation:
   
   ```bash
   $ sh fjs-gstsrv-version-build-osident.run
   
   Example:
   $ sh fjs-gstsrv-3.20.05-build156401-164x124.run
   
   2. Follow the instructions provided on the screen.

**What to do next**

When installation is complete, see the **Genero Application Server User Guide** for configuration information and instructions.

**Install Genero Studio Server Suite on UNIX™ platforms in silent mode**

Install Genero Studio Server Suite silently on Gnu/Linux® and UNIX™ platforms.

To start the installation, type the following:

```bash
./fjs-gstsrv-version-buildYYYYMMDDhhmm-osident.run -a -q -t install_dir
```

For example:

```bash
./fjs-gstsrv-3.20.05-build202006051012-164x1217.run -a -q -t $PWD/fjs-

gstsrv-3.20.05
```

**Options**

Table 16: UNIX install options on page 36 shows the most common options relating to installation.

**Table 16: UNIX™ install options**

<table>
<thead>
<tr>
<th>Install option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a or --accept</td>
<td>Bypass the display and the prompt for acceptance of the license agreement. Using the -a option indicates that you have read and accepted the End User License Agreement contained in the .txt files (in the license directory of the install directory).</td>
</tr>
<tr>
<td>-h or --help</td>
<td>Display help about all possible options.</td>
</tr>
<tr>
<td>-q or --quiet</td>
<td>Silent mode with no UI. If -q is not specified, the interactive installer is used.</td>
</tr>
</tbody>
</table>
Install Genero Studio Server Suite on Windows®

Procedure to install Genero Studio Server Suite on Windows®.

Before you begin

You must have Java installed. You will be asked to provide the Java directory as part of the installation.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

You will also be asked to identify a default database driver. Be prepared to provide an answer to that question.

1. Execute the package name to start the Setup Wizard.
   
   \texttt{fjs-gstsrv-version-build-osident.exe}
   
   Example:
   
   \texttt{fjs-gstsrv-3.20.03-build127192-w32v100.exe}

2. When the Welcome page displays, click Next.

3. End-User License Agreement - Read and accept the license agreement and click Next.

4. Third-Party License Agreement - Read and accept the terms of the license agreement and click Next.

5. Product Features - Select which components to install and click Next.
   
   By default, all components are selected for installation. The list box for each feature or component allows you to specify whether:
   
   • Feature/component will be installed on the local hard drive
   • Entire feature will be installed on the local hard drive
   • Entire feature will be unavailable

6. Destination Folder - Specify the destination folder for your Genero installation (or use the default) and click Next.

7. Start Menu Folder - Select the folder and click Next.

8. Licensing - If you want to license the product directly after it is installed, select the appropriate check boxes:
   
   • License Genero Business Language - Select if you want to install the BDL. This is the default.
   • License Genero Report Engine - Select only if you have a specific GRE license.

   For further information about licensing types, see Genero Licensing manual.

   If you deselected all check boxes, you need to license the product at a later time. See License Genero Business Development Language on page 58 and License Genero Report Engine (GRE) on page 90.

   Click Next to continue.

10. **Ready to install** - Click **Install** to begin the installation.

11. If you chose to license Studio during the installation, the **License Information** appears as well as the maintenance key (if available). Click **Install**. Alternatively, select the check box to use the Four Js Activation Server.
   a) Enter the license number and the license key, and click **Install**.
   b) Enter the maintenance key and click **Update Key**.
   c) Click **Quit** to leave the License Information dialog.

12. Click **Finish**.
   The installation completes and the install wizard closes.

**What to do next**
When installation is complete, see the *Genero Application Server User Guide* for configuration information and instructions.

**Install Genero Studio Server Suite on Windows® in silent mode**

Install Genero Studio Server Suite on Windows® platforms using the MSI installer.

The `msiexec` utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The `/qn` option allows you to install in silent mode. The `msiexec` utility expects an `.msi` file. To be compliant with Microsoft® User Access Control (UAC) requirements, the `.msi` file is embedded inside an `.exe` file. To extract the `.msi` file from the `.exe` file, use the `/x` option:

```
fjs-gstsrv-version-build-osident.exe /x
```

For example:

```
fjs-gstsrv-3.20.08-build167272-w64v141.exe /x
```

A `.msi` file is created in the same directory and with the same name as the `.exe` file.

**Options**

Table 17: msiexec install and uninstall options on page 38 shows the most common options for `msiexec` relating to installation and un-installation.

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/qn</code></td>
<td>Silent mode with no UI. If <code>/qn</code> is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td><code>/i package-name.msi</code></td>
<td>Install the specified <code>.msi</code> package.</td>
</tr>
<tr>
<td><code>/x package-name.msi</code></td>
<td>Uninstall the specified <code>.msi</code> package.</td>
</tr>
<tr>
<td><code>/log logfile</code></td>
<td>Write processing info to the specified log file.</td>
</tr>
<tr>
<td><code>/l+v* logfile</code></td>
<td>Provide verbose (detailed) logs in the specified log file</td>
</tr>
</tbody>
</table>

Enter `msiexec` from the command prompt to view the complete list of available options.

**Arguments**

You can pass arguments to the `msiexec` installer on the command line.
Table 18: Arguments for the msiexec installer

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_gstsvrdir_path</td>
<td>Path where GSTSRV will be installed. It is an alias of GSTDIR.</td>
</tr>
<tr>
<td>GENEROSTUDIO=your_gstsvrdir_path</td>
<td>Path where GSTSRV will be installed. It is an alias of GSTDIR.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example: &quot;fjs\gstsrv&quot;</td>
</tr>
<tr>
<td>ADDLOCAL=option</td>
<td>Use option to set the features to install.</td>
</tr>
</tbody>
</table>

Table 19: Option values for ADDLOCAL

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Install Genero Studio Server Suite (GSTSRVCORE), Genero Business Development Language (FGL), Genero Report Engine (GRE), and the Genero Application Server (GAS).</td>
</tr>
<tr>
<td>GSTIDE</td>
<td>Install Genero Studio Server Suite (mandatory).</td>
</tr>
<tr>
<td>FGL</td>
<td>Install the Genero Business Development Language (BDL).</td>
</tr>
<tr>
<td>GRE</td>
<td>Install the Genero Report Engine (GRE).</td>
</tr>
<tr>
<td>GAS</td>
<td>Install the Genero Application Server (GAS).</td>
</tr>
</tbody>
</table>

| JAVADIR=your_jvm_path          | Location of the Java Virtual Machine (JVM). This option is required for the Genero Report Engine (GRE). |
| FORCEREMovePRODUCTDIR=YES     | On uninstall, force the removal of the PRODUCTDIR directory, even if it is not empty. For any value other than YES, keep the files in the PRODUCTDIR location. Default value: "." |

Note: Quotes are only required around the argument value when a space character is in the value string.

Silent install example

This command installs GSTSRV 3.20.08 with all products, and sets the location of the Java Virtual Machine (JRE):

```bash
msiexec /qn /i fjs-gstsvr-3.20.08-build167272-w64v141.msi /log gstsrv.log PRODUCTDIR="c:\fjs\gst32008" ADDLOCAL=ALL JAVADIR="C:\Program Files\Java\jdk1.7.0_80\bin"
```
Silent uninstall example

This command removes GSTSRV 3.10.04 and removes the product directory:

```
msiexec /qn /x fjs-gstsrv-3.10.04-build155239-alpha-w64v120.msi /log gstsrv_remove.log FORCEREMOVEPRODUCTDIR=YES
```

Install Genero Studio Server Suite on macOS™

Procedure to install Genero Studio Server Suite on macOS™.

Before you begin

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.

You must have Java installed. You will be asked to provide the Java directory as part of the installation.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

You will also be asked to identify a default database driver. Be prepared to provide an answer to that question.

About this task

This installation package can install Genero Studio Server, Genero BDL, Genero Report Engine, and the Genero Application Server. You can follow the wizard suggestions and install all four at this time, or you can select and pick which components to install.

Follow these instructions to install the Genero Studio Server on macOS.

1. Determine the directory where you will install the product.
   - The wizard will eventually suggest `/opt/fourjs/gstsrv`. If you plan to use this default, ensure you have write permission to this directory.
2. Log in as a user with permission to write to the directory in which you plan to install this product.
3. Copy the self-extractable file into a temporary directory.
4. From a command prompt, run the self-extractable shell script with the `-i` option:
   ```
   sh fjs-gstsrv-3.xx.xx-buildxxxxxx-m64x1011.run -i
   ```
   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!
5. Follow the instructions displayed.
   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.
   - At some point in the instructions, if you elected to install Genero BDL, you will be asked whether you wish to provide the licensing details for the Genero Business Development Language. If you skip this step during the installation, you can always go back later to provide the licensing details.
   - If asked about providing the licensing details for the Genero Report Engine, you can choose to not license the GRE. A GRE license is not necessary if you have a Genero BDL license with maintenance support.

What to do next

When installation is complete, see the Genero Application Server User Guide for configuration information and instructions.
Install the Genero Mobile for Android front-end application

Install Genero Mobile for Android™ (GMA) with Genero Studio, or download the package and install from the command line.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

Using Genero Studio

Genero Studio comes with everything you need to install the GMA front-end application onto your device. Follow the procedures in the Configure Genero Mobile for Android section of the Genero Studio User Guide for installation and configuration information.

From the command line

To install from the command line, you must:

• Install Genero Business Development Language
• Download the Genero Mobile for Android™ (GMA) package from the Four Js product download page (visit http://www.4js.com/download/products). This package contains the gmabuildtool tool and the APK ready to install.

Follow the instructions provided in Genero mobile development client for Android in the Genero Business Development Language User Guide for installation and configuration information.

Genero compatibility for GMA

Determine the compatibility of different versions of the Genero product family and Genero Mobile for Android™ (GMA).

GMA 1.40 and Genero compatibility

When using Genero Mobile for Android™ (GMA) 1.40, ensure the other Genero components are based on compatible versions.

GMA 1.40 uses the Genero 3.20 development environment (it requires FGL 3.20 to compile the app). The runtime embedded in GMA 1.40 is FGL 3.20.

Where the mobile client application is using runOnServer, GMA 1.40 is compatible with:

• GAS 3.20 + FGL 3.20
• GAS 3.10 + FGL 3.10
• GAS 3.00 + FGL 3.00

Related concepts
GAS 3.20 and Genero compatibility on page 23
When using Genero Application Server (GAS) 3.20, ensure the other Genero components are based on compatible versions.

GMI 1.40 and Genero compatibility on page 43
When using Genero Mobile for iOS (GMI) 1.40, ensure the other Genero components are based on compatible versions.

GDC 3.20 and Genero compatibility on page 17
GMA 1.30 and Genero compatibility

When using Genero Mobile for Android™ (GMA) 1.30, ensure the other Genero components are based on compatible versions.

GMA 1.30 uses the Genero 3.10 development environment (it requires FGL 3.10 to compile the app). The runtime embedded in GMA 1.30 is FGL 3.10.

Where the mobile client application is using runOnServer, GMA 1.30 is compatible with:

• GAS 3.10 + FGL 3.10
• GAS 3.00 + FGL 3.00

GMA 1.20 and Genero compatibility

When using Genero Mobile for Android™ (GMA) 1.20, ensure the other Genero components are based on compatible versions.

GMA 1.20 uses the Genero 3.00 development environment (it requires FGL 3.00 to compile the app). The runtime embedded in GMA 1.20 is FGL 3.00.

Where the mobile client application is using runOnServer, GMA 1.20 is compatible with:

• GAS 3.00 + FGL 3.00

Install the Genero Mobile for iOS front-end application

Install the Genero Mobile for iOS front-end application with Genero Studio, download and install from the App Store, or download the package and install from the command line.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

Using Genero Studio

Genero Studio comes with everything you need to install the GMI front-end application onto your device. Follow the procedures in the Configure Genero Mobile for iOS section of the Genero Studio User Guide for installation and configuration information.

From the App Store

The Genero Mobile app is available from the App Store.

1. Go to the App Store.
2. Search for "Genero Development Client".
3. Select and install the "Genero Development Client".

Refer to the Genero mobile development client for iOS from the Genero Business Development Language User Guide for additional configuration and usage information.

From the command line

To build and install the GMI front-end from the command line, you must:

• Install Genero Business Development Language
• Download the Genero Mobile for iOS (GMI) package from the Four Js product download page (visit http://www.4js.com/download/products).

Follow the instructions provided in Genero mobile development client for iOS from the Genero Business Development Language User Guide for installation and configuration information.
Genero compatibility for GMI

Determine the compatibility of different versions of the Genero product family and Genero Mobile for iOS (GMI).

GMI 1.40 and Genero compatibility

When using Genero Mobile for iOS (GMI) 1.40, ensure the other Genero components are based on compatible versions.

GMI 1.40 uses the Genero 3.20 development environment (it requires FGL 3.20 to compile the app). The runtime embedded in GMI 1.40 is FGL 3.20.

Where the mobile client application is using `runOnServer`, GMI 1.40 is compatible with:

- GAS 3.20 + FGL 3.20
- GAS 3.10 + FGL 3.10
- GAS 3.00 + FGL 3.00

Related concepts

GAS 3.20 and Genero compatibility on page 23
When using Genero Application Server (GAS) 3.20, ensure the other Genero components are based on compatible versions.

GMA 1.40 and Genero compatibility on page 41
When using Genero Mobile for Android™ (GMA) 1.40, ensure the other Genero components are based on compatible versions.

GDC 3.20 and Genero compatibility on page 17

GMI 1.30 and Genero compatibility

When using Genero Mobile for iOS (GMI) 1.30, ensure the other Genero components are based on compatible versions.

GMI 1.30 uses the Genero 3.10 development environment (it requires FGL 3.10 to compile the app). The runtime embedded in GMI 1.30 is FGL 3.10.

Where the mobile client application is using `runOnServer`, GMI 1.30 is compatible with:

- GAS 3.10 + FGL 3.10
- GAS 3.00 + FGL 3.00

GMI 1.20 and Genero compatibility

When using Genero Mobile for iOS (GMI) 1.20, ensure the other Genero components are based on compatible versions.

GMI 1.20 uses the Genero 3.00 development environment (it requires FGL 3.00 to compile the app). The runtime embedded in GMI 1.20 is FGL 3.00.

Where the mobile client application is using `runOnServer`, GMI 1.20 is compatible with:

- GAS 3.00 + FGL 3.00

Install Genero Report Engine

These topics relate to the installation of the Genero Report Engine.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.
If your Genero Business Development Language (BDL) installation has a valid maintenance key, you do not need to license the Genero Report Engine. Otherwise, you must license your GRE installation.

**System requirements**

For details about system requirements, refer to the Supported platforms and databases document (available on the Download page of the Four Js Web site) or contact your support center.

**Note:** The binary format of the GRE does not need to match the binary format of the JVM. For example, a 64-bit GRE can run with either a 32-bit or a 64-bit JVM.

**Related concepts**

Installation troubleshooting tips on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

---

### Install GRE on UNIX™ platforms

Follow these steps to install Genero Report Engine on Gnu/Linux® and UNIX™.

1. Type the following command to start the installation:

   ```bash
   $ sh fjs-gre-version-build-osident.run
   ```

   Example:

   ```bash
   $ sh fjs-gre-3.20.05-build127148-164x124.run
   ```

2. Follow the instructions provided on the screen.

   When installation is complete, see Report Writer in the Genero Studio User Guide for configuration information and instructions.

### Install Genero Report Engine on UNIX™ platforms in silent mode

Install Genero Report Engine silently on Gnu/Linux® and UNIX™ platforms.

To start the installation, type the following:

```bash
./fjs-gre-version-buildYYYYMMDDhhmm-osident.run -a -q -t install_dir
```

For example:

```bash
./fjs-gre-3.20.09-build202006051148-h64i112.run -a -q -t $PWD/fjs-gre-3.20.09
```

**Options**

Table 20: UNIX install options on page 44 shows the most common options relating to installation.

### Table 20: UNIX™ install options

<table>
<thead>
<tr>
<th>Install option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a or --accept</td>
<td>Bypass the display and the prompt for acceptance of the license agreement. Using the -a option indicates that you have read and accepted the End User License Agreement contained in the .txt files (in the license directory of the install directory).</td>
</tr>
<tr>
<td>-h or --help</td>
<td>Display help about all possible options.</td>
</tr>
</tbody>
</table>
Install GRE on Windows®

Follow these steps to install the Genero Report Engine on Windows®.

**Important:** If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.

1. Execute the installation package to start the Setup Wizard.
   
   ```
   fjs-gre-version-build-osident.exe
   ```
   
   Example:
   
   ```
   fjs-gre-3.20.05-build127148-w32v100.exe
   ```

2. Follow the instructions provided online.
   
   The installation completes and the install wizard closes.

When installation is complete, see Report Writer in the Genero Studio User Guide for configuration information and instructions.

Install GRE on Windows® in silent mode

Install Genero Report Engine on Windows® platforms using the MSI installer.

**Important:** Before you install the GRE, you must install the Java Runtime Engine (JRE).

The `msiexec` utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The `/qn` option allows you to install in silent mode. The `msiexec` utility expects an `.msi` file. To be compliant with Microsoft® User Access Control (UAC) requirements, the `.msi` file is embedded inside an `.exe` file. To extract the `.msi` file from the `.exe` file, use the `/x` option:

```
c:\fjs-gre-version-build-osident.exe /x
```

For example:

```
c:\fjs-gre-3.20.06-build166789-w32v141.exe /x
```

A `.msi` file is created in the same directory and with the same name as the `.exe` file.

**Options**

Table 21: msiexec install and uninstall options on page 46 shows the most common options for `msiexec` relating to installation and un-installation.
Table 21: msiexec install and uninstall options

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/qn</td>
<td>Silent mode with no UI. If /qn is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td>/i package-name.msi</td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td>/x package-name.msi</td>
<td>Uninstall the specified msi package.</td>
</tr>
<tr>
<td>/log logfile</td>
<td>Write processing info to the specified log file.</td>
</tr>
<tr>
<td>/l*vx logfile</td>
<td>Provide verbose (detailed) logs in the specified log file.</td>
</tr>
</tbody>
</table>

Enter msiexec from the command prompt to view the complete list of available options.

Arguments

You can pass arguments to the msiexec installer on the command line.

Table 22: Arguments for the msiexec installer

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_gredir_path</td>
<td>The path where GRE will be installed. It is an alias of GREDIR variable.</td>
</tr>
<tr>
<td>GREDIR=your_gredir_path</td>
<td>The path where GRE will be installed. It is an alias of the PRODUCTDIR variable.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example, &quot;fjs\gre&quot;.</td>
</tr>
<tr>
<td>ADDLOCAL=[ALL</td>
<td>GRE]</td>
</tr>
<tr>
<td></td>
<td>• ALL (default): Install GRE (mandatory) and .gre file association</td>
</tr>
<tr>
<td></td>
<td>• GRE: Install GRE only</td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, force the removal of the PRODUCTDIR directory, even if it is not empty. For any value other than YES, keep the files in the PRODUCTDIR location. Default value: &quot;&quot;.</td>
</tr>
</tbody>
</table>

Note: Quotes are only required around the argument value when a space character is in the value string.

Example

The following commands install the JRE and the GRE silently:

```bash
msiexec /qn /i fjs-gre-3.20.05-build156498-alpha-w64v140.msi /l*vx gre.log GREDIR=D:\gre3.20 STARTMENUFOLDER="Four Js Genero Report Engine 3.20.05 (64 bits)"
```

Install GRE on macOS™

Follow these steps to install the Genero Report Engine on macOS™.

Before you begin

You need a macOS™ and an user account which has administrator access level.
Download the installation package for the macOS™.
You must have Java installed. You will be asked to provide the Java directory as part of the installation.
If you plan to license the GRE during the installation process, ensure you have the license number, license key, and maintenance number available.

**About this task**

Follow these instructions to install the Genero Report Engine on macOS.

1. Determine the directory where you will install the product.
   The wizard will eventually suggest `/opt/fourjs/gre`. If you plan to use this default, ensure you have write permission to this directory.
2. Log in as a user with permission to write to the directory in which you plan to install this product.
3. Copy the self-extractable file into a temporary directory.
4. From a command prompt, run the self-extractable shell script with the `-i` option:
   ```bash
   sh fjs-gre-3.xx.xx-buildxxxxxx-m64x1011.run -i
   ```
   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!
5. Follow the instructions displayed.
   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.
   At some point in the instructions, you will be asked whether you wish to provide the licensing details for the Genero Report Engine. If you skip this step during the installation, you can always go back later to provide the licensing details.

**What to do next**

When installation is complete, see the *Genero Studio User Guide* for configuration information and instructions.

## Install Genero Report Designer

These topics relate to the installation of the Genero Report Designer.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

These instructions are for the installation of the standalone Genero Report Designer.

Genero Report Designer is also included as part of Genero Studio. If you have installed Genero Studio, you do not need to install the standalone Genero Report Designer.

**System requirements**

For details about system requirements, refer to the *Supported platforms and databases* document (available on the Download page of the *Four Js Web site*) or contact your support center.

**Related concepts**

Installation troubleshooting tips on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Install GRD on UNIX® platforms**

Follow these steps to install Genero Report Designer on Gnu/Linux® and UNIX®.

1. Type the following command to start the installation:

   ```
   $ sh fjs-grd-version-build-osident.run
   
   Example:
   $ sh fjs-grd-3.20.22-build149130-164x1212.run
   ```

2. Follow the instructions provided on the screen.

   When installation is complete, see the *Genero Report Designer User Guide* for configuration information and instructions.

**Install Genero Report Designer on UNIX™ platforms in silent mode**

Install Genero Report Designer silently on Gnu/Linux® and UNIX™ platforms.

To start the installation, type the following:

```
./fjs-grd-version-buildYYYYMMDDhhmm-osident.run -a -q --no-desktop -t install_dir
```

For example:

```
./fjs-grd-3.20.06-build202006051012-164x1217.run -a -q --no-desktop -t $PWD/fjs-grd-3.20.06
```

**Options**

Table 23: UNIX install options on page 48 shows the most common options relating to installation.

**Table 23: UNIX™ install options**

<table>
<thead>
<tr>
<th>Install option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a or --accept</td>
<td>Bypass the display and the prompt for acceptance of the license agreement. Using the -a option indicates that you have read and accepted the End User License Agreement contained in the .txt files (in the license directory of the install directory).</td>
</tr>
<tr>
<td>-h or --help</td>
<td>Display help about all possible options.</td>
</tr>
<tr>
<td>-q or --quiet</td>
<td>Silent mode with no UI. If -q is not specified, the interactive installer is used.</td>
</tr>
<tr>
<td>-f backup</td>
<td>overwrite</td>
</tr>
<tr>
<td></td>
<td>• backup: Back up the installation directory.</td>
</tr>
<tr>
<td></td>
<td>• overwrite: Overwrite installation file.</td>
</tr>
<tr>
<td></td>
<td>• remove: Delete installation directory before installing.</td>
</tr>
</tbody>
</table>
Install Genero Report Designer

Install option | Description
--- | ---
-t install_dir or --target install_dir | Install the product in the specified target directory. If -t is not specified, the default installation is used.
--no-desktop | Desktop bindings are not installed, which means:
• Desktop and system menu icons are not created.
• File types are not automatically associated with the product.

Install GRD on Windows®

Follow these steps to install Genero Report Designer on Windows®.

1. Execute the package name to start the Setup Wizard.
   
   fjs-grd-version-build-osident.exe
   
   Example:
   
   fjs-grd-3.20.22-build149130-w64v120.exe

2. Complete the instructions provided online.
   
   The installation completes and the install wizard closes.

   When installation is complete, see the Genero Report Designer User Guide for configuration information and instructions.

Install GRD on Windows® in silent mode

Install Genero Report Designer on Windows® platforms using the MSI installer.

The msiexec utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The /qn option allows you to install in silent mode. The msiexec utility expects an msi file. To be compliant with Microsoft® User Access Control (UAC) requirements, the msi file is embedded inside an exe file.

To extract the msi file from the exe file, use the /x option:

```
c:\fjs-grd-version-build-osident.exe /x
```

For example:

```
c:\fjs-grd-3.20.05-build168744-w64v140.exe /x
```

A msi file is created in the same directory and with the same name as the exe file.

Options

Table 24: msiexec install and uninstall options on page 49 shows the most common options for msiexec relating to installation and un-installation.

Table 24: msiexec install and uninstall options

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/qn</td>
<td>Silent mode with no UI. If /qn is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td>/i package-name.msi</td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td>/x package-name.msi</td>
<td>Uninstall the specified msi package.</td>
</tr>
</tbody>
</table>
Install Genero Browser Client

These topics relate to the installation of the Genero Browser Client (GBC).

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

The Genero Browser Client (GBC) is released on a different schedule than the other components of the Genero Enterprise suite. A runtime version is included with the Genero Business Development Language installation; however, you will likely want to update the GBC to the latest version.

The GBC package does not install like other Genero products. You do not launch an installation script and click through a wizard to install the Genero Browser Client. Instead, you download the latest GBC runtime package and deploy it to a Genero Application Server.

For more information on the differences between the GBC Runtime package and GBC Project package, see the Genero Browser Client User Guide.
System requirements

For details about system requirements, refer to the Supported platforms and databases document (available on the Download page of the Four Js Web site) or contact your support center.

Deployment App

For more information on setting up and using the Deployment App or the gasadmin command to manage your GBC packages, see the Genero Application Server User Guide.

Install Four Js License Manager

To centralize licensing, install the Four Js License Manager. Four Js License Manager is a separate product, to be installed in a dedicated directory with its own configuration file.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

System requirements

For details about system requirements, refer to the Supported platforms and databases document (available on the Download page of the Four Js Web site) or contact your support center.

Upgrade the FLM without re-applying licenses

When you upgrade the Four Js license manager, you do not need to reinstall your existing licenses.

1. Make a backup copy of your FLM configuration file, FLMDIR/etc/lmprofile
2. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type flmprg -s
      The FLM service is stopped.
3. Install the new FLM package in the same directory as the existing installation.
   Take the option to overwrite the existing files.
4. Replace the configuration file at FLMDIR/etc/lmprofile with the backup copy created in Step 1.
   Overwrite the existing file.
5. Remove every file and directory in the FLMDIR/lock/ path.
6. Start your new FLM

   flmprg -r

It is also recommended to upgrade the license controllers for your Genero Business Development Language (fglWrt) or Genero Report Writer (greWrt) installations at this time. See Patching a license controller on page 52.
Patching a license controller

If you need to update the license controller in order to make an older version of Dynamic Virtual Machine (DVM) compliant with the License Manager, follow the procedure described.

To update the license controller to the latest version, you download the version for your product that is appropriate for your operating system from the Four Js web site.

Table 26: Genero Products and License Controllers

<table>
<thead>
<tr>
<th>Genero product</th>
<th>License controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero Enterprise</td>
<td>Four Js License Controller for BDL (fglwrt)</td>
</tr>
<tr>
<td>Genero Report Engine</td>
<td>Four Js License Controller for GRE (greWrt)</td>
</tr>
</tbody>
</table>

1. Open your browser and navigate to the Four Js web site http://www.4js.com.
2. Navigate to the Download > Products page.
3. Under the License manager packages heading, locate the version of the license controller that is appropriate for your operating system under the Platform heading, and click on the link under Version to start the download.
4. When the download completes, uncompress the archive in your FGL installation directory.

The license controller is now updated.

If a license controller version is not available for your operating system and/or for assistance with a downloaded version, contact your Four Js support center for help.

Identify DVM version

If you need to check if your Dynamic Virtual Machine (DVM) versions is compatible with the Four Js License Manager, run one of the commands described here.

To display the version number of a DVM, execute one of the following commands:

- `fpi`
- For older DVM versions, execute the command:
  ```
  fglrun -V
  ```
- Or
  ```
  fglnodb -V
  ```

Four Js License Manager packages

The Four Js License Manager (FLM) software is a self-extractable installation program.

On UNIX™, the installation program is a shell script. On Windows®, the installation file is an executable (.exe) file.

A Four Js or Genero software package follows a specific naming convention:

`fjs-product-version-build-osident.extension`

where:
product is the product identifier ("flm" for Four Js License Manager).

• version is the software release number.
• build is the software build number.
• osident is the operating system identifier.
• extension is the file extension: sh or run on UNIX™ platforms, exe on Windows® platforms, and dmg or run on macOS™ platforms.

Launching the installation

Four Js License Manager can be installed on Windows®, UNIX™, or macOS™ platforms.

Warning: Be sure you are installing the correct binary files for your operating system. To do so, examine the installation package name, which includes the operating system brand name. For more information on the installation package name, refer to Four Js License Manager packages.

Install Four Js License Manager on UNIX™ platforms

To display the installation options, run the installation command with the help (-h) option:

```
sh fjs-flm-5.10.3a-build333-1nx1c23.run -h
```

1. Choose a directory where Four Js License Manager will be installed, such as /opt/fourjs/flm.
2. Log in as a user with permission to write to the chosen directory.
3. Copy the self-extractable file into a temporary directory.
4. Run the self-extractable shell script with the -i option:

```
sh fjs-flm-5.10.3a-build333-1nx1c23.run -i
```

5. Follow the instructions displayed on your screen.

When installation is complete, see License Manager configuration on page 114 for configuration information and instructions.

Related concepts

Installation troubleshooting tips on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install Four Js License Manager on UNIX™ platforms in silent mode

Install Four Js License Manager silently on Gnu/Linux® and UNIX™ platforms.

To start the installation, type the following:

```
./fjs-flm-version-buildYYYYMMDDhhmm-osident.run -a -q -t install_dir
```

For example:

```
./fjs-flm-5.20.17-build202005061204-164x125.run -a -q -t $PWD/fjs-flm-5.20.17
```

Options

Table 27: UNIX install options on page 54 shows the most common options relating to installation.
Install Four Js License Manager on Windows® platforms

1. Choose a directory where Four Js License Manager will be installed, such as c:\fjs\flm.
2. Log in as a user with permission to write to the chosen directory.
3. Copy the self-extractable file into a temporary directory.

```
fjs-product-version-build-osident.exe
```

Example:

```
fjs-flm-5.19.16-build201708251459-w64v140.exe
```

4. Double-click the file to launch it, or right-click on the file name and select Run as administrator.
5. Follow the instructions displayed by the installation wizard.

As part of the wizard, you are asked whether to install as a service. If you elect to install as a service, it is installed and set to Manual start. To have the service restart automatically on reboot, you must edit the Startup Type and change to Automatic or Automatic Delayed.

When installation is complete, see License Manager configuration on page 114 for configuration information and instructions.

**Related concepts**

Installation troubleshooting tips on page 11

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Install Four Js License Manager on Windows® in silent mode**

Install Four Js License Manager on Windows® platforms using the MSI installer.

The msiexec utility provides the means to install, modify, and perform operations on Windows® Installer from the command line. The /qn option allows you to install in silent mode. The msiexec utility expects an msi file. To be
compliant with Microsoft® User Access Control (UAC) requirements, the .msi file is embedded inside an .exe file. To extract the .msi file from the .exe file, use the /x option:

```
fjs-product-version-build-osident.exe /x
```

For example:

```
fjs-flm-5.20.17-build202005061204-w64v141.exe /x
```

A .msi file is created in the same directory and with the same name as the .exe file.

**Options**

Table 28: `msiexec` install and uninstall options on page 55 shows the most common options for `msiexec` relating to installation and un-installation.

**Table 28: msiexec install and uninstall options**

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/qn</td>
<td>Silent mode with no UI. If /qn is not specified, the graphical installer is used.</td>
</tr>
<tr>
<td>/i package-name.msi</td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td>/x package-name.msi</td>
<td>Uninstall the specified msi package.</td>
</tr>
<tr>
<td>/log logfile</td>
<td>Write processing info to the specified log file.</td>
</tr>
<tr>
<td>/l*vx logfile</td>
<td>Provide verbose (detailed) logs in the specified log file</td>
</tr>
</tbody>
</table>

Enter `msiexec` from the command prompt to view the complete list of available options.

**Arguments**

You can pass arguments to the `msiexec` installer on the command line.

**Table 29: Arguments for the msiexec installer**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_fldmdir_path</td>
<td>The path where FLM will be installed. It is an alias of FLMDIR variable.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example, &quot;fjs\flm&quot;.</td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, force the removal of the PRODUCTDIR directory, even if it is not empty. For any value other than YES, keep the files in the PRODUCTDIR location. Default value: &quot;&quot;.</td>
</tr>
<tr>
<td>FORCEINNONEMPTY=YES</td>
<td>Force the installation of a folder, even if it is not empty. For any value other than YES, do not allow installation into a non-empty folder. Default value: &quot;&quot;.</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SERVICECONFIG=[NotToInstall</td>
<td>Specify whether the service is installed.</td>
</tr>
<tr>
<td>ServiceInstall</td>
<td>ServiceStart]</td>
</tr>
<tr>
<td></td>
<td>• ServiceInstall: Install the service.</td>
</tr>
<tr>
<td></td>
<td>• ServiceStart: Install the service and start it.</td>
</tr>
</tbody>
</table>

**Note:** Quotes are only required around the argument value when a space character is in the value string.

**Installing the service (Windows® only)**

The installation wizard gives you the option of installing the Four Js License Manager as a service.

If you elected NOT to install as a service during the initial installation, you can execute the following command (from the License Manager Workplace Window) to install it as a service:

```plaintext
flmprg --service-install
```

If you attempt to start the service from the command line and the service is not yet installed, it will first install the service, and then start the service.

```plaintext
flmprg --service-start
```

**Install FLM on macOS™**

**Before you begin**

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.

**About this task**

Follow these instructions to install the Four Js License Manager (FLM) on macOS.

1. Determine the directory where you will install the product.
   
   The wizard will eventually suggest /opt/fourjs/flm. If you plan to use this default, ensure you have write permission to this directory.

2. Log in as a user with permission to write to the directory in which you plan to install this product.

3. Copy the self-extractable file into a temporary directory.

4. From a command prompt, run the self-extractable shell script with the -i option:

   ```plaintext
   sh fjs-flm-5.20.xx-buildxxxxxx-m64x10xx.run -i
   ```

   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!

5. Follow the instructions displayed.

   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.

When installation is complete, see License Manager configuration on page 114 for configuration information and instructions.

**Related concepts**

Installation troubleshooting tips on page 11
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Related tasks**

Configure license with FLM for docker on macOS host on page 135

If you are working with Genero products installed in Docker instance on a macOS™ system that also hosts the Four Js License Manager (FLM) server, there is a specific configuration to provide licensing for docker instances if the network changes.

### Setting the environment

Before starting the Four Js License Manager, the FLMDIR and PATH environment variables must be set.

A script for setting the environment is created during the installation phase. Located in the Four Js License Manager installation directory (FLMDIR), this file is named envflm on UNIX™ platforms and envflm.bat on Windows® platforms. By running this script file, the following actions are performed:

**on UNIX™ (using sh as shell script):**

```bash
FLMDIR=/opt/fourjs/flm
export FLMDIR
PATH=$PATH:$FLMDIR/bin
export PATH
```

**on Windows®:**

```bash
set FLMDIR=c:\fjs\flm
set PATH=%PATH%;%FLMDIR%\bin
```

### Starting Four Js License Manager

To start the License Manager service, execute the following command:

```
flmprg -r
```

On Linux®/UNIX™, the License Manager runs as a daemon. On Windows®, it runs as a service.

**Important:** On Linux®/UNIX™ systems, for security reasons, it is strongly recommended that the daemon be run as a non-privileged user (not root). To avoid issues with directory permissions, it is recommended that the non-privileged user should also add the licenses.

You can also use the following command on Windows™:

```
flmprg --service-start
```

**Important:** You must run the command as administrator, it is not enough to simply have administrator permissions.

### Stopping license manager

To stop the License Manager service, execute the following command:

```
flmprg -s
```

Alternatively, on Windows®, you can also issue the following command:

```
flmprg --service-stop
```
Important: You must run the command as administrator, it is not enough to simply have administrator permissions.

License Genero Business Development Language

These topics give you the information you need to install and manage the license of your Genero Business Development Language product.

Steps to BDL license installation

Preparing to license involves evaluating your options based on what licensing tool (GUI or command line) is available to you, and whether you can validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

Before you begin Genero product licensing:

1. Locate your email message that contains the following:
   - product license key
   - product license number
   - product maintenance key
   - your customer code

   If you do not have this email, contact your local Four Js sales office.

2. Decide which tool (GUI or command line) you are using to install the license:
   - Genero BDL Licenser (GUI application)
   - fglWrt (command line tool).

3. Determine if you have internet access from the machine you are licensing the product.

4. Use Table 30: Options for licensing on page 58 to choose your licensing option, and select the procedure to follow.

Table 30: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero BDL Licenser with internet</td>
<td>See Install BDL license with user interface (internet) on page 58</td>
</tr>
<tr>
<td>Genero BDL Licenser without internet.</td>
<td>See Install BDL license with user interface (no internet) on page 60.</td>
</tr>
<tr>
<td>fglWrt command line tool with internet.</td>
<td>See Install BDL license from the command line (via internet) on page 62.</td>
</tr>
<tr>
<td>fglWrt command line tool without internet.</td>
<td>See Install BDL license from the command line (no internet) on page 63.</td>
</tr>
</tbody>
</table>

Install BDL license with user interface (internet)

You can license a Genero Business Development Language (BDL) product using the Genero licensing user interface.

Before you begin: You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero BDL Licenser tool from your Four Js program list
The licensing page opens in your Web browser.

**Figure 1: Genero BDL Licensing Page**

2. Enter your license number and license key, and click **INSTALL**.

Register the license

3. Select the **REGISTER LICENSE USING FOUR JS ACTIVATION SERVER** option.
Figure 2: Example registering the license

4. In the CUSTOMER CODE field, enter your customer code.

5. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

6. Click INSTALL KEYS

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

7. When finished, click QUIT to log out and close the licensing application.

Install BDL license with user interface (no internet)

Without internet access, you register the license with Four Js from another machine via the internet, or by phone. Then use the user interface to license your Genero Business Development Language (BDL) product.

1. Launch the Genero licensing user interface.
• From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
• From the desktop select the Genero BDL Licenser tool from your Four Js program list

The licensing page opens in your Web browser.

![Genero Business Development Language - Licensing version: 5 20 04-201809271621 (w64v140)](image)

License information

<table>
<thead>
<tr>
<th>License Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>License Key</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Installation Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No installed license found.</td>
</tr>
</tbody>
</table>

[INSTALL] [UNINSTALL] [QUIT]

Licensing Activation

<table>
<thead>
<tr>
<th>Register License using Four Js Activation Server</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Installation Key</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

[INSTALL KEY]

<table>
<thead>
<tr>
<th>Maintenance/Subscription Key</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

[UPDATE KEY]

**Figure 3: Genero BDL Licensing Page**

2. Enter your license number and license key, and click INSTALL.

   An installation number is generated.

**Register the license**

3. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 78

   Having registered your license, you have the installation key.

4. Enter your installation key, and click INSTALL KEY.
5. Enter your maintenance key, and click **UPDATE KEY**.

   Your product is now fully licensed. In the **DESCRIPTION** field you see your maintenance key is valid until the date displayed after **End of maintenance date**.

6. When finished, click **QUIT** to close the licensing application.

### Install BDL license from the command line (via internet)

You can license a Genero Business Development Language (BDL) product using the command line tool, fglWrt.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

**Important:** If your installation directory is in the `C:\Program Files` path, you must run as administrator when you license the product. This avoids any permission issues.
1. At the command line enter the command:

   fglWrt -l

2. When prompted, enter the license number.
3. When prompted, enter the license key.
4. At the prompt:

   Do you want to continue using HTTP ? (y/n)

   Enter: y

5. When prompted, enter your customer code:

   Enter your customer code >

6. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

   Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

   ![Image of Command Prompt]

   **Figure 5: Installing and registering a license via HTTP with fglWrt**

   License installation is now completed.

**Install BDL license from the command line (no internet)**

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then license your Genero Business Development Language (BDL) product using the command line tool, fglWrt.

**Important:** If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.

1. At the command line enter the command:

   fglWrt -l

2. When prompted, enter the license number.
3. When prompted, enter the license key.

   An installation number is generated and is displayed in the output.
4. At the prompt:

```plaintext
Do you want to continue using HTTP? (y/n)
```

Enter: n

5. At the prompt:

```plaintext
Enter your maintenance KEY (Empty to continue) >
```

Enter the maintenance key.

**Register the license**

6. To register the license go to the License your products page on the [Four Js website](https://fourjs.com). See the procedure described in [Register license on Four Js website](https://fourjs.com) on page 78.

Having registered your license, you have the installation key.

7. At the prompt:

```plaintext
Enter the installation KEY (call your vendor to obtain it) >
```

Enter: `installation_key`

![Figure 6: Installing license with fglWrt](image)

License installation is now completed.

**Manage Genero BDL local license**

Refer to the topics in this section to quickly become familiar with how to perform license management tasks.

You can install and manage licenses locally using the license controller (`fglWrt`) installed with the product. Alternatively, you can use the License Manager, see the topic [Using a license manager](https://fourjs.com).

**Notes About Upgrading**

When upgrading a Genero product, the product is installed over the existing directory having a valid license. You do not have to re-enter the license keys.

When you purchase a new maintenance contract, the new maintenance key must be installed. To install your new maintenance key, you do not need to reinstall your license. Updating the maintenance key is handled separately.
There is also no need to uninstall the old maintenance key. See Steps to apply maintenance or subscription key (BDL) on page 86.

**License Controller (fglWrt)**

The fglWrt command line tool is used to install, upgrade, or delete Genero BDL licenses. There are also options to provide various types of license information and statistics.

**Syntax**

```
fglWrt [options]
```

1. *options* are described in Table 31: fglWrt options on page 65.

**fglWrt Options**

**Table 31: fglWrt options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-v or -V</td>
<td>Displays version information.</td>
</tr>
<tr>
<td>-h</td>
<td>Displays options for the tool.</td>
</tr>
<tr>
<td>-l license</td>
<td>Installs a license.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To escape when prompted to enter a license number and license key, type &quot;stop&quot; at the prompt.</td>
</tr>
<tr>
<td>-m option</td>
<td>Maintenance key installation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>• key: Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>• auto: The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td>-u</td>
<td>Check for active users.</td>
</tr>
<tr>
<td>-k option</td>
<td>Installation key for license validation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>• key: Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>• auto: The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td>-d</td>
<td>Remove current installed license.</td>
</tr>
<tr>
<td>-i</td>
<td>Clears the list of registered user sessions.</td>
</tr>
<tr>
<td>-a option</td>
<td>Check or view options.</td>
</tr>
<tr>
<td></td>
<td>Here <em>option</em> can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• ps: Shows processes on this machine.</td>
</tr>
<tr>
<td></td>
<td>• env: Shows current environment</td>
</tr>
<tr>
<td></td>
<td>• cpu: Shows number of CPU in the computer.</td>
</tr>
<tr>
<td></td>
<td>• hostname: Shows name of this machine.</td>
</tr>
<tr>
<td></td>
<td>• info license: Shows license information.</td>
</tr>
<tr>
<td></td>
<td>• info stat: Shows statistics of license server.</td>
</tr>
<tr>
<td></td>
<td>• info users: Shows all registered active users.</td>
</tr>
<tr>
<td></td>
<td>• info up: Shows if license server is up.</td>
</tr>
<tr>
<td>-x or -kill-session pid</td>
<td>Clears the session referenced by the specified pid.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>--batch action=command</td>
<td>Performs the specified action in batch mode. Here <code>command</code> can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <code>target-info</code> (Get operating system information)</td>
</tr>
<tr>
<td></td>
<td>• <code>lm-info</code> (Get license manager information)</td>
</tr>
<tr>
<td></td>
<td>• <code>product-info</code> (Get license controller information)</td>
</tr>
<tr>
<td></td>
<td>• <code>license-info</code> (Get license information)</td>
</tr>
<tr>
<td></td>
<td>• <code>install-license``lnum=license_num``lkey=license_key</code></td>
</tr>
<tr>
<td></td>
<td>• <code>uninstall-license</code></td>
</tr>
<tr>
<td></td>
<td>• <code>install-mkey``mkey=maintenance_key</code></td>
</tr>
<tr>
<td></td>
<td>• <code>install-mkey``http``login=username``proxy=http://myproxy``proxy-port=port-number``proxy-user=proxy-user``proxy-passwd=proxy-password</code></td>
</tr>
<tr>
<td></td>
<td>• <code>install-ikey``ikey=installation_key</code></td>
</tr>
<tr>
<td></td>
<td>• <code>install-ikey``http``user=username``proxy=http://myproxy``proxy-user=proxy-user``proxy-passwd=proxy-password</code></td>
</tr>
<tr>
<td></td>
<td>The caret character (^) is used for parsing. In Windows® the caret is also used to escape special characters. To escape it, you may need to double (^) it up.</td>
</tr>
<tr>
<td></td>
<td>fglWrt --batch action=install-mkey``mkey=maintenance_key`</td>
</tr>
<tr>
<td>--batch-console action=command</td>
<td>Opens fglWrt in console mode for the batch commands.</td>
</tr>
<tr>
<td></td>
<td>C:\fgl&gt;fglwrt --batch-console</td>
</tr>
<tr>
<td></td>
<td>$ action=product-info</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;product&quot;: &quot;fglWrt&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;version&quot;: &quot;5.20.13&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;wrtminver&quot;: &quot;5.20.05&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;build&quot;: &quot;201911141141&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;target&quot;: &quot;w64v141&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;status&quot;: 0,</td>
</tr>
<tr>
<td></td>
<td>&quot;status-msg&quot;: &quot;Success.&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>$</td>
</tr>
<tr>
<td>docker-assign</td>
<td>Assigns the license to a running docker instance.</td>
</tr>
<tr>
<td>docker-instance-name</td>
<td>Docker instance name to assign the license to.</td>
</tr>
<tr>
<td>docker-instance-id</td>
<td>Docker instance ID for the license assignment.</td>
</tr>
<tr>
<td>docker-release</td>
<td>Release a docker-assigned license.</td>
</tr>
</tbody>
</table>
Displaying environment and statistics

When the Four Js License Manager is used for licensing, it works with the license controller locally to access information. The topics in this section describe license controller options that apply to the use of the FLM.

Display environment information

Use this procedure to display information about the environment of your machine where the license is installed.

Settings are extracted from the FGL configuration file (for example, $FGLDIR/etc/fglprofile) and some from system environment settings.

To display information about the environment, execute the command:

```bash
fglwrt -a env
```

The output shows details under the Resource, Environment and System headings.

Note:

- If you have a local license installed and therefore not using a Four Js License Manager (FLM) server, the server field will be displayed as (undefined).
- If you have a local license installed, your license number and key will not be displayed. License numbers that may be displayed are from the fglprofile, if any had been filled in there.

![Figure 7: Display the environment settings where license is installed.](image)

Check Four Js License Manager (FLM) is started

Follow this procedure to check if the FLM is started.

To check if the FLM is started, execute the command:

```bash
fglwrt -a info up
```

This example shows the display when the license manager is currently not running because configuration details are missing in fglprofile.
Display Statistics
Use this procedure to display statistical information on the use of a specific license on a machine when a License Manager is used for license control.

If you need detailed information about how licenses are used, or you need to troubleshoot your FLM, viewing information about a license in terms of the number of runtime, compilation, end-runtime, and process Id requests rejected or accepted can prove useful.

To display statistical information, execute the command

```
fglWrt -a info stat
```

Display CPUs (cores) information
Use this procedure on the application server where the Genero runtime is installed, to determine the exact number of CPUs (cores/threads) for CPU licensing.

To display the number of logical CPUs in your machine type the command:

```
fglWrt -a cpu
```

The number of CPUs (cores/threads) you have are displayed. An example of a machine which has one physical CPU with four cores is shown.
GDC/GDCA/GJC

**Note:** Genero Desktop Client ActiveX (GDCA) and Genero Java Client (GJC) are desupported.

The following Client Information (clientInfo) is sent:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cx-mode</td>
<td>The connection type. The value can be &quot;gas&quot; or &quot;direct&quot;</td>
</tr>
<tr>
<td>user-name</td>
<td>Is the local user name. The user that runs the Front End.</td>
</tr>
<tr>
<td>host-addr</td>
<td>Is the user computer IP address; this is the local IP address even if the connection goes through a router or a proxy.</td>
</tr>
<tr>
<td>hw-addr</td>
<td>Is the user computer mac address</td>
</tr>
<tr>
<td>host-name</td>
<td>Is the user computer name</td>
</tr>
</tbody>
</table>

Examples:

- With direct connection to the DVM

  ```
  cx-mode       : direct  
  user-name     : Administrator  
  host-addr     : 10.0.0.65  
  hw-addr       : 00-0C-29-8D-EE-F0  
  host-name     : server-2  
  ```

- With connection to GAS or through a web server

  ```
  cx-mode       : gas  
  user-name     : Administrator  
  host-addr     : 10.0.0.65  
  hw-addr       : 00-0C-29-8D-EE-F0  
  host-name     : server-2  
  ```
Genero Browser Client (GBC)

Note: Genero Web Client (GWC) applies to the Genero web client prior to version 3.00. From version 3.10, the GWC is discontinued and replaced by Genero Browser Client (GBC).

The following information (clientInfo) is sent by a Genero web client:

<table>
<thead>
<tr>
<th>app-name</th>
<th>appName</th>
</tr>
</thead>
<tbody>
<tr>
<td>app-id</td>
<td>appId</td>
</tr>
<tr>
<td>user-agent</td>
<td>ua</td>
</tr>
<tr>
<td>host-addr</td>
<td>ip</td>
</tr>
<tr>
<td>host-name</td>
<td>hname</td>
</tr>
</tbody>
</table>

where:

**appName**
Is the application identifier that is in the URL /wa/r/appName.

**appId**
Is the application session number that is in the URL /sua/appId/

**ua**
is the user agent name.

**ip**
Is the user computer IP address

**hname**
Is the user computer name

Note: Depending on the proxy configuration or the web server configuration, **host-name** and **host-addr** can be the proxy or the web server information instead of the user information.

Example:

```
host-addr : 10.0.0.65
host-name : 10.0.0.65
user-agent : Mozilla/5.0 (Windows; U; Windows NT 5.1; en-US; rv:1.8.1.2)
           Gecko/20070219 Firefox/2.0.0.2
app-name  : gwc-demo
app-id    : 131551616
```

See Display registered active users information on page 75 for more information.

Get license information

Get details of the status of the license of your Genero product, for example, the maintenance contract expiry date, or the installation number for license registration.

License details reference

A reference to license details.

The output from the license controller command, for example, `fglWrt -a info license`) and/or the Genero Licenser application screen displays details about the installed license. Use Table 32: License details on page 70 as a reference to look up details of your license.

Note: For specific license details, see your license agreement, or contact your nearest Four Js sales office.

Table 32: License details

<table>
<thead>
<tr>
<th>Details displayed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server name</td>
<td>This is the name of the license manager server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Indicates that licensing is managed by a License Manager.</td>
</tr>
</tbody>
</table>
### Details displayed

<table>
<thead>
<tr>
<th>Details displayed</th>
<th>Description</th>
</tr>
</thead>
</table>
| TCP Port         | This is the port the license manager is listening.  
**Note:** Indicates that licensing is managed by a License Manager. |
| License          | This is the value of the license number. |
| License Key      | This is the value of the license key. |
| Product          | This refers to the name of the product under license, for example:  
• Four J's Universal Compiler (for Genero Enterprise and Genero Mobile products)  
• Four Js Genero Report Writer (for Genero Report Engine) |
| Type             | This refers to the type of license. This can be:  
• runtime  
• development |
| Users            | This number indicates the maximum number of users allowed to use the license. |
| Extension(s)     | This entry provides information on some specific conditions of the license. For example, "- Open Database Interface" means that your license allows you to use any database.  
The **installation number** is displayed if the license is a temporary license and the installation has not been finalized.  
If the license is **date-limited**, then the date when the license expires is shown. |
| End of maintenance date | This entry indicates the date your maintenance contract expires. |

### Related tasks

**Get license information** on page 71
Get details of the status of the license of your Genero product.

### Get license information
Get details of the status of the license of your Genero product.

### About this task:

Use this procedure, for example, to find out the date the maintenance contract expires.

**Tip:** You can also use the procedure described in this topic to retrieve the **installation number** when you need to register the license and finalize the installation.

From a command prompt, enter the command:

```
fglWrt -a info license
```
Example of Genero BDL license information:

<table>
<thead>
<tr>
<th>License</th>
<th>TAB#XXXXXXXX</th>
</tr>
</thead>
<tbody>
<tr>
<td>License key</td>
<td>KKKKKKKKKKKK</td>
</tr>
<tr>
<td>Product</td>
<td>Four Js Universal Compiler</td>
</tr>
<tr>
<td>Type</td>
<td>Development version</td>
</tr>
<tr>
<td>Users</td>
<td>5</td>
</tr>
</tbody>
</table>
| Extension(s)  | - Open Database Interface  
               - Enhanced license key format |

This license is date limited and expires the 2016/03/31 (Year/Month/Day).
Warning! This is a temporary license, installation number is 'NNNNNNNNNNNN'.
This temporary installation will expire in 29 day(s).
WARNING! Your maintenance key has expired. Please contact your vendor.
End of maintenance date: 2016/03/03 (Year/Month/Day).

The output from the license controller command displays details about the installed license.

**Related concepts**

- **License details reference** on page 70
  A reference to license details.

**Get license information using BDL licenser**

Get details of the status of the license of your Genero product.

1. Launch the Genero Licenser application.
   - From within the Genero Studio product interface, launch it from the **Tools > Genero Tools** menu.
   - From the desktop select the **Genero BDL Licenser** application tool from your Four Js program list:

   The **Four Js Licensing Application** opens.
License information is displayed in the **Licensing status** field. In the field under **Licensing status** you see your maintenance key is valid until the date displayed after **End of maintenance date**.

2. When finished, select **Quit** to exit the application.

**Related concepts**

- **License details reference** on page 70
A reference to license details.

**Uninstall license**

You may need to uninstall a license if you are making some hardware or software changes.

**Uninstall license with BDL Licenser**

Use this procedure to uninstall the license of your Genero BDL product.

**About this task:**

**Note:** This procedure is valid for a local license only. If you are using the Four Js License Manager, see **Manage licenses with FLM (flmprg)** on page 119.

1. Launch the Genero licensing user interface.
• From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
• From the desktop select the Genero BDL Licenser tool from your Four Js program list

The licensing page opens in your Web browser.

![License information](image)

**Figure 11: Genero BDL Licenser**

2. Click Uninstall to uninstall the license. The DESCRIPTION field is updated to show a license is not installed.
3. When finished, click QUIT to close the licensing application.

**Uninstall license from command line**

Use this procedure to uninstall a license for your Genero BDL product.

1. At the command line enter the command:

   ```
   fglWrt -d
   ```

2. Enter "y" when prompted if you really want to uninstall the license.
The license is uninstalled. A message confirms the license is uninstalled.

![Uninstalling a License with the License Controller (fglWrt)](image)

**Figure 12: Uninstalling a License with the License Controller (fglWrt)**

**The FGLDIR/lock directory**

When using a local license, the license controller uses the FGLDIR/lock directory to store information (number of active users). A user running a BDL program must have access rights to this directory. Permissions can be restricted to specific users with FGLWRTUMASK.

This FGLDIR/lock directory must have access rights for any user running a BDL program. If it does not exist, it is automatically created.

**Note:** The FGLDIR/lock directory is not used when Genero is configured to use a license manager.

By default, the FGLDIR/lock directory is created with rwxrwxrwx rights, to let any user access the directory and create files. To restrict the access to a specific group or user, use the FGLWRTUMASK environment variable to force fglWrt to use a specific mask when creating the lock directory:

```
$ FGLWRTUMASK="022"; export FGLWRTUMASK
```

**Important:** The FGLWRTUMASK environment variable must be set for all users executing BDL programs, because the FGLDIR/lock directory can be re-created by any user at first BDL program execution.

**License an upgraded installation**

There are some considerations for licensing when upgrading an existing Genero installation to a newer version.

**Notes about Upgrading**

It is not necessary to re-enter the license of the product if the new version:

- Is installed into an existing installation directory
- Is not a major version number change

When you have purchased a new maintenance contract, the new maintenance key must be installed. To install your new maintenance key, you do not need to reinstall your license. Updating the maintenance key is handled separately. There is also no need to uninstall the old maintenance key.

**Managing the active users**

The license controller maintains a register of active users of licenses. The topics in this section describe ways you can manage license users.

**Display registered active users information**

Use this procedure to display the registered active user list of the current license.

To display the registered active user list, execute the command:

```
fglWrt -a info users
```
The information displayed differs depending on the network architecture and the front-end client.

This example displays output when the connection is direct to the DVM via the Genero Desktop Client (GDC):

```
C:\Program Files\FourJs\Genero_Studio_3_00_22\fgl\bin>fglWrt.exe -a info
users
License      : THM#XXXXXXXX
License key  : KKKKKKKKKKK
Product      : Four Js Universal Compiler
Type         : Development version
Users        : 1/5
    FrontEndId2: {f3619311-3f9b-4a93-bba5-5d9b4ec6d84b}
    GUI Server 127.0.0.1:0 - Process Id 5144
        host-name: 4js1
        host-addr: ::ffff:127.0.0.1
        user-name: user1
        app-id: {f4afc501-f7c9-c9c6-e16f-2b881a8bf3f0}
        cx-mode: direct
```

This example displays output when the connection is through a Web server to the DVM:

```
C:\Program Files\FourJs\Genero_Studio_3_00_22\fgl\bin>fglWrt.exe -a info
users
License      : THM#XXXXXXXX
License key  : KKKKKKKKKKK
Product      : Four Js Universal Compiler
Type         : Development version
Users        : 1/5
    GUI Server 127.0.0.1:47274
        Process Id 5596
```

where:

- **License**

  This is the value of the license number.

- **License Key**

  This is the value of the license key.

- **Product**

  The name of the product being licensed is displayed. In relation to Genero product, this can be, for example:
  - Four J's Universal Compiler (for Genero Enterprise and Genero Mobile products)
  - Four Js Genero Report Writer (for Genero Report Engine)
  - Genero Report Writer for Java C# PHP (for Genero Report Writer products)

- **Type**

  This is the type of license. This can be runtime version or development version.

- **Users**

  This is the number of active users over the maximum number of users allowed.

- **FrontEndId2**

  For desktop clients, the Global Unique Identifier (GUID) of the front-end client is displayed. For the web and desktop clients, the GUI server's IP address and port, and the process identifier is displayed.

- **host-name**

  This is the name of the computer that runs the DVM.

- **host-addr**

  This is the server's IP address and port it is listening on.

- **user-name**

  This is the user name.
app-id

For desktop clients, the Global Unique Identifier (GUID) of the application is displayed.

Force a check of registered users list
After a system crash or an abnormal termination of an application, use this procedure to force a check of the registered users list on the current machine.

This license controller feature forces the synchronization of the real users list and the registered users list for the current machine.

To check the registered users list, execute the command:

```
fglWrt -u
```

Related tasks
Clean registered users list on page 77
Generally, you never need to clean the registered users list on a host, but if, for example, a DVM crashes and the associated unreleased licenses would not be recovered otherwise, use this procedure to clear the list.

Clean registered users list
Generally, you never need to clean the registered users list on a host, but if, for example, a DVM crashes and the associated unreleased licenses would not be recovered otherwise, use this procedure to clear the list.

Important: The `fglWrt -i` should be used with caution because it invalidates implicitly all existing sessions and eventually all running applications will stop with a license error. In other cases, the `-u` option to force a check of the registered users should be preferred to the `-i` option.

To clean the registered users list, execute the license controller command:

```
fglWrt -i
```

All users registered are disconnected when you use this option.

Figure 13: Clean the Registered Users with `fglWrt -i`

Related tasks
Force a check of registered users list on page 77
After a system crash or an abnormal termination of an application, use this procedure to force a check of the registered users list on the current machine.

Display the process Id List
Use this procedure to display the current list of processes on your machine.

To display processes, execute the command:

```
fglWrt -a ps
```

A list of process Ids are displayed as shown.
Figure 14: Display the ids of Processes Currently Running

Related tasks
Drop session on page 78
Use this procedure to drop a session referenced by a specified process id on a host.

Drop session
Use this procedure to drop a session referenced by a specified process id on a host.

This feature is available starting from version 5.19.01.

Important: This feature only applies to User- type licenses, not to CPU licenses.

To drop a session, execute the command:

```
fglwrt -x <pid>
```

Where `<pid>` is the process id.

Related tasks
Display the process Id List on page 77
Use this procedure to display the current list of processes on your machine.

Register license on Four Js website

Register your license with Four Js in order to validate it.

About this task:

Important:

If you can use the license controller `--m auto` option to install the license via the internet, (for example `fglwrt --m auto`), then you do not need to perform this task.

Before you begin:

- Get your installation number from the output of the following command:

```
<license_controller> -a info license
```

Where `<license_controller>` is `fglwrt` (for Genero Enterprise), or `greWrt` (for Genero Report Engine), depending on which product you are licensing.

Or if you are using Four Js License Manager, use the following command:

```
flmprg -a info license <license_number>
```

- You must also have the following:
  - Customer code
  - License number
• License key

Typically, these are delivered by email with your product. If you do not have them, contact your local sales office.

1. Open your browser and navigate to the Four Js web site:

2. Navigate to the Support > License your products page.

The Online registration form is displayed.

![Four Js Online Registration Page](image)

**Figure 15: Four Js Online Registration Page**

3. Complete the Online registration form making sure that everything is entered correctly and select **Submit**.

A new page is displayed showing information that your license has been registered and providing you with:

• Installation key  
• Maintenance key

At this point, you need to install the installation and maintenance keys.

**Related tasks**

Troubleshooting license registration on page 80
When registering your license on the Four Js website you get an error message. More than likely you need to request a new activation key.

**Troubleshooting license registration**

When registering your license on the Four Js website you get an error message. More than likely you need to request a new activation key.

When registering a license, an error message on the registration page states that you may need to request a new activation key. You may encounter this issue, for example, when you are upgrading your server and registering a license that has already been registered for another server.

There has been a problem during the submit process. Please check following comment:
The number of licensing request is over. Please send a New Activation Key Request Form to your license provider.

![Figure 16: Four Js license registration failure](https://fourjs.com/support/registration?#online_registration)

1. Navigate to the **Support > License forms** page.
2. Click on the **New Activation Key Request** link.
3. Download the form.
4. Fill out the form to complete the request for a new activation key and send it to Four Js.

For more information and support contact your local Four Js support center.

**Get maintenance key from Four Js website**

You get the maintenance key from the Four Js website to ensure you have a valid maintenance key to install or update your product's license.

**About this task:**
If you can use the license controller `m auto` option to install the maintenance key via the internet, (for example `fglwrt m auto`), then you do not need to perform this task.

**Before you begin:**

You must also have the following:

- Customer code
- License number

1. Open your browser and navigate to the Four Js web site.
2. Navigate to the **Support > License your products** page and scroll to the **Online maintenance** section.

![Four Js Online Maintenance form](image)

Figure 17: Four Js Online Maintenance form

3. Complete the form making sure that everything is entered correctly and select **Submit**.

   A new page is displayed providing you with the maintenance key.

At this point, you need to install the maintenance key.

**Steps to finalize temporary BDL license**

You finalize your product's license installation after registering the license with Four Js. To complete licensing, select the option (with or without internet) that is right for you and match it with the procedure to follow.

**Before you begin finalizing licensing:**

1. Decide which tool (GUI or command line) you are using to install the license:
   - **Genero BDL Licenser** (GUI application)
   - `fglwrt` (command line tool).
2. Determine if you have internet access from the machine you are licensing the product.
3. Use **Table 33: Options for licensing** on page 81 to choose your licensing option, and select the procedure to follow.

**Table 33: Options for licensing**

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Genero BDL Licenser</strong> with internet</td>
<td>See <strong>Finalize BDL license with user interface (via internet)</strong> on page 82.</td>
</tr>
<tr>
<td>You are using ...</td>
<td>Procedure to follow</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Genero BDL Licenser without internet.</td>
<td>See Finalize BDL license with user interface (no internet) on page 83.</td>
</tr>
<tr>
<td>fglWrt command line tool with internet.</td>
<td>See Finalize BDL license from the command line (via internet) on page 85.</td>
</tr>
<tr>
<td>fglWrt command line tool without internet.</td>
<td>See Finalize BDL license from the command line (no internet) on page 85.</td>
</tr>
</tbody>
</table>

**Finalize BDL license with user interface (via internet)**

You can complete licensing using the user interface. The license is registered with Four Js via the internet and the maintenance key is installed.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero BDL Licenser** tool from your Four Js program list

   The licensing page opens in your Web browser.

**Register the license**

2. Select the **REGISTER LICENSE USING FOUR JS ACTIVATION SERVER** option.
3. In the CUSTOMER CODE field, enter your customer code.

4. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

5. Click INSTALL KEYS

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to log out and close the licensing application.

**Finalize BDL license with user interface (no internet)**

Without internet access, you complete licensing using the user interface as described.

Register the license
1. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 78

Having registered your license, you have the installation key.

2. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero BDL Licenser tool from your Four Js program list

The licensing page opens in your Web browser.

3. Enter your installation key, and click INSTALL KEY.

![Genero Business Development Language - Licensing version: 5.20.04-201809271621 (w64v140)](image)

![License information](image)

![Licensing Activation](image)

**Figure 19: Manually install installation key and maintenance key**

4. Enter your maintenance key, and click UPDATE KEY.

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

5. When finished, click QUIT to close the licensing application.
Finalize BDL license from the command line (via internet)

Your license is registered with Four Js via the internet and the installation and maintenance keys are installed automatically using the command fglWrt -k auto.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

**Important:** If your installation directory is in the `C:\Program Files` path, you must run as administrator when you license the product. This avoids any permission issues.

1. At the command line enter the command:

   ```plaintext
   fglWrt -k auto
   ```

2. When prompted, enter your customer code:

   ```plaintext
   Enter your customer code >
   ```

3. At the following prompt:

   ```plaintext
   Do you need to configure an HTTP proxy ? (y/n)
   ```

   Enter y if your access to the internet is through a proxy. Provide the required information for **HTTP proxy, Port**, and authentication when prompted. Otherwise, enter n.

   The installation key and the maintenance key are installed automatically and the message is displayed.

   ```plaintext
   Installing maintenance key 'MMMMMMMMMMMM'
   License installation successful.
   ```

   License installation is now completed.

**Note:** There is no need to run `fglWrt -m auto` to install the maintenance key.

Finalize BDL license from the command line (no internet)

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then complete licensing of your BDL product using the command line tool, fglWrt, as described.

**Important:** If your installation directory is in the `C:\Program Files` path, you must run as administrator when you license the product. This avoids any permission issues.

**Register the license**

1. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 78

   Having registered your license, you have the installation key.

2. At the command line enter the command to install the installation key:

   ```plaintext
   fglWrt -k <installation-key>
   ```

   A message is displayed in the output to say the installation key was installed successfully.

3. At the command line enter the command to install the maintenance key:

   ```plaintext
   fglWrt -m <maintenance-key>
   ```

   A message is displayed in the output to say the license installation was successful.

   License installation is now completed.
Steps to apply maintenance or subscription key (BDL)

You apply a maintenance key (also known as a subscription key depending on your contract) when you are installing a license for a product and thereafter when you renew your maintenance contract.

An active maintenance or subscription contract is required to license a product. The maintenance key determines which version of the Genero product you are authorized to use with your license, and the date that the maintenance contract expires.

Before you begin applying a maintenance key:

1. Decide which tool (GUI or command line) you are using to install the key:
   - **Genero BDL Licenser** (GUI application)
   - `fglwrt` (command line tool).

2. Determine if you have internet access from the machine you are licensing the product.

3. Use Table 34: Options for licensing on page 86 to choose your licensing option, and select the procedure to follow.

Table 34: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Genero BDL Licenser</strong> with internet</td>
<td>See Install or update the maintenance key (BDL) with UI (via internet) on page 86.</td>
</tr>
<tr>
<td><strong>Genero BDL Licenser</strong> without internet.</td>
<td>See Install or update the maintenance key (BDL) with UI (no internet) on page 88.</td>
</tr>
<tr>
<td><code>fglwrt</code> command line tool with internet.</td>
<td>See Install or update the maintenance key (BDL) with fglwrt (via internet) on page 89.</td>
</tr>
<tr>
<td><code>fglwrt</code> command line tool without internet.</td>
<td>See Install or update the maintenance key (BDL) with fglwrt (no internet) on page 89.</td>
</tr>
</tbody>
</table>

Install or update the maintenance key (BDL) with UI (via internet)

Use the Genero user interface to install or update your maintenance key.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero BDL Licenser** tool from your Four Js program list

   The licensing page opens in your Web browser.

2. Select the **REGISTER LICENSE USING FOUR JS ACTIVATION SERVER** option.
3. In the CUSTOMER CODE field, enter your customer code.

4. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

5. Click INSTALL MAINTENANCE KEY

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to log out and close the licensing application.
Install or update the maintenance key (BDL) with UI (no internet)

Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then use the Genero user interface to install or update your maintenance key.

1. From a machine with internet access, open a browser and navigate to the Four Js web site to get the maintenance key. See the procedure described in Get maintenance key from Four Js website on page 80.
2. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero BDL Licenser tool from your Four Js program list

The licensing page opens in your Web browser.
3. Enter your maintenance key in the field provided, and click UPDATE KEY.

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.
4. When finished, click **QUIT** to close the licensing application.

**Install or update the maintenance key (BDL) with fglwrt (via internet)**

You can install or update the maintenance key of your BDL product using the command line tool, fglWrt.

**Before you begin:** You must have internet access to automatically install the maintenance key.

**Important:** If your installation directory is in the **C:\Program Files** path, you must run as administrator when you license the product. This avoids any permission issues.

1. At the command line enter the command:
   
   ```
   fglWrt -m auto
   ```

2. When prompted, enter your customer code:
   
   ```
   Enter your customer code >
   ```

3. At the following prompt:
   
   ```
   Do you need to configure an HTTP proxy ? (y/n)
   ```

   Enter **y** if your access to the internet is through a proxy. Provide the required information for **HTTP proxy. Port**, and authentication when prompted. Otherwise, enter **n**.

   The **maintenance key** is then retrieved from the Four Js Activation server and a message is displayed:
   
   Maintenance key installation successful.

**Install or update the maintenance key (BDL) with fglwrt (no internet)**

Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then to install or update the maintenance key of your BDL product use the command line tool, fglWrt.

**Important:** If your installation directory is in the **C:\Program Files** path, you must run as administrator when you license the product. This avoids any permission issues.

1. From a machine with internet access, open a browser and navigate to the **Four Js web site** to get the maintenance key. See the procedure described in **Get maintenance key from Four Js website** on page 80.

2. At the command line enter the command to install the maintenance key:
   
   ```
   fglWrt -m <maintenance-key>
   ```

   A message is displayed in the output to say the license installation was successful.

   License installation is now completed.

---

**License using Four Js License Manager**

License your Genero Business Development Language (BDL) product installation using a license manager on the network.

For details see **License using Four Js License Manager** on page 114.
License Genero Report Engine (GRE)

These topics give you the information you need to install and manage the license of your Genero Report Engine.

If your Genero Business Development Language (BDL) installation has a valid maintenance key, you do not need to license the Genero Report Engine. This applies to both local and remote distributed environments. To review the rules regarding licensing and the GRE, please refer to the Genero Licensing manual.

Steps to GRE license installation

Preparing to license involves evaluating your options based on what licensing tool (GUI or command line) is available to you, and whether you can validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

Before you begin Genero product licensing:

1. Locate your email message that contains the following:
   - product license key
   - product license number
   - product maintenance key
   - your customer code

   If you do not have this email, contact your local Four Js sales office.

2. Decide which tool (GUI or command line) you are using to install the license:
   - Genero Report Engine Licenser (GUI application)
   - greWrt (command line tool).

3. Determine if you have internet access from the machine you are licensing the product.

4. Use Table 35: Options for licensing on page 90 to choose your licensing option, and select the procedure to follow.

Table 35: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>greWrt command line tool with internet.</td>
<td>See Install GRE license from the command line on page 92.</td>
</tr>
<tr>
<td>greWrt command line tool without internet.</td>
<td>See Install GRE license from the command line on page 93.</td>
</tr>
</tbody>
</table>

Install Genero Report Engine license with GUI (internet)

You can license a Genero Report Engine (GRE) product installation using the Genero Report Engine Licenser GUI application.

Before you begin: You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
- From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list: The licensing page opens in your Web browser.

![Genero Report Engine Licenser](image)

**Figure 22: Genero Report Engine Licenser**

2. Enter your license number and license key, and click **INSTALL**.

Register the license

3. Select the **REGISTER LICENSE USING FOUR JS ACTIVATION SERVER** option.

4. In the **CUSTOMER CODE** field, enter your customer code.

5. If your access to the internet is through a proxy, select the **USE PROXY** option, and perform the following steps:
   a) Provide the required information for **HTTP PROXY** and **PORT** options.
   b) If the proxy requires authentication, select the **USE AUTHENTICATION** option and provide the required information for **LOGIN** and **PASSWORD**.

6. Click **INSTALL KEYS**

   Your product is now fully licensed. In the **DESCRIPTION** field you see your maintenance key is valid until the date displayed after **End of maintenance date**.

7. When finished, click **QUIT** to log out and close the licensing application.

**Install GRE license with GUI (no internet)**

Without internet access, you register the license with Four Js from another machine via the internet, or by phone. Then use the user interface to license your Genero Report Engine.

1. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list:

     The licensing page opens in your Web browser.

2. Enter your license number and license key, and click **INSTALL**.

   An **installation number** is generated.

Register the license
3. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 78

Having registered your license, you have the installation key.

4. On the licensing page enter your installation key in the INSTALLATION KEY field, and click INSTALL KEY.

![Figure 23: Manually install installation key and maintenance key](image)

5. Enter your maintenance key, and click UPDATE KEY.

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to close the licensing application.

Install GRE license from the command line

You can license a Genero Report Engine (GRE) product using the command line tool, greWrt. During installation the license is registered with Four Js via the internet.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

**Important:** If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.

1. At the command line enter the command:

   ```
greWrt -l
   ```

2. When prompted, enter the license number.

3. When prompted, enter the license key.
4. At the prompt:

   Do you want to continue using HTTP ? (y/n)

Enter: y

5. When prompted, enter your customer code:

   Enter your customer code >

6. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

Figure 24: Installing and registering a license via HTTP with greWrt

License installation is now completed.

Install GRE license from the command line

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then license your Genero Report Engine (GRE) product using the command line tool, greWrt.

**Important**: If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.

1. At the command line enter the command:

   greWrt -l

2. When prompted, enter the license number.

3. When prompted, enter the license key.

   An installation number is generated and displayed in the output.

4. At the prompt:

   Do you want to continue using HTTP ? (y/n)

Enter: n
5. At the prompt:

   Enter your maintenance KEY (Empty to continue) >

   Enter the maintenance key.

Register the license

6. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 78.

   Having registered your license, you have the installation key.

7. At the prompt:

   Enter the installation KEY (call your vendor to obtain it) >

   Enter the installation key.

![Figure 25: Installing license with greWrt](image)

License installation is now completed.

Manage Genero Report Engine local license

Refer to the topics in this section to quickly become familiar with how to perform license management tasks.

You can install and manage licenses locally using the license controller (`greWrt`) installed with the product.

License Controller (greWrt) options

The `greWrt` command line tool is used to install, upgrade, or delete Genero Report Engine licenses. There are also options to provide various types of license information and statistics.

Syntax

```
 greWrt [options]
```

1. `options` are described in Table 36: greWrt options on page 95.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-v</code> or <code>-V</code></td>
<td>Displays version information.</td>
</tr>
<tr>
<td><code>-h</code></td>
<td>Displays options for the tool.</td>
</tr>
<tr>
<td><code>-l license</code></td>
<td>Installs a license. <strong>Note:</strong> To escape when prompted to enter a license number and license key, type &quot;stop&quot; at the prompt.</td>
</tr>
<tr>
<td><code>-m option</code></td>
<td>Maintenance key installation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>• key: Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>• auto: The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td><code>-u</code></td>
<td>Check for active users.</td>
</tr>
<tr>
<td><code>-k option</code></td>
<td>Installation key for license validation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>• key: Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>• auto: The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td><code>-d</code></td>
<td>Remove current installed license.</td>
</tr>
<tr>
<td><code>-i</code></td>
<td>Clears the list of registered user sessions.</td>
</tr>
<tr>
<td><code>-a option</code></td>
<td>Check or view options. Here option can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• ps: Shows processes on this machine.</td>
</tr>
<tr>
<td></td>
<td>• env: Shows current environment</td>
</tr>
<tr>
<td></td>
<td>• cpu: Shows number of CPU in the computer.</td>
</tr>
<tr>
<td></td>
<td>• hostname: Shows name of this machine.</td>
</tr>
<tr>
<td></td>
<td>• info license: Shows license information.</td>
</tr>
<tr>
<td></td>
<td>• info stat: Shows statistics of license server.</td>
</tr>
<tr>
<td></td>
<td>• info users: Shows all registered active users.</td>
</tr>
<tr>
<td></td>
<td>• info up: Shows if license server is up.</td>
</tr>
<tr>
<td><code>-x</code> or <code>-kill-session pid</code></td>
<td>Clears the session referenced by the specified pid.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| --batch action=command | Performs the specified action in batch mode. Here *command* can be one of the following:  
- target-info (Get operating system information)  
- lm-info (Get license manager information)  
- product-info (Get license controller information)  
- license-info (Get license information)  
- install-license  
- uninstall-license  
- install-mkey^mkey=maintenance_key  
- install-mkey-http^login=username^proxy=http://myproxy^proxy-port=port-number^proxy-user=proxy-user^proxy-passwd=proxy-password  
- install-ikey^ikey=installation_key  
- install-ikey-http^user=username^proxy=http://myproxy^proxy-user=proxy-user^proxy-passwd=proxy-password  
The caret character (^) is used for parsing. In Windows® the caret is also used to escape special characters so you may need to double (^^) it up in commands, for example:  
```
greWrt --batch action=install-mkey^^mkey=maintenance_key
```
| --batch-console action=command | Opens greWrt in console mode for the batch commands.  
```
C:\gst\gre\bin>greWrt --batch-console
$ action=product-info
{
  "product": "greWrt",
  "version": "5.20.11",
  "wrtminver": "5.20.05",
  "build": "201908061357",
  "target": "w64v141",
  "status": 0,
  "status-msg": "Success."
}
$  
```
The output is JSON formatted. You can enable / disable indentation on the output. The default is indented. To quit the console type `exit`. Type `help` for instructions on its use. | docker-assign docker-instance-name docker-instance-id | Assigns the license to a running docker instance. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>docker-release</td>
<td>Release a docker-assigned license.</td>
</tr>
</tbody>
</table>

**Get license information**

Get details of the status of the license of your Genero product, for example, the maintenance contract expiry date, or the installation number for license registration.

**License details reference**

A reference to license details.

The output from the license controller command, for example, `fglWrt -a info license` and/or the Genero Licenser application screen displays details about the installed license. Use Table 37: License details on page 97 as a reference to look up details of your license.

**Note:** For specific license details, see your license agreement, or contact your nearest Four Js sales office.

**Table 37: License details**

<table>
<thead>
<tr>
<th>Details displayed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server name</td>
<td>This is the name of the license manager server. <strong>Note:</strong> Indicates that licensing is managed by a License Manager.</td>
</tr>
<tr>
<td>TCP Port</td>
<td>This is the port the license manager is listening. <strong>Note:</strong> Indicates that licensing is managed by a License Manager.</td>
</tr>
<tr>
<td>License</td>
<td>This is the value of the license number.</td>
</tr>
<tr>
<td>License Key</td>
<td>This is the value of the license key.</td>
</tr>
</tbody>
</table>
| Product           | This refers to the name of the product under license, for example:  
|                   | • Four J's Universal Compiler (for Genero Enterprise and Genero Mobile products)  
|                   | • Four Js Genero Report Writer (for Genero Report Engine) |
| Type              | This refers to the type of license. This can be:  
|                   | • runtime  
|                   | • development |
| Users             | This number indicates the maximum number of users allowed to use the license. |
### Related tasks

**Get license information** on page 71
Get details of the status of the license of your Genero product.

### Get license information

Get details of the status of the license of your Genero product.

**Important:** If your installation directory is in the `C:\Program Files` path, you must run as administrator when you license the product. This avoids any permission issues.

**About this task:**
Use this procedure, for example, to find out the date the maintenance contract expires.

**Tip:** You can also use the procedure described in this topic to retrieve the installation number when you need to register the license and finalize the installation.

From a command prompt, enter the command:

```
greWrt -a info license
```

**Example of Genero Report Engine license information:**

<table>
<thead>
<tr>
<th>License</th>
<th>(GRE Built-in license)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Four Js Genero Report Writer</td>
</tr>
<tr>
<td>Type</td>
<td>Runtime version</td>
</tr>
<tr>
<td>CPU(s)</td>
<td>CPU unlimited</td>
</tr>
<tr>
<td>Extension(s)</td>
<td>- DVM License under maintenance</td>
</tr>
</tbody>
</table>

In the example, the Genero Report Engine license is shown as built-in. This means that it is covered under the Genero Business Development Language installation. As the DVM license is under maintenance, the GRE license is valid.

### Related concepts

**License details reference** on page 70
A reference to license details.

### Get license information using GRE licenser

Get details of the status of the license of your Genero Report Engine product.

1. Launch the Genero Licenser application.
   - From within the Genero Studio product interface, launch it from the **Tools > Genero Tools** menu.
   - From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list.
The Four Js Licensing Application opens.

![Four Js Licensing Application](image)

**Figure 26: Genero Report Engine Licenser**

In the example, the Genero Report Engine license is shown as built-in. This means that it is covered under the Genero Business Development Language installation. As the DVM license is under maintenance, the GRE license is valid.

2. When finished, select **Quit** to exit the application.

**Related concepts**

- [License details reference](#) on page 70
  A reference to license details.

**Uninstall license**

You may need to uninstall a license if you are making some hardware or software changes.

**Uninstall license with GRE licenser**

Use this procedure to uninstall a license for your Genero Report Engine product using the Genero Report Engine Licenser.

**About this task:**

- **Note:** This procedure is valid for a local license only. If you are using the Four Js License Manager, see [Manage licenses with FLM (flmprg)](#) on page 119.

1. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list:
The licensing page opens in your Web browser.

2. Click **Uninstall** to uninstall the license.  
The **DESCRIPTION** field is updated to show a license is not installed.

3. When finished, click **QUIT** to close the licensing application.

**Uninstall license from command line**

Use this procedure to uninstall a license for your Genero Report Engine product using greWrt.

**Before you begin:** You must be the root user or the user who installed the software, to run the license controller command.

**Important:** If your installation directory is in the **C:\Program Files** path, you must run as administrator when you license the product. This avoids any permission issues.

From a command prompt, enter the license controller command.

```
greWrt -d
```

At the prompt:

```
Do you really want to uninstall the license (y/n)?
```

Enter: **y**

The license is uninstalled. A message confirms the license is uninstalled.

![Uninstalling a License with the License Controller (greWrt)](image)

**License an upgraded installation**

There are some considerations for licensing when upgrading an existing Genero installation to a newer version.

**Notes about Upgrading**

It is not necessary to re-enter the license of the product if the new version:

- Is installed into an existing installation directory
- Is not a major version number change

When you have purchased a new maintenance contract, the new maintenance key must be installed. To install your new maintenance key, you do not need to reinstall your license. Updating the maintenance key is handled separately. There is also no need to uninstall the old maintenance key.

**Register license on Four Js website**

Register your license with Four Js in order to validate it.

**About this task:**
Important:

If you can use the license controller `-m auto` option to install the license via the internet, (for example `fglWrt -m auto`), then you do not need to perform this task.

Before you begin:

- Get your **installation number** from the output of the following command:

  ```
  <license_controller> -a info license
  ```

  Where `<license_controller>` is `fglWrt` (for Genero Enterprise), or `greWrt` (for Genero Report Engine), depending on which product you are licensing.

  Or if you are using Four Js License Manager, use the following command:

  ```
  flmprg -a info license <license_number>
  ```

- You must also have the following:
  - Customer code
  - License number
  - License key

  Typically, these are delivered by email with your product. If you do not have them, contact your local sales office.

1. Open your browser and navigate to the Four Js web site:

2. Navigate to the **Support > License your products** page.
   The **Online registration** form is displayed.
3. Complete the **Online registration** form making sure that everything is entered correctly and select **Submit**. A new page is displayed showing information that your license has been registered and providing you with:

- Installation key
- Maintenance key

At this point, you need to install the installation and maintenance keys.

**Related tasks**

Troubleshooting license registration on page 80

When registering your license on the Four Js website you get an error message. More than likely you need to request a new activation key.

---

**Get maintenance key from Four Js website**

You get the maintenance key from the Four Js website to ensure you have a valid maintenance key to install or update your product's license.

**About this task:**
If you can use the license controller `--m auto` option to install the maintenance key via the internet, (for example `fglWrt --m auto`), then you do not need to perform this task.

**Before you begin:**

You must also have the following:

- Customer code
- License number

1. Open your browser and navigate to the Four Js web site.
2. Navigate to the Support > License your products page and scroll to the Online maintenance section.

![Four Js Online Maintenance form](image)

**Figure 29: Four Js Online Maintenance form**

3. Complete the form making sure that everything is entered correctly and select Submit. A new page is displayed providing you with the maintenance key.

At this point, you need to install the maintenance key.

### Steps to finalize temporary GRE license

You register the license with Four Js to finalize your product’s license installation. To complete licensing, select the option (with or without internet) that is right for you and match it with the procedure to follow.

**Before you begin finalizing licensing:**

1. Decide which tool (GUI or command line) you are using to install the license:
   - **Genero Report Engine Licenser** (GUI application)
   - `greWrt` (command line tool).
2. Determine if you have internet access from the machine you are licensing the product.
3. Use Table 39: Options for licensing on page 108 to choose your licensing option, and select the procedure to follow.

#### Table 38: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Genero Report Engine Licenser</strong> with internet</td>
<td>See Finalize Genero Report Engine license with GUI (via internet) on page 104</td>
</tr>
</tbody>
</table>
You are using ...

<table>
<thead>
<tr>
<th>Genero Report Engine Licenser without internet.</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>greWrt command line tool with internet.</td>
<td>See Finalize Genero Report Engine license with GUI (no internet) on page 105</td>
</tr>
<tr>
<td>greWrt command line tool without internet.</td>
<td>See Finalize Genero Report Engine license from the command line (via internet) on page 106</td>
</tr>
</tbody>
</table>

Finalize Genero Report Engine license with GUI (via internet)
You can complete licensing using the user interface. The license is registered with Four Js via the internet and the maintenance key is installed.

Before you begin: You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   • From within the Genero Report Writer product interface, launch it from the Tools > Genero Tools menu
   • From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list:

   The licensing page opens in your Web browser.

Register the license
2. Select the REGISTER LICENSE USING FOUR JS ACTIVATION SERVER option.

![Image of Genero Report Writer licensing user interface]

Figure 30: Example registering the license
3. In the CUSTOMER CODE field, enter your customer code.

4. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

5. Click INSTALL KEYS

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to log out and close the licensing application.

Finalize Genero Report Engine license with GUI (no internet)

Without internet access, you register the license with Four Js from another machine via the internet, or by phone. Then to complete licensing use the user interface as described.

Register the license

1. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 78

   Having registered your license, you have the installation key.

2. Launch the Genero licensing user interface.
   • From within the Genero Report Writer product interface, launch it from the Tools > Genero Tools menu
   • From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list:

   The licensing page opens in your Web browser.

3. Enter your installation key, and click INSTALL KEY.
4. Enter your maintenance key, and click UPDATE KEY.

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

5. When finished, click QUIT to log out and close the licensing application.

**Finalize Genero Report Engine license from the command line (via internet)**

Licensing of your Genero Report Engine product can be completed using the command greWrt -k auto. Your license is registered with Four Js via the internet and the installation and maintenance keys are installed automatically.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

**Important:** If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.

1. At the command line enter the command:
   ```plaintext
greWrt -k auto
   ```

2. When prompted, enter your customer code:
   ```plaintext
   Enter your customer code >
   ```

3. At the following prompt:
   ```plaintext
   Do you need to configure an HTTP proxy ? (y/n)
   ```
Enter y if your access to the internet is through a proxy. Provide the required information for **HTTP proxy**, **Port**, and authentication when prompted. Otherwise, enter n.

The installation key and the maintenance key are installed automatically and the message is displayed.

```
Installing maintenance key 'MMMMMMMMMMMMM'
License installation successful.
License installation is now completed.
```

Note: There is no need to run `greWrt -m auto` to install the maintenance key.

**Finalize Genero Report Engine license from the command line (no internet)**

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then complete licensing of your Genero Report Engine product using the command line tool, greWrt.

**Important:** If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.

**Register the license**

1. To register the license contact the vendor by phone, or register on the Genero Report Writer website. See the procedure described in Register license on Four Js website on page 78

Having registered your license, you have the installation key.

2. At the command line enter the command to install the installation key:

```
greWrt -k <installation-key>
```

A message is displayed in the output to say the installation key was installed successfully.

3. At the command line enter the command to install the maintenance key:

```
greWrt -m <maintenance-key>
```

A message is displayed in the output to say the license installation was successful.

License installation is now completed.

**Steps to apply maintenance or subscription key (GRE)**

You apply a maintenance key (also known as a subscription key depending on your contract) when you are installing a license for a product and thereafter when you renew your maintenance contract.

An active maintenance or subscription contract is required to license a product. The maintenance key determines which version of the Genero product you are authorized to use with your license, and the date that the maintenance contract expires.

Before you begin applying a maintenance key:

1. Decide which tool (GUI or command line) you are using to install the key:

   - **Genero Report Engine Licenser** (GUI application)
   - **greWrt** (command line tool).

2. Determine if you have internet access from the machine you are licensing the product.

3. Use Table 39: Options for licensing on page 108 to choose your licensing option, and select the procedure to follow.
Table 39: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Genero Report Engine Licenser</strong> with internet</td>
<td>See Install or update the maintenance key (GRW) with GUI (via internet) on page 108</td>
</tr>
<tr>
<td><strong>Genero Report Engine Licenser</strong> without internet.</td>
<td>See Install or update the maintenance key (GRE) with GUI (no internet) on page 109</td>
</tr>
<tr>
<td>grxWrt command line tool with internet.</td>
<td>See Install or update the maintenance key (GRE) with greWrt (via internet) on page 110</td>
</tr>
<tr>
<td>grxWrt command line tool without internet.</td>
<td>See Install or update the maintenance key (GRE) with greWrt (no internet) on page 111</td>
</tr>
</tbody>
</table>

**Install or update the maintenance key (GRW) with GUI (via internet)**

Use the Genero user interface to install or update your maintenance key.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list:
     The licensing page opens in your Web browser.

2. Select the **REGISTER LICENSE USING FOUR JS ACTIVATION SERVER** option.
Figure 32: Example installing maintenance key

3. In the CUSTOMER CODE field, enter your customer code.

4. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

5. Click INSTALL MAINTENANCE KEY

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to log out and close the licensing application.

Install or update the maintenance key (GRE) with GUI (no internet)

Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then use the Genero user interface to install or update your maintenance key.

1. To get the maintenance key, open a browser and navigate to the Four Js web site. See the procedure described in Get maintenance key from Four Js website on page 80.

2. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list:

   The licensing page opens in your Web browser.

3. Enter your maintenance key, and click UPDATE KEY.
Figure 33: Manually install maintenance key

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

4. When finished, click QUIT to close the licensing application.

Install or update the maintenance key (GRE) with greWrt (via internet)

You can install or update the maintenance key of your Genero Report Engine (GRE) product using the command, greWrt -m auto. During installation the maintenance key is retrieved from Four Js via the internet.

Before you begin: You must have internet access to automatically install the maintenance key.

Important: If your installation directory is in the C:\Program Files path, you must run as administrator when you license the product. This avoids any permission issues.

1. At the command line enter the command:

   greWrt -m auto

2. When prompted, enter your customer code:

   Enter your customer code >

3. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.
The **maintenance key** is then retrieved from the Four Js Activation server and a message is displayed:

Maintenance key installation successful.

**Install or update the maintenance key (GRE) with greWrt (no internet)**

Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then to install or update the maintenance key of your Genero Report Engine (GRE) product use the command line tool, greWrt.

**Before you begin:**

**Important:** If your installation directory is in the `C:\Program Files` path, you must run as administrator when you license the product. This avoids any permission issues.

**Register the license**

1. To get the maintenance key, open a browser and navigate to the Four Js web site. See the procedure described in [Get maintenance key from Four Js website](#) on page 80.
2. At the command line enter the command to install the maintenance key:

   ```
   greWrt -m <maintenance-key>
   ```

   A message is displayed in the output to say the license installation was successful.

   License installation is now completed.

**License Genero Report Engine using the Four Js License Manager**

License your Genero Report Engine (GRE) product installation using a license manager on the network.

For details see [License using Four Js License Manager](#) on page 114.

**License Genero Mobile**

To license Genero Mobile, you license the Genero Business Development Language. Please see the topics covering the licensing of Genero Business Development Language.

When licensing Genero Mobile, your Genero Business Development Language (BDL) license must be for a Genero Mobile installation. If you receive an error message:

```
ERROR(-6024) : Modules compiled with Genero Mobile require a Genero Mobile license at runtime.
```

This means that the Genero BDL license you have is not valid for Genero Mobile. Please contact your local sales office for further information.

**Tip:** While you can use a license manager for Genero Mobile, the Genero Mobile license is an individual license and there is no need to use a license manager. You would only consider using the Four Js License Manager for Genero Mobile if you already use it with an existing Genero installation.

**Related concepts**

- [Steps to BDL license installation](#) on page 58
Preparing to license involves evaluating your options based on what licensing tool (GUI or command line) is available to you, and whether you can validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

**Find your mobile app p-code size**

If you have a Genero Mobile free developer license, use this procedure to determine your app's p-code size.

The free developer license is suitable for apps whose p-code is under 64K (65,535 bytes to be precise).

**Note:** For general information about the fglrun sizing options --program-size and --module-size, see the *Genero Business Development Language User Guide*.

1. From Genero Studio, open the **Tools > Genero Tools** menu and select **Genero Workplace Window**. The **Genero Workplace Window** opens and displays a command prompt.
2. Verify that you are using a free Genero Mobile license.
   
   Type the command `fglWrt -a info`.

   ![Figure 34: Checking your Genero Mobile license](image)

   The output states when you are using a free license. You only need to continue this procedure if you are using a free license. A paid license has no limit.

3. Navigate to the directory where your compiled program files reside.
4. Type the command `fglrun --program-size appname`, where *appname* is your app name.
Figure 35: Determining the bytes towards your app p-code limit

The last line of the output shows the number of kilobytes of p-code for the app, as well as the number of kilobytes that apply towards the free license limit. The limit number cannot exceed 64K.

**Note:** The limit only includes the modules compiled with the free license. These modules are identified with the \( \text{(limited)} \) tag in the command output. Modules precompiled in Genero packages are not compiled with a free license, and therefore do not count towards the limit.
License using Four Js License Manager

License your Genero Business Development Language (BDL) or Genero Report Engine (GRE) product installation using the Four Js License Manager (FML) on the network.

License Manager configuration

Configure by linking the DVM configuration file with the License Manager.

**Tip:** The DVM configuration file, for example `$FGLDIR/etc/fglprofile`, can be automatically updated with FLM server details when installing Genero on a UNIX® platform, as long as the FLM is installed, and the option to use the FLM is selected at time of installation.

Configure the License Manager

To configure the Four Js License Manager (FLM), edit the `$FLMDIR/etc/lmprofile` file.

Configuration entries are in the format `name-of-resource="value"

**Note:** The `flm.storage` configuration entry was deprecated in version 5.12.08. If a configuration entry is set for `flm.storage`, it is silently ignored.

1. To set the value for the FLM server resource, add the line in the following format with the name of the server:

   For example, if your DNS or your hosts file is correctly configured, you can safely use localhost:

   ```
   flm.server="localhost"
   ```

   **Note:** Working with Docker on macOS™:

   If you are hosting FLM and docker containers on the same host, it is recommended to configure a mapping to the localhost using a special DNS name which will resolve to the internal IP address used by the host; regardless of changes in the network. See Configure license with FLM for docker on macOS host on page 135.

2. Add or update values for the resources shown in Table 40: License Manager Configuration Resources on page 114 as required:

**Table 40: License Manager Configuration Resources**

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flm.server</td>
<td>none</td>
<td>Name of the machine that hosts FLM. Set this value to the machine name or IP address where FLM is installed. <strong>Warning:</strong> Although no default is provided, this parameter is mandatory.</td>
</tr>
<tr>
<td>flm.service</td>
<td>6399</td>
<td>Service or port number for the communication between the license controller and FLM.</td>
</tr>
<tr>
<td>Resource Name</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>flm.check</td>
<td>100</td>
<td>Number of connections between checks of the registered users list for a host machine. The control of active users is important, as it will synchronize real users on the network with the registered users list managed by FLM. The check is used to recover licenses from users that are no longer active (in case of VM crash, the associated license may not be recovered). To disable this control, set the parameter to (-1). <strong>Warning:</strong> If you disable this control, some registered users will never be unregistered by the FLM unless you run the command <code>flmprg -u &lt;host&gt;</code>. See Force a Check of the Registered Users List (flmprg) on page 124.</td>
</tr>
<tr>
<td>flm.license.shared</td>
<td>0</td>
<td>Set to 1 (true) to share licenses between users. If you have licenses for the same product, type, and extension, the total number of users will be cumulative.</td>
</tr>
<tr>
<td>flm.cnxlog.enabled</td>
<td>0</td>
<td>Set 1 (true) to activate the FLM connection log. Support may request that you enable this option and send the generated log files to aide in analyzing licensing issues. The log files are created in <code>FLMDIR</code>. The files are named using the pattern <code>flm-YYYYMMDD-id.log</code>, where: (\text{• } YYYY = ) current year (\text{• } MM = ) current month (\text{• } DD = ) day of month (\text{• } id = ) counter value. The counter value is incremented each time the FLM is started.</td>
</tr>
</tbody>
</table>

**Related tasks**

Configure the license controller on page 115

Before the Four Js License Manager (FLM) can manage a Genero product license, you need to configure the product's DVM configuration file locally with FLM server details and the product's license key and number.

**Configure the license controller**

Before the Four Js License Manager (FLM) can manage a Genero product license, you need to configure the product's DVM configuration file locally with FLM server details and the product's license key and number.

- Genero Enterprise and Genero Mobile products are configured by setting values in the `FGLPROFILE` file.
- Genero Report Engine (GRE) is configured by setting values in the `GREPROFILE` file.

**Important:** Licensing for Genero Report Writer for Java, C# and PHP must be managed locally as it can not be managed by the License Manager.

1. To set the value for the FLM server, add the line in the following format with the name of server:
   
   For example:
   
   `flm.server="<FLM_server>"`

2. To set the value for the license number, add the line in the following format:
   
   `flm.license.number="<license_number>"`

3. To set the value for the license key, add the line in the following format:
4. Add or update values for the resources shown in Table 41: DVM - configuration resources for License Server on page 116 as required:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flm.server</td>
<td>none</td>
<td>Name of the machine that holds the license service program. This value should be the same as the entry in Four Js License Manager configuration file, <code>$FLMDIR/etc/lmprofile</code>. <strong>Warning:</strong> Although no default is provided, this parameter is mandatory.</td>
</tr>
<tr>
<td>flm.license.number</td>
<td>none</td>
<td>Value of your current license number. You must set this value to use Four Js License Manager. (For example: XXX#XXXXXXXX)</td>
</tr>
<tr>
<td>flm.license.key</td>
<td>none</td>
<td>Value of your current license key. You must set this value to use Four Js License Manager. (For example: YYYYYYYYYYYY)</td>
</tr>
<tr>
<td>flm.service</td>
<td>6399</td>
<td>Service or port number for the communication between the local license controller and Four Js License Manager. This value should be the same as in the Four Js License Manager configuration file, <code>$FLMDIR/etc/lmprofile</code>. See Configure the License Manager on page 114.</td>
</tr>
<tr>
<td>flm.check</td>
<td>10</td>
<td>Number of iterations between two controls of the user list. Default is 10.</td>
</tr>
<tr>
<td>flm.ps</td>
<td>ps -ae</td>
<td>Specifies the command that gives a process list for a machine. This value is used to synchronize the real user list on the current machine with the registered users list on Four Js License Manager. <strong>Warning:</strong> This entry is not used on most platforms as the default value <code>ps -ae</code> is replaced by a call to an API. Do not set this resource unless the internal implementation relying on the OS-specific API call fails.</td>
</tr>
</tbody>
</table>

**Steps to licensing with FLM**

Preparing to license involves deciding how you are going to validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

Before you begin Genero product licensing:

1. Locate your email message that contains the following:
   - product license key
   - product license number
   - product maintenance key
   - your customer code

   If you do not have this email, contact your local Four Js sales office.
2. Determine if you have internet access from the FLM server.
3. Use Table 42: Options for licensing on page 117 to choose your licensing option, and select the procedure to follow.

Table 42: Options for licensing

<table>
<thead>
<tr>
<th>FLM Licensing options</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using flmprg with internet.</td>
<td>See Install license with Four Js License Manager (via internet) on page 117.</td>
</tr>
<tr>
<td>Using flmprg without internet.</td>
<td>See Install license with Four Js License Manager (without internet) on page 118.</td>
</tr>
</tbody>
</table>

Install license with Four Js License Manager (via internet)

Follow this procedure to license a Genero product using the FLM command line tool, flmprg -l. During installation the license is registered with Four Js via the internet.

**Before you begin:** You must have internet access from the FLM server to validate the license.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type flmprg -l
2. When prompted, enter the license number.
3. When prompted, enter the license key.
4. At the prompt:
   
   Do you want to continue using HTTP ? (y/n)

   Enter: y
5. When prompted, enter your customer code:

   Enter your customer code >
6. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

   Enter y if your access to the internet is through a proxy, and provide the required information for HTTP proxy and Port when prompted. Otherwise, enter n.
License installation is now completed.

Install license with Four Js License Manager (without internet)

Use this procedure to license a Genero product using the FLM command line tool, flmprg -l. Without internet access, you can register the license with Four Js from another machine via the internet, or by phone.

1. Start the command line interface.
   a) Open a command prompt.
      - On Windows®, open the License Manager Workplace window from the Start menu.
      - On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg -l`

2. When prompted, enter the license number.

3. When prompted, enter the license key.
   An installation number is generated and is displayed in the output.

4. At the prompt:
   
   ```
   Do you want to continue using HTTP ? (y/n)
   ```

   Enter: n

5. At the prompt:

   ```
   Enter your maintenance KEY (Empty to continue) >
   ```

   Enter: <maintenance-key>

Register the license

6. To register the license contact the vendor by phone, or register on the Four Js website. See the procedure described in Register license on Four Js website on page 78.

   Having registered your license, you have the Installation key

7. At the prompt:

   ```
   Enter the installation KEY (call your vendor to obtain it) >
   ```

   Enter: installation_key
Figure 37: Installing License with License Manager (flmprg) without internet

License installation is now completed.

Manage licenses with FLM (flmprg)

The License Manager program is installed and its service started to manage license controller connections. There are various command line options that you use for managing licensing with FLM.

The License Manager program is called flmprg on Linux®/UNIX™ and flmprg.exe on Windows®. The recommendation is to run this program only on the machine where the License Manager is installed and configured and where its daemon or service is started to listen for license controller connections. This chapter includes topics to manage licences.

Note: On Linux®/UNIX™ systems to avoid issues with directory permissions, it is recommended that the non-privileged user (not root user) who installs the License Manager, should also start the daemon and add licenses.

FLM (flmprg) options

The flmprg command line tool is used to install, upgrade, or delete Genero licenses. There are also options that apply specifically to Windows®, and options to provide various types of license information and statistics.

Syntax

```
flmprg [options]
```

1. General command options are described in Table 43: General command options on page 119.
2. Options for use on Windows® only are described in Table 44: Windows only command options on page 120

flmprg Options

Table 43: General command options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-l [license]</td>
<td>Installs a license (requires license number and license key).</td>
</tr>
<tr>
<td>-m license</td>
<td>Install the maintenance key for the specified license.</td>
</tr>
<tr>
<td>-v or -V</td>
<td>Shows license manager version information.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>-u host</code> or <code>-u all</code></td>
<td>Checks active users working on a given host.</td>
</tr>
<tr>
<td><code>-r</code></td>
<td>Runs the license server daemon.</td>
</tr>
<tr>
<td><code>-s</code></td>
<td>Stops the license server daemon.</td>
</tr>
<tr>
<td><code>-d license</code></td>
<td>Deletes the specified license.</td>
</tr>
<tr>
<td><code>--kill-session host [pid]</code></td>
<td>Kills all sessions owned by the specified host, if <code>pid</code> is provided, only the specified session is cleared.</td>
</tr>
</tbody>
</table>

**Important:** For security reasons, you cannot remotely add or remove licenses registered on Four Js License Manager (FLM) with a local license controller command, for example, fglWrt.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-i license</code> or <code>-i all</code></td>
<td>Clears the list of registered user sessions for a given license.</td>
</tr>
<tr>
<td><code>-h</code></td>
<td>Display help for the license manager command.</td>
</tr>
</tbody>
</table>

**Warning:** All active users will be disconnected.
Use `-i all` to clear lists for all licenses.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>env</td>
<td>Shows current environment.</td>
</tr>
<tr>
<td>hostname</td>
<td>Shows name of the host machine.</td>
</tr>
<tr>
<td>info license</td>
<td>Shows license information.</td>
</tr>
<tr>
<td>info stat</td>
<td>Shows statistics for license manager server.</td>
</tr>
<tr>
<td>info users</td>
<td>Shows all registered active users.</td>
</tr>
<tr>
<td>info up</td>
<td>Checks if the FLM is started.</td>
</tr>
</tbody>
</table>

**Table 44: Windows only command options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>--service-install</code></td>
<td>Installs the service and exits.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>--service-start or -r</td>
<td>Starts the service.</td>
</tr>
<tr>
<td>--service-stop</td>
<td>Stops the service.</td>
</tr>
<tr>
<td>--service-uninstall</td>
<td>Uninstalls the service and exits.</td>
</tr>
<tr>
<td>--configuration-reload</td>
<td>Reloads the configuration file.</td>
</tr>
</tbody>
</table>

**Remove a license (Four Js License Manager)**

**Note:** Active users can continue to work after the license is deleted. No check on the registered users list is done for the deleted license. Once they stop their sessions, however, they will not be able to start them again.

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the License Manager Workplace window from the Start menu.
   - On Linux®, open a command prompt. "sudo" may be required.

b) Type `flmprg -d <license_number>`

![Figure 38: Uninstalling a License with the License Manager (flmprg -d)](image)

**Display license information and statistics**

Four Js License Manager provides various types of license information and statistics.

**Display license information (flmprg)**

Use this procedure to display details of all the enabled licenses, and their maintenance expiration dates.

**Tip:** If you need to check a specific license, you may also find it useful to run the license controller command from the target host that consumes the license. For example:

`fglWrt -a info license`

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the License Manager Workplace window from the Start menu.
   - On Linux®, open a command prompt. "sudo" may be required.

b) Type `flmprg -a info license`

Example of display:

<table>
<thead>
<tr>
<th>License</th>
<th>TXX#XXXXXXXX</th>
</tr>
</thead>
<tbody>
<tr>
<td>License key</td>
<td>KKKKKKKKKKKK</td>
</tr>
<tr>
<td>Product</td>
<td>Four J's Universal Compiler</td>
</tr>
<tr>
<td>Type</td>
<td>Development version</td>
</tr>
<tr>
<td>Users</td>
<td>1</td>
</tr>
<tr>
<td>Extension(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Enhanced license key format</td>
</tr>
<tr>
<td></td>
<td>- Strict licensing option</td>
</tr>
</tbody>
</table>
This license is date limited and expires the 2009/03/15 (Year/Month/Day). End of maintenance date: 2009/01/01 (Year/Month/Day).

**Display statistical information**
You can display statistics about license usage as shown in this procedure.

**Tip:** If you need to display statistical information on the use of a specific license on a machine, you may also find it useful to run the license controller command from the target host that consumes the license, for example:

```plaintext
fglwrt -a info stat
```

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the **License Manager Workplace** window from the **Start** menu.
   - On Linux®, open a command prompt. "sudo" may be required.

b) Type `flmprg -a info stat`

Example of display:

```
License Manager Statistics:
Runtime : 0
Accepted : 0
Rejected : 0
System Problem : 0
Compilation : 0
Accepted : 0
Rejected : 0
System Problem : 0
Extension : 0
Accepted : 0
Rejected : 0
System Problem : 0
End Runtime : 0
PID request : 0
Information : 1
Bad License : 58
Stop Manager : 0
Deleted licenses : 0
Unknown : 0
Total : 59
```

The following list describes the output fields and explains the values displayed:

- **Runtime**
  - This is the number of runtime requests, split into accepted, rejected and system problem categories.

- **Compilation**
  - This is the number of compilation requests, split into accepted, rejected and system problem categories.

- **Extension**
  - This is the number of extension requests, split into accepted, rejected and system problem categories.

- **EndRuntime**
  - This is the number of requests which specified that a runtime is finished.

- **PID request**
  - This is the number of requests for PID checking. This is an internal mechanism to synchronize the real users list and registered users list of the license manager.

- **Information**
  - This is the number of requests for statistics.

- **Bad License**
  - This is the number of requests for bad licenses (license not enabled or that does not exist).
Stop Manager
This is the number of requests to stop the license manager.

Deleted licenses
This is the number of requests to delete licenses.

Unknown
This is the number of requests of unknown type.

Total
This is the number of total requests.

**Display registered active users information**
Follow this procedure to display a list of registered active users.

**Tip:** If you need to check registered users on a specific license, you may also find it useful to run the license controller command from the target host that consumes the license, for example:

```bash
fglWrt -a info users
```

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the **License Manager Workplace** window from the **Start** menu.
   - On Linux®, open a command prompt. "sudo" may be required.

b) Type `flmprg -a info user`

This is an example of the output:

```
License : FAA#YYYYYYYY
Product : Four J's Universal Compiler
Type : Development version
Users : 2/200
Host : Athena
GUI Server : 10.0.0.33:0
Process Id : 2768
Process Id : 2854
Terminal : 772
Process Id : 2775
License : FAB#ZZZZZZZZ
Product : Four J's Universal Dynamic Virtual Machine
Type : Runtime version
Users : 0/700
```

The following list describes the output fields and explains the values displayed:

- **License**: This is the value of the license number.
- **Product**: This is the name of the product. In relation to Genero product, this can be, for example: Four J's Universal Compiler for Genero Enterprise and Genero Mobile products.
- **Type**: This is the type of license. This can be runtime version or development version.
- **Users**: Users are the current number of active users over the maximum number of users allowed.
- **Host**: This is the name of the host machine.
- **GUI server**: This is the IP address value of a graphical client.
- **Process Id**: This is the current process identifier.
- **Terminal**: This is the value of an ASCII client.
Manage the active user list (flmprg)

Four Js License Manager (FLM) provides you with methods to manage licenses being consumed by users by synchronizing the actual users list with the registered users list.

**Force a Check of the Registered Users List (flmprg)**

Request a synchronization of the real users list with the registered users list for a specific machine or for all machines.

The synchronization will be done at the next dialogue between the license controller of the machine and the Four Js License Manager.

**Tip:** A faster way to synchronize users may be to run the license controller command from the target host that consumes the license, for example:

```
fglWrt -u
```

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the **License Manager Workplace** window from the **Start** menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg -u <host>`
      Where `<host>` is the name of the machine.

2. To request a check of all machines using the license manager, execute the command:

```
flmprg -u all
```

Clean registered users list

Clean the registered users listed as using a license. The command option to clear users for all licenses is also shown.

**Warning:** Use `flmprg -i` with caution, as it implicitly invalidates all existing sessions of a specific license; eventually all running applications will stop with a license error.

It may be used in the case of, for example, a DVM crash when the associated license would not be recovered otherwise. In other cases, the `-u` option to force a check of the registered users should be preferred to the `-i` option.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the **License Manager Workplace** window from the **Start** menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg -i <license_number>`
      All users registered for this license are disconnected when you use this option.

2. To clean all licenses, execute the command:

```
flmprg -i all
```

Drop sessions attached to a host

In this procedure, you locate the information for a session that you wish to drop, and then you kill that session.

This procedure is for sessions managed by the Four Js License Manager (FLM). For local licensing, you can stop a session by entering `fglWrt -x <pid>`, where `<pid>` is the process id for the session. See the **Genero Business Development Language User Guide** for more information regarding the `fglWrt` command.

**Important:** This feature only applies to User licenses, not to CPU licenses.

1. Open a command prompt.
   • On Windows®, open the **License Manager Workplace** window from the **Start** menu.
2. Type `flmprg --info users` from the command prompt. The host name and process id combinations for each user display. You will use this information in the next step of this procedure.

3. Do you want to drop a single session, or all sessions from a host?
   a) To drop a single session, type `flmprg --kill-session <host>:<pid>`.
   b) To drop all sessions started on a host, type `flmprg --kill-session <host>`.

Restricting access to a Four Js License Manager

The license manager can be configured to filter the hosts connecting to it.

The following resources are available:

**Table 45: Filter Access Resources**

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flm.filter.deny.ip</td>
<td>none</td>
<td>List of IP addresses to deny.</td>
</tr>
<tr>
<td>flm.filter.deny.host</td>
<td>none</td>
<td>List of hostnames to deny.</td>
</tr>
<tr>
<td>flm.filter.deny.domain</td>
<td>none</td>
<td>List of domains to deny.</td>
</tr>
<tr>
<td>flm.filter.allow.ip</td>
<td>none</td>
<td>List of IP addresses to allow.</td>
</tr>
<tr>
<td>flm.filter.allow.host</td>
<td>none</td>
<td>List of hostnames to allow.</td>
</tr>
<tr>
<td>flm.filter.allow.domain</td>
<td>none</td>
<td>List of domains to allow.</td>
</tr>
<tr>
<td>flm.filter.priority</td>
<td>deny</td>
<td>Defines which rules will be processed first. Valid values for this parameter are &quot;allow&quot; and &quot;deny&quot;.</td>
</tr>
</tbody>
</table>

The IP addresses, host names and domains must be separated by a space character and can contain wildcards (* or ?).

**Example:**

```
flm.filter.deny.ip="127.0.0.* 192.168.200.1"
```

The processing order of the rule is important.

**Example:**

```
flm.filter.deny.ip="127.0.0.1"
flm.filter.allow.ip="127.0.0.1"
```

Using the priority `deny`, the IP address 127.0.0.1 is rejected, as the rule for `flm.filter.deny.ip` matches first.

Using the priority `allow`, the IP address 127.0.0.1 is accepted, as the rule for `flm.filter.allow.ip` matches first.

The license manager checks for IP addresses first, then host names, then domains.

Reload the configuration file (Windows only)

Use this procedure if you need to reload the FLM configuration file in a Windows® platform.

Start the command line interface.

a) Open a command prompt.

   On Windows®, open the License Manager Workplace window from the Start menu.

b) Type `flmprg --configuration-reload`.

Steps to finalize temporary license with FLM

You register the license with Four Js to finalize your product's license installation. To complete licensing, select the option (with or without internet) that is right for you and match it with the procedure to follow.

Before you begin finalizing licensing:

1. Determine if you have internet access from the FLM server.
2. Use Table 46: Options for licensing on page 126 to choose your licensing option, and select the procedure to follow.

Table 46: Options for licensing

<table>
<thead>
<tr>
<th>FLM Licensing options</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using flmprg with internet.</td>
<td>See Install license with FLM (via internet) on page 126.</td>
</tr>
<tr>
<td>Using flmprg without internet.</td>
<td>See Finalize license with FLM (without internet) on page 127.</td>
</tr>
</tbody>
</table>

Install license with FLM (via internet)

You can complete licensing using the flmprg -l command. The license is registered with Four Js via the internet and the maintenance key is installed.

Before you begin: You must have internet access from the machine you are licensing the product to validate the license.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux, open a command prompt. "sudo" may be required.
   b) Type flmprg -l <license-number>
      Note: The FLM recognizes you are in temporary license mode, and it will prompt you for the missing installation key to complete the license installation and switch to permanent license mode.

2. When prompted
   Do you want to continue using HTTP ? (y/n)

   Enter: y

3. When prompted, enter your customer code:

   Enter your customer code >

4. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

   Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

   The installation key is retrieved automatically from the Four Js Activation server. License installation is now completed.
Finalize license with FLM (without internet)

Without internet access, you complete licensing using the flmprg -l command. You can register the license with Four Js from another machine via the internet, or by phone.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux, open a command prompt. "sudo" may be required.
   b) Type `flmprg -l <license-number>`

   **Note:** The FLM recognizes you are in temporary license mode, and it will prompt you for the missing installation key to complete the license installation and switch to permanent license mode.

2. When prompted
   Do you want to continue using HTTP ? (y/n)
   Enter: n

Register the license

3. To register the license contact the vendor by phone, or register on the Four Js website. See the procedure described in Register license on Four Js website on page 78.

Having registered your license, you have the Installation key

4. At the prompt:

   Enter the installation key:

   Enter the installation key.

   ![Image of License Manager Workplace window](image)

   **Figure 39: Installing Installation Key with License Manager (flmprg -l) without internet**

   You should receive a message to say the installation was successful.

5. At the prompt:

   Enter your maintenance KEY ('stop' or leave empty to quit) >

   Enter: <maintenance-key>

   A message is displayed in the output to say the license installation was successful. License installation is now completed.
Steps to apply maintenance (FLM)

You apply a maintenance key (also known as a subscription key depending on your contract) when you are installing a license for a product and thereafter when you renew your maintenance contract.

An active maintenance or subscription contract is required to license a product. The maintenance key determines which version of the Genero product you are authorized to use with your license, and the date that the maintenance contract expires.

Before you begin applying a maintenance key:

1. Determine if you have internet access from the FLM server.
2. Use Table 47: Options for licensing on page 128 to choose your licensing option, and select the procedure to follow.

Table 47: Options for licensing

<table>
<thead>
<tr>
<th>FLM Licensing options</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using flmprg with internet.</td>
<td>See Install the maintenance key with Four Js License Manager (via internet) on page 128.</td>
</tr>
<tr>
<td>Using flmprg without internet.</td>
<td>See Install the maintenance key with Four Js License Manager (without internet) on page 129.</td>
</tr>
</tbody>
</table>

Install the maintenance key with Four Js License Manager (via internet)

Install or update the maintenance key for a Genero product using the license manager program command, flmprg -m. During installation the maintenance key is retrieved from Four Js activation server via the internet.

About this task: If you have purchased a new maintenance contract, you only need to add the new maintenance key. You do not need to reinstall your license, or uninstall the old maintenance key.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux, open a command prompt. "sudo" may be required.
   b) Type flmprg -m <license-number>
      Note: The FLM prompts you for the missing maintenance key.

2. At the prompt:
   Do you want to obtain the maintenance key using HTTP ? (y/n)
   Enter: y

3. When prompted, enter your customer code:

   Enter your customer code >

4. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

The maintenance key is retrieved automatically from the Four Js Activation server. Maintenance key installation is now completed.
Install the maintenance key with Four Js License Manager (without internet)

Install or update the maintenance key for a Genero product using the license manager program command, flmprg -m. Without internet access, you can obtain the maintenance key from Four Js from another machine via the internet, or by phone.

About this task: If you have purchased a new maintenance contract, you only need to add the new maintenance key. You do not need to reinstall your license, or uninstall the old maintenance key.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux, open a command prompt. “sudo” may be required.
   b) Type `flmprg -m <license-number>`

      Note: The FLM prompts you for the missing maintenance key.

2. At the prompt:
   Do you want to obtain the maintenance key using http ? (y/n)
   Enter: n

3. To get the maintenance key contact the vendor by phone, or get it from the Four Js website. See the procedure described in Get maintenance key from Four Js website on page 80.

4. At the prompt:
   Enter the maintenance key:
   Enter the maintenance key.
   You should receive a message to say the maintenance key installation was successful.

License sharing with docker

If you are working with Genero products installed in Docker container, follow the tasks for building a docker image and assigning a Genero BDL license installed on the host machine to that running in a Docker container.

Licensing for Genero products installed in a docker container can be implemented in one of two ways:

• If you are using a Four Js License Manager (FLM) server to manage licensing, licensing can be implemented by it in the usual way provided that the server is hosted outside the container. The FLM server can not run inside a docker container.

• An alternative option is to assign the license installed on the host machine to that running in a Docker container. This option is provided by the local license controllers (`fglWrt`, `greWrt`, `grxWrt`).

If you are working with Docker, you must have an understanding of Docker container technology. Docker is based on open standards that allow Docker instances running on the same machine to share the machine's operating system kernel but isolate applications from one another and from the underlying infrastructure. For more information see the Docker site.

Install FGLGWS on host

Follow this process to install Genero Business Development Language (BDL) with Web Services on the host machine running docker.

Before you begin: A prerequisite requires that the BDL installing path is not the same on both the host and the Docker container. Therefore, for example, instead of taking the default installation path option, which is `/opt/fourjs/fgl`, you specify the installation path as `/opt/fourjs/fglgws-license` on the host. For more information on Genero BDL installing, see the Install Genero Business Development Language on page 12 topic.
1. At the point in the installation when you are prompted for the installation directory, type N and then press the Enter key:

For example:

FGLDIR is set up to /opt/fourjs/fgl. You can choose it for installation directory

Do you want to use FGLDIR? Press [Y]es/[N]o/[C]ancel then (ENTER) ([Y]es is the default)

2. Specify the installation location:

At the following prompt:

"Where do you want to install this product?  
Default value is /opt/fourjs/fgl :

Enter the path, for example:

```
/opt/fourjs/fglgws-license
```

What to do next:

License Genero BDL. At the point of the installation requesting license details, follow the instructions for the license key and number and enter the required information.

---

**Build operating system image**

Follow this process to build a Linux® operating system image for use in a docker container.

**About this task:** This topic describes a procedure for working with a Debian image.

**Before you begin:**

You must have Docker installed and running.

1. Make a directory with a name that relates to your image.

For example, a directory called `debian` may contain a Dockerfile for your Debian® image.

```
mkdir debian
```

2. With a text editor create the file as shown, and save it as `Dockerfile`.

```
FROM debian:latest
RUN apt-get update \
    && apt-get install -y --no-install-recommends --no-install-suggests file \ 
    bzip2 \ 
    binutils \ 
    sqlite3 \ 
    sudo \ 
    && apt-get clean \ 
    && rm -rf /var/lib/apt/lists/*
ARG user=genero
ARG group=fourjs
ARG uid=2000
ARG gid=2000
ENV HOME=/home/${user}
RUN set -eufx \ 
    && groupadd -g "$(gid)" "$(group)" 
```
The docker file contains all the commands needed to get the latest updates and build the Debian image. The user ("genero") and group ("fourjs") are added. A home directory and environment is set up for the user.

**Note:** The Dockerfile file is written following specific Dockerfile instructions. For more information see the Docker documentation.

3. At the command line, type the following commands to build the image from your Dockerfile:

```
docker pull debian:latest
```

```
docker build --force-rm -t fglgws-os .
```

The `docker pull` command pulls a pre-built Debian® image from the Docker repository. The `docker build` command builds an image called `fglgws-os` based on the Dockerfile found in the current directory, represented by the dot (`.`).

4. Get a list of docker images.

```
docker images
```

Your docker image (`fglgws-os`) is shown in the list.

What to do next:

Based on this image, you can now build a docker image with an FGLGWS package. See Build docker image with FGLGWS package on page 131

---

### Build docker image with FGLGWS package

Follow this process to build a docker image with an FGLGWS package for use in a docker container.

**About this task:** The procedure described here applies to a Genero Business Development Language (BDL) installation in a docker container. The procedure may be adapted to add other Genero products to the docker container.

**Before you begin:**

- You have created a docker image called `fglgws-os` as described in Build operating system image on page 130.
- You have the FGLGWS package required for your installation downloaded to your system from the Four Js website, [www.4js.com](http://www.4js.com).
- You have Docker installed and running.

1. Make a directory with a name that relates to your image.
   
   For example, a directory called `fglgws-base` may contain a Dockerfile for your image.

   ```
   mkdir fglgws-base
   ```

2. Create a docker file to install the FGLGWS package.
   
   With a text editor create the file as shown, and save it as `Dockerfile`:

   ```
   FROM fglgws-os
   USER root
   ```
ARG user=genero
ARG group=fourjs
ARG FGLGWS_PACKAGE

WORKDIR ${HOME}
COPY ${FGLGWS_PACKAGE} /tmp/fglgws-install.run
RUN mkdir -p /opt/fourjs \
    && chown ${{user}}:${{group}} /opt/fourjs /tmp/fglgws-install.run
USER ${{user}}

# Install fglgws package
ENV FGLDIR /opt/fourjs/fglgws
ENV PATH ${FGLDIR}/bin:${PATH}
RUN /tmp/fglgws-install.run --accept --install --quiet --target ${FGLDIR} \
    && fglrun -V \
    && rm -f /tmp/fglgws-install.run

In this example, the base image already created is used to build the FGLGWS installation (FROM fglgws-os).
Permissions are set up for the installation to be run in the /opt/fourjs/fglgws directory by the "genero" user when the docker container is run.

3. At the command line type the following command to build the image from your dockerfile:

```
docker build --force-rm --build-arg FGLGWS_PACKAGE=fjs-fglgws-3.10.01-build1486651223-164x1212.run -t fglgws-base .
```

The build parameter --build-arg specifies the FGLGWS package to be installed in the docker container when created.

4. Get a list of docker images.

```
docker images
```

Your docker image (fglgws-base) is shown in the list.

What to do next:

Run the docker container and check Genero BDL license status. See Run docker container on page 132.

---

## Run docker container

Run a docker container with a Genero Business Development Language (BDL) installation and check the license status.

**About this task:** Genero licensing can not be implemented directly in a docker container. This procedure shows the status before licensing has been assigned.

**Before you begin:**

- You have created a docker image called fglgws-base as described in Build docker image with FGLGWS package on page 131.
- You have Docker installed and running.

1. At the command line, type the command to create and run the fglgws-base docker container.

```
docker run --rm -it -t --name fglgws fglgws-base
```
The container’s name or tag is fglgws (as defined by the `--name` option). It can be listed by the docker command `docker ps` run on the host:

2. At the command prompt of the docker container, try to get Genero BDL license information.

Type the license controller command:

```
fglWrt -a info
```

genero@775edc6b89ce:$ fglWrt -a info license
SYS ERROR (-6054,2) : No such file or directory

Cannot read a license file
Check installation path and your environment.

There is no license available. License installation is not allowed in a docker container.

What to do next:
You assign the Genero BDL license on the host where the docker container is running to the instance in the container. See Assign host license to docker container on page 133.

---

**Assign host license to docker container**

Follow this process if you wish to assign a license to a docker container from a licensed Genero product on the host machine.

The procedure described here applies to assigning a license from a host to a Genero Business Development Language (BDL) installation in a docker container.

License controllers for Genero Report Engine (`greWrt`) and Genero Report Writer (`grxWrt`) provide a `docker-assign` function for those Genero products.

**Before you begin:**

- Make sure that the BDL installing path (FGLDIR) is **not** the same on both the host and the Docker container.
- You must have created a docker image as described in Build docker image with FGLGWS package on page 131.
- You must have Docker installed and running.

1. Run the docker command with the option to mount the host installation directory (FGLDIR) in the container.

Type the command:

```
docker run --rm -it \
--volume /opt/fourjs/fglgws-license:/opt/fourjs/fglgws-license\ 
-t --name fglgws fglgws-base
```

**Important:**

The `--volume` option mounts the host FGLDIR directory on the container. The names of the mounted directories must be the same in the host and docker container.

2. Set up the path to the license controller in the docker container.

At the command line type the command:

```
export FGLWRTPATH=/opt/fourjs/fglgws-license
```

3. Back on the host machine. Set the Genero BDL environment by running the script `envcomp`

**Tip:** To detach from the `fglgws` container and leave it running, use the keyboard sequence Ctrl + p Ctrl + q.
At the command line type:

```
. /opt/fourjs/fglgws-license/envcomp
```

4. **Assign the Genero BDL license on the host to the docker container named "fglgws"**:
   Type the license controller command:
   ```
   fglWrt docker-assign fglgws
   ```

5. **Attach to the container fglgws**.
   Type the command:
   ```
   docker attach fglgws
   ```

6. **Check the Genero BDL license in the container**.
   At the command line, type the license controller command:
   ```
   fglWrt -a info
   ```
   The license information shows the expected details of the license and you see it is assigned to the docker container. It can not be used again on the host, until it is released from the docker container.

   License : XXX#XXXXXXXX
   Product : Four Js Universal Compiler
   Type : Development version
   Users : 10
   Extension(s) :
   - Open Database Interface
   End of maintenance date: 2018/12/31 (Year/Month/Day).
   License assigned to docker instance
   '4c5c3747e838916365d04f2a2300a20334b91afbf9629861a6ddceeb7d3abfd15f

   **What to do next:**
   A Genero license assigned to a docker container can be released back to the host installation. See **Release docker container license** on page 134.

---

### Release docker container license

A license assigned to a docker container can be released back to the host from the host installation. Follow this process if you wish to release a license.

**About this task:**

This topic describes a procedure for releasing a Genero Business Development Language (BDL) license from the Docker container to the host.

At the command line of the host, type the command:

```
fglWrt docker-release
```

The license can now be used in the host. It is no longer available to the Docker container.
Configure license with FLM for docker on macOS host

If you are working with Genero products installed in Docker instance on a macOS™ system that also hosts the Four Js License Manager (FLM) server, there is a specific configuration to provide licensing for docker instances if the network changes.

**Before you begin:**

This configuration procedure applies to macOS™ only. It is assumed the Four Js License Manager (FLM) is installed on the same macOS™ host where the docker instance is running.

**About this task:**

Typically, in production environments a docker instance needs to access an external FLM service for Genero licensing. The `flm.server` resource needs to specify the server, and this needs to be set in the FGLPROFILE file before building the docker image.

However, situations in development are common where a macOS™ host may contain both the FLM and the docker instance. While providing the IP address in `/etc/hosts` works for the local network, you may encounter situations where the IP address of the host changes; for example switching between networks - or even where there is no network access - that will cause the FLM to fail to resolve license requests from docker instances.

Therefore, it is recommended to configure a mapping to the localhost using a special DNS name which resolves to the internal IP address used by the host; regardless of changes in the network. For more information see the Docker docs site.

1. Edit the FLM configuration file, `$FLMDIR/etc/lmprofile`:
   
   If the hostname is ”serverA”, for example set the resource:
   
   ```plaintext
   flm.server="serverA.local"
   ```

2. Configure the Genero product’s DVM configuration file (for example, the FGLPROFILE included in the docker’s FGLGWS installation):
   
   For example, set the `flm.server` resource:
   
   ```plaintext
   flm.server="host.docker.internal"
   ```

   Where `host.docker.internal` is the special DNS name provided by Docker.

   Now even if you remove the network connection of the macOS™ docker host, the FLM server is found.

**What to do next:**

For more information on FLM configuration, see License Manager configuration on page 114.

---

**Troubleshoot license issues**

You may become aware of licensing issues when using Genero products via messages output from the Dynamic Virtual Machine (DVM).

**Licensing errors**

Error messages that you see in the DVM output views about licensing are generally self-explanatory, detailing the specific cause. For example,

```plaintext
SYS ERROR(-6054,2):No such file or directory
```
Cannot read a license file. 
Check installation path and your environment. 
Verify if a license is installed.

You will find additional information about licensing related errors in the Genero Business Development Language User Guide, chapter "Genero BDL errors". Errors with numbers in the range 6001 to 6200 describe known and common licensing errors. You will find additional information about the action you need to take to resolve a particular error.

License logs

To troubleshoot licensing issues, you may have to activate a logging feature by enabling entries in either the lmprofile (FLM) or fglprofile (flgWrt, greWrt, or grxWrt). For further information see License logs on page 136. You may be asked to send log files to Four Js support for further assistance with a licensing problem. For more information or assistance you can also contact your local Four Js support center for help.

Licensing for Windows®

If your Windows® installation directory is the c:\Program Files path, you must run the license controller command (for example fglWrt) as administrator in order to avoid permission issues.

Important: You must run the command as administrator, it is not enough to simply have administrator permissions.

License logs

Logging can be enabled for the Four Js License Manager (FLM) and/or the license controller. Requests and responses that are sent and received by the license controller or Four Js License Manager (FLM) may be recorded in log files. These logs are intended for the troubleshooting of licensing issues by decoding and reviewing events. You may be asked to activate logging in order to assist Four Js support with a licensing problem.

Note: The logs are encoded and are not intended to be readable by users.

Activating this logging feature is dependent on how your license management is implemented.

Local license controller logs

If you are using a license controller (fglWrt, greWrt, or grxWrt) for license management, the log feature is configured in the FGLPROFILE file or by setting environment variables.

fglprofile configuration

To affect all license controllers, enable logging in the FGLPROFILE file.

Logs can be enabled using these entries:

- flm.log.enabled=1
- flm.log.directory="/tmp"

Environment variables

You can control which license controller processes inherit environment variables. For example, you can use a production installation for a single test and avoid changing the context where production executes.

Tip: Sometimes this method is easier than updating a configuration file.

Logs can be enabled using these environment variables:

- WRT_LOG_ENABLED=1
A \texttt{wrt-<timestamp>.log} file is created in the specified log directory. A new log file is created each day. If logs are enabled and no directory provided, the output goes to stderr.

\textbf{Tip: } License controller logs can also be enabled locally when using an FLM.

\textbf{Four Js License Manager (FLM) Log}

If you are using FLM, a log feature is available (FLM version 5.10.3u or later). The log can be enabled by setting the entry \texttt{flm.cnxlog.enabled=1} in \texttt{$FLMDIR/etc/lmprofile}.

After making a configuration change, you will need to restart the FLM. After the restart, you get an \texttt{flm.log} file in the \texttt{$FLMDIR} directory.

Contact your local Four Js support center for additional assistance.

## Upgrading

These topics talk about what steps you need to take to upgrade to the next release of Genero licensing, and allows you to identify which features were added for a specific version.

## New Features of Genero License

These topics provide a look back at the new features introduced with each release of Genero License.

### Licensing 5.20 new features

Review this topic for information about new features and changes in existing functionality that have been introduced in this release of the Genero Licensing manual.

### Table 48: Genero Licenser UI application

<table>
<thead>
<tr>
<th>Version Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Genero Licenser UI launches a web page in your browser. The UI provides the same service to license your products as the application used in earlier versions.</td>
<td>See, for example, \textit{Steps to BDL license installation} on page 58</td>
</tr>
</tbody>
</table>

### Table 49: License Controllers (fglWrt, greWrt, grxWrt)

<table>
<thead>
<tr>
<th>Version 5.20.13 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is an option to perform some actions such as install/uninstall licenses in batch mode, for example \texttt{fglwrt --batch}. Batch commands can also be run from the tool console, for example \texttt{fglwrt --batch-console}.</td>
<td>See \textit{License Controller (fglWrt)} on page 65 and \textit{License Controller (greWrt) options} on page 94</td>
</tr>
</tbody>
</table>
### Licensing 5.19 new features

Review this topic for information about new features and changes in existing functionality that have been introduced in this release of the Genero Licensing manual.

#### Table 50: License Manager (flmprg)

<table>
<thead>
<tr>
<th>Version 5.19.19 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 5.19.19 has bug fixes and provides some enhancements for license controllers.</td>
<td>No additional reference.</td>
</tr>
<tr>
<td>Starting from 5.19.19, users do not share licenses by default. License sharing must be explicitly enabled by setting the <code>flm.license.shared</code> option to 1.</td>
<td>See Configure the License Manager on page 114</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.10 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting from version 5.19.10, when licensing with <code>flmprg -l</code>, the maintenance key can be installed after the installation key.</td>
<td>See Steps to licensing with FLM on page 116</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.01 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting with version 5.19.01, a feature is available that allows you to drop a single session, or drop all sessions started from a host.</td>
<td>See Drop sessions attached to a host on page 124</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.00 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting with version 5.19.00 there is a new method for managing licensing of Genero products in a Docker container. Licenses can not be installed inside a docker container. Docker instances must use an FLM server hosted outside the container for license support.</td>
<td>No additional reference.</td>
</tr>
</tbody>
</table>

#### Table 51: License Controllers (fglWrt, greWrt, grxWrt)

<table>
<thead>
<tr>
<th>Version 5.19.26 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting from version 5.19.26, license logs can be enabled for the license controller.</td>
<td>See License logs on page 136</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.10 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting from version 5.19.10, when licensing from the command line using the <code>fglWrt -l,greWrt -l,or grxWrt -l</code>, the maintenance key can be installed after the installation key.</td>
<td>See Install BDL license from the command line (via internet) on page 62</td>
</tr>
<tr>
<td>The Genero license installed on a machine hosting Docker can be assigned to applications on a running docker container.</td>
<td>See License Controller (fglWrt) on page 65 and License sharing with docker on page 129.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.01 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>For local licensing, starting with version 5.19.01, there is an option to drop the session referenced by a specified process id.</td>
<td>See Drop session on page 78</td>
</tr>
</tbody>
</table>
Licensing 5.18 new features

Review this topic for information about new features and changes in existing functionality that have been introduced in this release of the Genero Licensing manual.

Table 52: License Controller

<table>
<thead>
<tr>
<th>Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beginning with Four Js License Manager (FLM) and License Controller</td>
<td>No additional</td>
</tr>
<tr>
<td>(fglWrt) version 5.18.00, there is a new method for calculating CPU</td>
<td>reference.</td>
</tr>
<tr>
<td>Licenses operating in degraded mode.</td>
<td></td>
</tr>
</tbody>
</table>

Upgrade Guides for Licensing

Review the list of migration recommendations each time you move to a new version.

Upgrade the FLM without re-applying licenses

When you upgrade the Four Js license manager, you do not need to reinstall your existing licenses.

1. Make a backup copy of your FLM configuration file, FLMDIR/etc/lmprofile
2. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type flmprg -s
      The FLM service is stopped.
3. Install the new FLM package in the same directory as the existing installation.
   Take the option to overwrite the existing files.
4. Replace the configuration file at FLMDIR/etc/lmprofile with the backup copy created in Step 1.
   Overwrite the existing file.
5. Remove every file and directory in the FLMDIR/lock/ path.
6. Start your new FLM
   flmprg -r

It is also recommended to upgrade the license controllers for your Genero Business Development Language (fglWrt) or Genero Report Writer (greWrt) installations at this time. See Patching a license controller on page 52.

Copyrights and Trademarks

The Copyright and trademark page is shared amongst all Four Js documentation. Appearance in this page does not guarantee a mention within the current document.

Copyright notice

© Copyright Four Js Development Tools, Inc. Use, duplication or disclosure restricted.
Trademarks

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated.

IBM and WebSphere are trademarks or registered trademarks of International Business Machines Corp., in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at Copyright and trademark information.

Linux is a registered trademark of Linus Torvalds.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

DEBIAN is a registered trademark owned by Software in the Public Interest, Inc. Debian trademark is a registered United States trademark of Software in the Public Interest, Inc., managed by the Debian project. Genero is not affiliated with Debian. Debian is a registered trademark owned by Software in the Public Interest, Inc.

Red Hat is a registered trademark of Red Hat, Inc. in the United States and other countries.

Red Hat Enterprise Linux is a registered trademark of Red Hat, Inc. in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.
Index

A
activation key
  requesting a new key 80

B
BDL
  finalize license installation 81
  install 12
  install maintenance key 86
  license information 70
  license installation 58
  licensing with License Manager 89
  local license management 64
  lock directory
    user access 75
  packages 12
  post-install tasks 17
  pre-install tasks 12
  uninstall license 73
  update maintenance key 86
bundled software 8
Business Development Language, See BDL

C
check FLM is started 67
check registered users list 77
clean registered users list 77
command line tools
  common options 9
command reference
  fglnodb 52
  fpi 52
  GRE license information
    greWrt -a info license 98
  GRE maintenance key install
    greWrt -m 111
    greWrt -m auto 110
  install BDL license
    fglWrt -l 62
  install GRE installation key
    greWrt -k 107
  install GRE license
    greWrt -l 92
  install installation key automatically
    greWrt -k auto 106
  install license with FLM
    flmprg -l 117
  uninstall GRE license
    greWrt -d 100
compatibility
  GAS 3.10 and Genero 23
  GAS and Genero 23, 23
  GDC 2.50 and Genero 18
  GDC 3.00 and Genero 18
  GDC 3.10 and Genero 18
  GDC 3.20 and Genero 17
  GDC and Genero 17
  GMA 1.20 42
  GMA 1.30 42
  GMA 1.40 41
  GMA and Genero 41
  GMI 1.20 43
  GMI 1.30 43
  GMI 1.40 43
  GMI and Genero 43
  GST 3.20 and Genero 28

D
display cpu information 68
display process list 77
displaying license information
  FLM 121
docker 129
docker-assign 133
docker-release 134
drop session 78
DVM version
  identifying 52

F
fglprg command line tool
donner session 124
FGLWRTUMASK
  restricting user access 75
file format
  fglprofile 115
greprofile 115
flm
  manage active users 124
FLM
  configuration 114
  displaying license information 121
  install installation key 126
  install maintenance key 128
  license installation 116
  license management 119
  update maintenance key 128
  See also license manager
Four Js License Manager 114
  See also license manager

G
GAS
  install 22
GDC
  install 17
Genero Application Server, See GAS
Genero Browser Client
  install 50
Genero Desktop Client, See GDC
Genero Mobile for Android
install 41
Genero Mobile for iOS
install 42
Genero Report Designer
install 47
Genero Report Engine, See GRE
Genero Studio
install 28
Genero Studio Server Suite
install 35
GMA
install 41
GMI
install 42
GRD. See Genero Report Designer
GRE
finalize license installation 103
install 43
install maintenance key 107
license information 97
license installation 90
licensing with License Manager 111
uninstall license 99
update maintenance key 107
greprofile
configure FLM resources 111
I
install
flm 56
Four Js License Manager 56
install installation key
FLM 126
install maintenance key
BDL 86
FLM 128
GRE 107
installation
directory environment 9
environment scripts 9
for development 8
for production 8
troubleshooting 11
L
license
environment and statistics 67
managing active users 75
license controller
command options
fglwrt 65
grecwrt 94
license information
BDL 70
GRE 97
license management
Genero Report Engine 94
license manager
command options
flmprg 119
configuration
DVM configuration file 115
displaying license information
displaying active user statistics 123
displaying FLM statistics 122, 123
installing 51
installing FLM service 56
license using 114
starting FLM service 57
stopping FLM service 57
uninstalling a license 121
upgrading 51, 139
license managerfglwrg
drop session 124
license registration
on Four Js website 78, 100
licensing
docker container
assign host license 133
release host license 134
docker container on macOS 135
logs 136
troubleshooting 135
licensing Genero Mobile
determining app size 112
free developer license 112
packaging mobile app 112
licensing new product version 75, 100
licensing with License Manager
BDL 89
Linux
install GRD 48
local license management
BDL 64
M
macOS
install GAS 27
install GDC 21
install Genero BDL 16
install Genero Studio Server 40
install GRE 46
install Studio 34, 34
maintenance key
from Four Js website 80, 102
manage active users
flm 124
managing active users
license 75
MSI installer
BDL 15
GAS 25
GDC 20
GRD 49
GRE 45
License Manager 54
Studio 31
Studio Server Suite 38
multiple versions
  installing 10

N
new features
  version 5.18 139
  version 5.19 138
  version 5.20 137

P
patching license controller 52
product
  version life cycle 10

R
Report Designer, See Genero Report Designer

S
silent mode
  install BDL
    UNIX 14
    Windows 15
  install FLM
    UNIX 53
  install GAS
    UNIX 24
  install GDC
    UNIX 19
  install GRD
    UNIX 48
  install GRE
    UNIX 44
  install GSTSRV
    UNIX 36
  install License Manager 54
  install Studio
    UNIX 29
    Windows 31
  install Studio Server Suite 38
software bundle 8
software package names 8
Studio, See Genero Studio

T
troubleshooting
  installation 11
  license registration 80

U
uninstall license
  BDL 73
  GRE 99
UNIX
  install BDL 13
  install BDL silently 14
  install FLM silently 53
  install GAS 23
  install GAS silently 24
  install GDC 18
  install GDC silently 19
  install Genero Studio 29, 36
  install GRD 48
  install GRD silently 48
  install GRE 44
  install GRE silently 44
  install GSTSRV silently 36
  install Studio silently 29

W
Windows
  install BDL
    using MSI 15
  install GAS
    using MSI 25
  install GDC
    using MSI 20
  install Genero Studio Server 37
  install GRD
    using MSI 49
  install GRE
    using MSI 45
  install License Manager
    using MSI 54
  install Studio
    using MSI 31
  install Studio Server Suite
    using MSI 38
  Security Blocking 22, 33

X
x11
  install GDC 22